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IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

Kit overview

The Applied Biosystems™ GlobalFiler" Express PCR Amplification Kit is a 6-dye, short tandem repeat
(STR) multiplex assay for the amplification of human genomic DNA.

The kit amplifies:

* 21 autosomal STR loci (D3S1358, VWA, D16S539, CSF1PO, TPOX, D8S1179, D21S11, D18S51,
D2S441, D19S433, THO1, FGA, D2251045, D5S818, D13S317, D7S820, SE33, D10S1248,
D1S1656, D12S391, D2S1338)

* 1Y-STR (DYS391)
¢ 1 insertion/deletion polymorphic marker on the Y chromosome (Y indel)
* Amelogenin (sex determining marker)

The GlobalFiler™ Express PCR Ampilification Kit combines the 13 original CODIS loci with 7 from the
expanded European Standard Set of Loci (ESSL) and the highly discriminating SE33 locus. The kit
delivers a 24-locus multiplex with the highest discrimination power of any Thermo Fisher Scientific
Human Identification Kit, along with high sensitivity and tolerance to inhibitors. The concentration of 10
mini-STR loci that are entirely below 220 bp maximizes performance on degraded samples. The highly
optimized buffer formulation contains an enzyme that allows completion of amplification in ~45 minutes.

The GlobalFiler" Express PCR Amplification Kit uses the same improved process for synthesis and
purification of the amplification primers developed for other next-generation Thermo Fisher Scientific
STR chemistries. The improved amplification primers deliver clean electrophoretic backgrounds that
assist interpretation.
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Product description

Single-source sample types supported

The GlobalFiler™ Express PCR Ampilification Kit is optimized to allow direct amplification from the
following types of single-source samples without the need for sample purification:

¢ Blood and buccal samples on treated paper substrates.

e Blood and buccal samples collected on untreated paper substrates and treated with Prep-n-Go™
Buffer.

* Buccal samples collected on swab substrates and treated with Prep-n-Go™ Buffer.

Substrate examples

* Treated paper: NUCLEIC-CARD™ system or Whatman FTA™ cards
¢ Untreated paper: Bode Buccal DNA Collector™ or 903 paper
* Swab: FLOQSwabs™ or cotton swabs

Note: Our testing does not include blood samples on swab substrates. This sample type is not
typically used for the collection of reference samples.

About the primers

The GlobalFiler™ Express PCR Ampilification Kit primers are manufactured using the same synthesis
and purification improvements as the primers in the NGM SElect™ and the Identifiler Plus kits. These
improvements enhance the assay signal-to-noise ratio and simplify the interpretation of results.

The primers used in the kit are:

* For all loci except AMEL —The same primer sequences as the NGM SElect™ kit and the Identifiler™
Plus kit including SNP-specific primers for the VWA, D16S539, AMEL, D2S441, D22S1045, and
D8S1179 loci.

* For AMEL—The same primer sequences as the NGM SElect™ kit (which are different from the
Identifiler™ Plus kit).

The GlobalFiler™ Express PCR Amplification Kit also includes the following primer additions and
modifications:

¢ Addition of DYS391 and a novel Y indel.

* The TPOX reverse primer has been redesigned to relocate the amplicon into the higher size range
of the multiplex and optimize marker spacing.

* Addition of 8 new SNP-specific primers for the D3S1358, vWA, D18S51, D19S433, THO1, FGA,
D5S818, and SE33 loci. The second degenerate primer was added to the vWA locus to address
two different SNPs in the primer binding site.

Non-nucleotide linkers are used in primer synthesis for the following loci: D19S433, vWA, CSF1PO,
D2S441, THO1, FGA, and D12S391. For these primers, non-nucleotide linkers are placed between the
primers and the fluorescent dye during oligonucleotide synthesis (Butler 2005, Grossman et al., 1994).
Non-nucleotide linkers enable reproducible positioning of the alleles to facilitate interlocus spacing. The
combination of a 6-dye fluorescent system and the use of non-nucleotide linkers allows simultaneous
amplification and efficient separation of all 24 markers during automated DNA fragment analysis.

GlobalFiler™ Express PCR Amplification Kit User Guide 9
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Dyes used in the kit

Dye Color Label
6-FAM™ Blue Samples, allelic ladders, and controls
vic™ Green
NED™ Yellow
TAZ" Red
sID™ Purple
Lz Orange GeneScan" 600 LIZ™ Size Standard v2.0

Loci amplified by the kit

Table 1 GlobalFiler" Express PCR Amplification Kit loci and alleles

Locus Chromosome Alleles included in Allelic Ladder ol | A CEEl
designation location 007
D3S1358 3p21.31 9,10, 11,12, 13, 14, 15, 16, 17, 18, 19, 20 6-FAM™ 15,16
VWA 12p13.31 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 14,16
24
D16S539 16024.1 5,8,9,10, 11, 12,13, 14, 15 9,10
CSF1PO 5933.3-34 |6,7,8,9,10, 11,12, 13, 14, 15 11,12
TPOX 2p23-2per | 5,6,7,8,9,10,11,12, 13, 14, 15 8,8
Y indel Yq11.221 1,2 vic™ 2
Amelogenin X:p22.1-22.3 | X, Y X, Y
Y:p11.2
D8S1179 8g24.13 5,6,7,8,910, 11,12, 13, 14, 15, 16, 17, 18, 19 12,13
D21S11 21q11.2-g21 |24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 30.2, 28, 31
31,31.2,32, 32.2, 33, 33.2, 34, 34.2, 35, 35.2,
36, 37, 38
D18S51 180g21.33 |7,9,10,10.2, 11, 12, 13, 13.2, 14, 14.2, 15, 16, 12,15
17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27
DYS391 Yq11.21 7,8,9,10, 11, 12,13 11
D2S441 2p14 8,9,10, 11,11.3, 12, 13, 14, 15, 16, 17 NED™ 14,15
D19S433 19912 6,7,8,9,10, 11,12, 12.2,13, 13.2, 14, 14.2, 15, 14,15
15.2, 16, 16.2, 17, 17.2, 18.2, 19.2
THO1 11p15.5 4,5,6,7,8,9,9.3,10, 11, 13.3 7,9.3

10
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Table 1 GlobalFiler Express PCR Amplification Kit loci and alleles (continued)

Locus Chromosome Alleles included in Allelic Ladder Byslabelt s oentel
designation location 007
FGA 4928 13,14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, NED™ 24,26
26, 26.2, 27, 28, 29, 30, 30.2, 31.2, 32.2, 33.2,
422,432,442, 452, 46.2, 47.2, 48.2, 50.2,
51.2
D2251045 229123 |8,9,10, 11, 12, 13, 14, 15, 16, 17, 18, 19 TAZ™ 11, 16
D55818 5q21-31 |7, 8,9, 10, 11,12, 13, 14, 15, 16, 17, 18 11, 11
D13S317 13q22-31  |5,6,7,8,9,10, 11, 12, 13, 14, 15, 16 11, 11
D75820 7q11.21-22 |6,7,8,9, 10,11, 12, 13, 14, 15 7,12
SE33 6q14 42,63,8,9,11,12,13, 14, 15, 16, 17, 18, 19, 17,25.2
20,20.2,21,21.2,22.2, 23.2, 24.2, 25.2, 26.2,
07.2,28.2,29.2,30.2,31.2,32.2, 33.2, 34.2, 35,
35.2, 36, 37
D10S1248 109263 |8,9,10, 11,12, 13, 14, 15, 16, 17, 18, 19 sIp™ 12, 15
D1S1656 19422 |9,10,11,12, 13, 14, 14.3, 15, 15.3, 16, 16.3, 17, 13, 16
17.3,18.3,19.3, 20.3
D125391 12p132  |14,15,16,17, 18,19, 19.3, 20, 21, 22, 23, 24, 18, 19
25,26, 27
D251338 2q35 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 20, 23
24,25, 26, 27, 28

Standards and controls that are required

For the GlobalFiler™ Express PCR Amplification Kit, the panel of standards needed for PCR
amplification, PCR product sizing, and genotyping are:

* DNA Control 007 —A positive control for evaluating the efficiency of the amplification step and STR
genotyping using the GlobalFiler" Express Allelic Ladder. DNA Control 007 is present in the kit. See
“DNA Control 007 profile” on page 13.

* GeneScan™ 600 LIZ™ Size Standard v2.0—Used for obtaining sizing results. This standard, which
has been evaluated as an internal size standard, yields precise sizing results for PCR products.

Order the GeneScan ™ 600 LIZ" Size Standard v2.0 (Cat. No. 4408399) separately.

* GlobalFiler™ Express Allelic Ladder—Developed for accurate characterization of the alleles
amplified by the kit. The Allelic Ladder is present in the kit and allows automatic genotyping of
most of the reported alleles for the loci in the kit. See “Allelic ladder profile” on page 12.

GlobalFiler™ Express PCR Amplification Kit User Guide
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Allelic ladder profile
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Figure 1 GeneMapper  ID-X Software plot of the GlobalFiler” Express Allelic Ladder
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Figure 2 DNA Control 007 (1 ng) amplified with the GlobalFiler” Express PCR Amplification Kit and analyzed on
an Applied Biosystems " 3500xL Genetic Analyzer (Y-axis scale 0 to 8,000 RFU).
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Contents and storage

The GlobalFiler™ Express PCR Ampilification Kit contains sufficient quantities of the following reagents
to perform 200 (Cat. No. 4476609) or 1,000 (Cat. No. 4474665) amplifications at 15 pL/amplification.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,

amplified DNA, allelic ladder, and size standard from light when not in use.

IMPORTANT! Do not refreeze kit components after thawing.

200 reactions | 1,000 reactions
Contents Description (Cat. No. (Cat. No. Storage
4476609) 4474665)
GlobalFiler™ Express Contains enzyme, salts, 1x1.13mL 1 x5.64 mL -25°C to —15°C on receipt.
Master Mix dNTP§, bovine serum 2°C to 8°C after first use,
albumin, enzyme, and for up to 6 months or u
0.05% sodium azide in P o P
to the expiration date stated
buffer and salt. ) .
on the kit (whichever comes
first).
Master Mix Additive Reagent for one-time 1x0.1mL 1x0.45mL -25°C to —15°C on receipt.
add|t|on. toTEhe Discard the tube after
GlobalFiler™ Express adding to the master mix
Master Mix following first 9 '
thaw.
GlobalFiler™ Express | Contains forward and 1x1.2mL 1x6mL —25°C to —15°C on receipt.
Primer Set rever§e primers to 2°C to 8°C after first use,
amplify human DNA
taraet for up to 6 months or up
argets. to the expiration date stated
on the kit (whichever comes
first).
Store protected from light.
GlobalFiler" Express | Contains amplified 1 x 0.065 mL 1x0.15mL —25°C to -15°C on receipt.
Allelic Ladder alleles. 2°C to 8°C after first use, up
See “Allelic ladder to the expiration date stated
profile” on page 12 for on the kit.
information. Store protected from light.
14 GlobalFiler™ Express PCR Amplification Kit User Guide
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Required materials not supplied

(continued)
200 reactions | 1,000 reactions
Contents Description (Cat. No. (Cat. No. Storage
4476609) 4474665)
DNA Control 007 Contains 2 ng/uL human 1 x0.05mL 1x0.1mL —25°C to —15°C on receipt.

male genomic DNA from
cell line in 0.05% sodium
azide and bufferl]

See “DNA Control 007
profile” on page 13 for
information.

2°C to 8°C after first use, up
to the expiration date stated
on the kit.

[ DNA Control 007 is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation of the
capability of the kit reagents to generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you
quantify aliquots of Control 007, the concentration may differ from the labeled concentration.

Required materials not supplied

See Appendix B, “Materials required but not supplied”.

Instrument and software compatibility

Instrument Validated models
type
Thermal * ProFlex” 96-well PCR System (Cat. No. 4484075)
cyclers e ProFlex™ 2 x 96-well PCR System (Cat. No. 4484076)

* Veriti" 96-Well Thermal Cycler (Cat. No. 4479071)
* GeneAmp" PCR System 9700, 96-Well Silver (Cat. No. N8050001)
* GeneAmp" PCR System 9700, 96-Well Gold-Plated (Cat. No. 4314878)

IMPORTANT! GlobalFiler™ Express PCR Amplification Kit is NOT validated for use with:

. Veriti" Fast 96-Well Thermal Cycler (Cat. No. 4375305)
. GeneAmp™ PCR System 9700, 96-Well Aluminum (Cat. No. 4314879)

GlobalFiler™ Express PCR Amplification Kit User Guide 15
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(continued)
Instrument .
Validated models
type
Genetic 3500/3500xL Genetic Analyzer
1 ™
analyzers!' * 3500 Series Data Collection Software 1 (Windows"™ Vista operating system) and HID Updater
3500 Data Collection Software v2 (Cat. No. 4480670)
* 3500 Series Data Collection Software 2 (Windows™ 7 operating system) and HID Updater
3500 Data Collection Software v2 (Cat. No. 4480670)
* 3500 Series Data Collection Software 3 (Windows™ 7 operating system)
* 3500 Series Data Collection Software 3.1 (Windows" 7 operating system)
* 3500 Series Data Collection Software 4 (Windows™ 10 operating system)
* 3500 Series HID Data Collection Software v4.0.1 (Windows™ 10 operating system)
3130/3130x/ Genetic Analyzer
* 3130 Series Data Collection Software 4 (Windows™ 7 operating system)
* 3130/3730 Data Collection 4 6-Dye Module v1
3730/3730xI DNA Analyzer
* 3730 Series Data Collection Software 4 (Windows™ 7 operating system)
e 3730 Series Data Collection Software 4 6-Dye Module v1
* 3730x| Data Collection Software 5 (Windows™ 10 operating system)
Note: For information on using the 3730xI DNA Analyzer, see the 3730x/ Data
Collection Software 5 for HID User Bulletin: New Features and Developmental Validation
(Pub. No. MAN0019461)
SeqStudio™ Genetic Analyzer
* SeqStudio™ Data Collection Software v1.2
* SeqStudio™ Data Collection Software v1.2.1
Analysis GeneMapper" ID-X Software v1.4 or later
software . T . ™ . ™ .
Windows  XP, Windows ~ 7, or Windows = 10 operating system

[ We conducted validation studies using the 3130x/, 3500, 3500xL, and 3730xI instruments. For validation information on the 3730xI instrument,
see the 3730xI Data Collection Software 5 for HID User Bulletin: New Features and Developmental Validation (Pub. No. MAN0019461).

16
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Workflow

Perform PCR on treated or untreated paper
substrates

“Prepare the amplification kit reactions: treated paper
substrate” on page 21 or

“Prepare the amplification kit reactions: untreated
paper substrate” on page 23

v

Obtain punch with Harris Manual Punch or BSD Semi-
Automated Dried Sample Punch Instrument

v
Untreated paper only: Process with Prep-n-Go™ Buffer
v

Process with the GlobalFiler™ Express PCR
Amplification Kit

v

Chapter 1 Product information  [S¥
Workflow

Perform PCR on swab substrates

“Prepare the reactions: swab substrate” on page 26

Lyse in Prep-n-Go™ Buffer
v

Process with the GlobalFiler™ Express PCR
Amplification Kit

v

Amplify with a recommended thermal cycler
v

Perform electrophoresis
“Set up the SeqStudio™ instruments for electrophoresis (before first use of the kit)” on page 30 or
“Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)” on page 32 or
“Set up the 3130/3130xl instruments for electrophoresis (before first use of the kit)” on page 36 or

“Set up the 3730/3730xI instruments for electrophoresis (before first use of the kit)” on page 38
v
“Prepare samples for electrophoresis” on page 41
v

Analyze data

“Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)” on page 44
“Create an analysis method” on page 49
“Create a size standard definition file if needed” on page 57
“Analyze and edit sample files with GeneMapper™ ID-X Software” on page 60

“Examine or edit a project” on page 61
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Optimize PCR cycle number (before first use of the kit)

Perform PCR

Optimize PCR cycle number (before firstuse of the kit) .......... .. ... o ... 18
Before yOU Degin . ... . e e 19
Treated paper substrates: prepare the amplification kit reactions ........................... 20
Untreated paper substrates: prepare the amplification kit reactions ......................... 22
Swab substrates: prepare the amplification kitreactions .............. ... ... .. . . 24
PerfOrm PO R .. 28

Before using the GlobalFiler" Express PCR Amplification Kit for the first time, perform a single initial
sensitivity experiment to determine the appropriate cycle number to use during internal validation
studies and operational use of the kit. This experiment accounts for instrument-to-instrument and
sample-to-sample variations. If you are processing multiple sample type and substrate combinations
(for example, buccal samples on treated paper and buccal samples on swabs), perform separate
sensitivity experiments for each sample type and substrate to be used for testing.

Procedural guidelines when optimizing PCR cycle number

(Recommended) Use 26 samples so that you can complete electrophoresis using a single 96-well
plate. This minimizes the impact of run-to-run variation on the results. Examples of PCR and
electrophoresis plate layouts are provided on page 145.

To maximize result quality, prepare and amplify Plate 1, then repeat for Plates 2 and 3. Do not
prepare all 3 plates before amplification.

To minimize the effect of instrument-to-instrument variation, use the same thermal cycler to amplify
all 3 plates.

Select samples and prepare plates

1.

18

Select 26 of each sample+substrate type. Ensure that the selected samples represent a "typical"
range of samples analyzed in your laboratory.

Prepare the samples and the reactions as described in the appropriate protocols later in this
chapter. Prepare sufficient PCR reagents to complete amplification of three replicate plates.

Create the first of 3 identical PCR plates (see page 145 for a suggested plate layout).
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Before you begin

4. Amplify each plate using a different cycle number to determine the optimum conditions for use in
your laboratory.

Suggested cycle numbers for different sample type and substrate combinations are listed in the
following table.

Substrate
Sample type
Treated paper Untreated paper Swab
Blood 25, 26, 27 cycles 25, 26, 27 cycles N/A
Buccal 26, 27, 28 cycles 26, 27, 28 cycles 25, 26, 27 cycles

Determine optimum PCR conditions

1. Run the PCR products on the appropriate CE platform using the recommended protocol that is
described in Chapter 3, “Perform electrophoresis”.

2. Based on the results of the sensitivity study, select the appropriate PCR cycle number for future
experiments.

Our studies indicate the optimum PCR cycle number should generate profiles with the following
heterozygote peak heights, with no instances of allelic dropout and minimal occurrence of off-scale

allele peaks:
Instrument Heterozygous peak height
3500 Series 3,000-12,000 RFU
3130 Series 1,000-3,000 RFU
3730 Series 3,000-12,000 RFU
SeqStudio™ Genetic Analyzer 3,000-12,000 RFU

When amplifying single-source, unpurified samples, you will see greater sample-to-sample variation in
peak height than you see with purified samples. Careful optimization of the cycle number helps to
minimize this variation.

Before you begin

Thaw reagents and prepare Master Mix (before first use of the Kkit)

1. Thaw the Master Mix, Master Mix Additive, and Primer Set, then vortex for 3 seconds.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer
set, amplified DNA, allelic ladder, and size standard from light when not in use.

IMPORTANT! Thawing is required only during first use of the kit. After first use, reagents are
stored at 2 to 8°C and, therefore, do not require subsequent thawing. Do not refreeze the reagents.
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Treated paper substrates: prepare the amplification kit reactions

2. Before opening the tubes or bottles, remove droplets from the caps by centrifuging the tubes
briefly and tapping the bottles on the bench.

3. Add the following volumes of Master Mix Additive to the Master Mix:

Kit Master Mix Additive volume
200 reactions 80 pL
1,000 reactions 390 pL

4. Gently invert the Master Mix tube 10 times, then centrifuge the tube briefly or tap the bottle on the
bench.

5. Mark the cap of the Master Mix with a (+) to indicate that the Master Mix Additive has been added.

6. Discard the Master Mix Additive tube.

Treated paper substrates: prepare the amplification kit
reactions

Sample preparation guidelines: treated paper substrate

* Do not add water to the wells on the reaction plate before adding the punches. If you observe
static issues with the paper discs, you can prepare and dispense the 15-pL reaction mix into the
wells of the reaction plate before adding the punches.

Alternatively, dispense 3 pL of low-TE Buffer into each sample and negative amplification control
well (NOT the positive amplification control wells) before adding the punches.

* Make the punch as close as possible to the center of the sample to ensure optimum peak intensity.
Increasing the size of the punch may cause inhibition during PCR amplification.

* For manual punching: Place the tip of a 1.2 mm Harris Micro-Punch on the card, hold the barrel of
the Harris Micro-Punch (do not touch the plunger), gently press and twist 1/4-turn, then eject the
punch in to the appropriate well on the reaction plate.

* For automated punching: See the User Guide of your automated or semiautomated disc punch
instrument for proper guidance.

Prepare low-TE buffer

For optimal results, we recommend using low-TE buffer for sample preparation. Prepare it as described
in this procedure or buy it from Teknova (Cat. No. T0223).
1. Mix together:
* 10 mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0

* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
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Treated paper substrates: prepare the amplification kit reactions

2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

Prepare the ampilification kit reactions: treated paper substrate

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents and prepare Master
Mix (before first use of the kit)” on page 19 before proceeding.

1. Add samples to the MicroAmp™ Optical 96-well Reaction Plate:

To these wells of the plate ... Add...
Negative control 1.2 mm blank disc
Test samples 1.2 mm sample disc
Positive control For 25 and 26 cycles 3 L of Control DNA 007
IMPORTANT! Do not add a blank disc For 27 cycles 2 uL of Control DNA 007
to the positive control well.
For 28 cycles 1 pL of Control DNA 007

Note: The volumes of positive control are suggested amounts and can be adjusted if peak heights
are too high or too low for your optimized cycle number.

2. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by centrifuging the tubes briefly or tapping the bottles on the bench.

3. Pipet the required volumes of components into an appropriately sized polypropylene tube.

Reaction component Volume per reaction
Master Mix 6.0 uL
Primer Set 6.0 uL

Low-TE buffer 3.0 uL

Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! This kit is optimized for a 15-uL PCR volume to overcome the PCR inhibition that is
expected when amplifying unpurified samples. Using a lower PCR reaction volume may reduce the
ability of the kit chemistry to generate full STR profiles.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 15 pL of the reaction mix into each reaction well of a MicroAmp™ Optical 96-Well
Reaction Plate.
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Untreated paper substrates: prepare the amplification kit reactions

6. Seal the plate with MicroAmp™ Clear Adhesive Film (Cat. No. 4306311) or MicroAmp" Optical
Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700 with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a MicroAmp™ Optical
Film Compression Pad (Cat. No. 4312639) on top of the plate to prevent evaporation during
thermal cycling. Other validated thermal cyclers do not require a compression pad.

7. Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge with plate holders.

8. Amplify the samples as described in Chapter 2, “Perform PCR”.

IMPORTANT! This kit is not validated for use with the GeneAmp™ PCR System 9700 with the
aluminum 96-well block. Use of this thermal cycling platform may adversely affect performance of
this kit.

Untreated paper substrates: prepare the amplification kit
reactions

Sample preparation guidelines: untreated paper substrate

* Make a 1.2 mm punch as close as possible to the center of the sample to ensure optimum peak
intensity. Increasing the size of the punch may cause inhibition during PCR amplification.

* If you are using a Bode Buccal DNA Collector™, make
a 1.2 mm punch as close as possible to the tip of
the DNA collector to ensure optimum peak intensity.
A larger punch may cause inhibition during PCR
amplification.

¢ For manual punching: Place the tip of a 1.2 mm Harris
Micro-Punch on the card, hold the barrel of the Harris
Micro-Punch (do not touch the plunger), gently press
and twist 1/4-turn, then eject the punch in to the
appropriate well on the reaction plate.

@ Location of punch with a Bode Buccal
* For automated punching: See the User Guide of your DNA Collector™

automated or semiautomated disc punch instrument for
proper guidance.
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Untreated paper substrates: prepare the amplification kit reactions

Prepare the amplification kit reactions: untreated paper substrate

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents and prepare Master
Mix (before first use of the kit)” on page 19 before proceeding.

1. Add Prep-n-Go'" Buffer (Cat. No. 4467079) to the MicroAmp"™ Optical 96-Well Reaction Plate:

To these wells ... Add...

Negative control 3 pL of Prep-n-Go™ Buffer

Test samples 3 pL of Prep-n-Go™ Buffer

Positive control For 25 and 26 cycles |0 pL of Prep-n-Go " Buffer
For 27 cycles 1 pL of Prep-n-Go™ Buffer
For 28 cycles 2 uL of Prep-n-Go™ Buffer

2. Add samples to the reaction plate:

To these wells ... Add...
Negative control 1.2 mm blank disc
Test samples 1.2 mm sample disc
Positive control For 25 and 26 cycles 3 pL of Control DNA 007
IMPORTANT! Do not add a blank disc | For 27 cycles 2 pL of Control DNA 007
to the positive control well.
For 28 cycles 1 uL of Control DNA 007

Note: The volumes of positive control are suggested amounts and may be adjusted if peak
heights are too high or too low for your optimized cycle number.

3. Centrifuge the plate to ensure that the punches are immersed in the Prep-n-Go™ Buffer.

4. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by centrifuging the tubes briefly or tapping the bottles on the bench.

5. Pipet the required volumes of components into an appropriately sized polypropylene tube.

Reaction component Volume per reaction
Master Mix 6.0 uL
Primer Set 6.0 uL
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Swab substrates: prepare the amplification kit reactions

Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! This kit is optimized for a 15-uL PCR volume to overcome the PCR inhibition that is
expected when amplifying unpurified samples. Using a lower PCR reaction volume may reduce the
ability of the kit chemistry to generate full STR profiles.

6. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

7. Dispense 12 pL of the reaction mix into each reaction well of a MicroAmp™ Optical 96-Well
Reaction Plate.

The final volume in each well is 15 pL (reaction mix plus Prep-n-Go™ Buffer and sample or positive
control).

8. Seal the plate with MicroAmp™ Clear Adhesive Film (Cat. No. 4306311) or MicroAmp™ Optical
Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700 with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a MicroAmp™ Optical
Film Compression Pad (Cat. No. 4312639) on top of the plate to prevent evaporation during
thermal cycling. Other validated thermal cyclers do not require a compression pad.

9. Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge with plate holders.

10. Amplify the samples as described in Chapter 2, “Perform PCR”.

IMPORTANT! This kit is not validated for use with the GeneAmp™ PCR System 9700 with the
aluminum 96-well block. Use of this thermal cycling platform may adversely affect performance of
this kit.

Swab substrates: prepare the amplification kit reactions

Sample preparation guidelines: swab substrate

* Detach each buccal swab head from the swab shaft before lysis.

¢ If you are using the heated lysis protocol, perform lysis in either of the following formats:
- 1.5-mL tubes with a heat block (VWR™ Scientific Select dry heat block or similar)
- PrepFiler™ 96-Well Processing Plates (Cat. No. A47010)
- Robbins Scientific™ Model 400 Hybridization Incubator or similar
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Swab substrates: prepare the amplification kit reactions

- Agilent™ Benchtop Rack for 200 pL Tubes/V Bottom Plates (metal) or similar (Cat. No. 410094)

IMPORTANT! Do not use a plastic plate adaptor.

* For optimum performance, lyse the entire swab. If you need to preserve the sample, use half of the
lysate prepared from the entire swab.

Prepare the sample lysate: room temperature
This protocol may improve the performance for challenging or aged samples.

1. Add 400 pL Prep-n-Go™ Buffer (Cat. No. 4471406) to 1.5-mL tubes or the appropriate wells of a
PrepFiler” 96-Well Processing Plate (Cat. No. A47010).

2. Into each tube or well, put the entire head of each swab, then let stand for 20 minutes at room
temperature (20°C to 25°C) to lyse the sample.

3. After 20 minutes, transfer the sample lysate out of the sample plate into tubes or plates for storage,
then discard the deep-well plate containing the swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from the sample
lysate plate before transferring the lysate.

4. Go to “Prepare the reactions: swab substrate” on page 26 or “Store the sample lysate” on
page 27.

Prepare the sample lysate: heat protocol
This protocol may improve the performance for challenging or aged samples.

1. Preheat the heat block to 90°C or the oven with metal plate adaptor to 99°C.

2. Add 400 pL Prep-n-Go™ Buffer (for buccal swabs, Cat. No. 4471406) to 1.5-mL tubes or the
appropriate wells of a PrepFiler™ 96-Well Processing Plate (Cat. No. A47010).

3. Into each tube or well, put the entire head of each swab. If you are using tubes, cap the tubes. Let
the tubes or plate stand for 20 minutes in the preheated heat block or oven to lyse the sample.

4. After 20 minutes, remove the tubes or the deep-well plate from the heat block or oven.

5. Let the lysate stand at room temperature for at least 15 minutes to cool the lysate (for accurate
pipetting).

6. Transfer the sample lysate out of the 1.5-mL tubes or sample plate into tubes or plates for storage.
Discard the 1.5-mL tubes or deep-well plate containing the swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from the sample
lysate plate before transferring the lysate.

7. Go to “Prepare the reactions: swab substrate” on page 26 or “Store the sample lysate” on
page 27.
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Swab substrates: prepare the amplification kit reactions

Prepare the reactions: swab substrate

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents and prepare Master
Mix (before first use of the kit)” on page 19 before proceeding.

1. Add Prep-n-Go' Buffer (Cat. No. 4471406) to the control wells in the MicroAmp™ Optical 96-Well
Reaction Plate:

To these wells ... Add...
Negative control 3 pL of Prep-n-Go™ Buffer
Positive control For 25 and 26 cycles |0 pL of Prep-n-Go™ Buffer
For 27 cycles 1 pL of Prep-n-Go™ Buffer
For 28 cycles 2 pL of Prep-n-Go™ Buffer

2. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by centrifuging the tubes briefly or tapping the bottles on the bench.

3. Pipet the required volumes of components into an appropriately sized polypropylene tube.

Reaction component Volume per reaction
Master Mix 6.0 uL
Primer Set 6.0 uL

Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! This kit is optimized for a 15-puL PCR volume to overcome the PCR inhibition that is
expected when amplifying unpurified samples. Using a lower PCR reaction volume may reduce the
ability of the kit chemistry to generate full STR profiles.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 12 pL of the reaction mix into each reaction well of a MicroAmp™ Optical 96-Well
Reaction Plate.

The final volume in each well is 15 pL (reaction mix plus Prep-n-Go™ Buffer or sample lysate or
positive control).
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6. Add samples to the reaction plate:

To these well(s) of a MicroAmp™ Optical 96- Add
Well Reaction Plate...
Test samples 3 pL of sample lysate
Positive control For 25 and 26 cycles 3 pL of Control DNA
007
For 27 cycles 2 pL of Control DNA
007
For 28 cycles 1 uL of Control DNA
007

Note: The volumes of positive control are suggested amounts and may be adjusted if peak
heights are too high or too low for your optimized cycle number.

7. Seal the plate with MicroAmp™ Clear Adhesive Film (Cat. No. 4306311) or MicroAmp™" Optical
Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700 with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a MicroAmp™ Optical
Film Compression Pad (Cat. No. 4312639) on top of the plate to prevent evaporation during
thermal cycling. Other validated thermal cyclers do not require a compression pad.

8. Vortex the reaction mix at medium speed for 3 seconds.
9. Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge with plate holders.

10. Amplify the samples as described in Chapter 2, “Perform PCR”.

IMPORTANT! This kit is not validated for use with the GeneAmp™ PCR System 9700 with the
aluminum 96-well block. Use of this thermal cycling platform may adversely affect performance of
this kit.

Store the sample lysate

1. Cap the sample lysate storage tubes or seal the sample lysate storage plate with MicroAmp™ Clear
Adhesive Film.

2. Store the sample lysate as needed:

If you are storing the sample lysate... Then place at...
<2 weeks 2°C to 8°C
>2 weeks —25°C to -15°C
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Note: The effects of multiple freeze/thaw cycles on the lysate have not been fully evaluated.
Therefore, multiple freeze/thaw cycles are not recommended.

Perform PCR

IMPORTANT! This kit is validated for use with the thermal cyclers listed in “Instrument and software
compatibility” on page 15.

1.

28

Program the thermal cycling conditions.

IMPORTANT! I[f you are using the GeneAmp™ PCR System 9700, select the Max ramping mode.
If you are using the ProFlex" 96-well PCR System, select the GeneAmp™ PCR System 9700
simulation mode. If you are using the Veriti" Thermal Cycler, select the 100% ramping rate. Do not
use 9600 emulation mode.

P ; Optimum cycle numberl!]
LDl et Final extension Final hold
step Denature Anneal/Extend
HOLD CYCLE HOLD HOLD
95°C, 1 minute | 94°C, 3 seconds | 60°C, 30 seconds | 60°C, 8 minutes | 4°C, up to 24 hoursl?!

[ See “Optimize PCR cycle number (before first use of the kit)” on page 18.
[ The infinity (c0) setting allows an unlimited hold time.

Load the plate into the thermal cycler, close the heated cover, then start the run.

IMPORTANT! If you are using adhesive clear film instead of caps to seal the plate wells, be
sure to place a MicroAmp™ Optical Film Compression Pad (Cat. No. 4312639) on top of the plate
to prevent evaporation during thermal cycling. The Veriti" Thermal Cycler, ProFlex " 96-well PCR
System, and ProFlex™ 2 x 96-well PCR System do not require a compression pad.

When the run is complete, store the amplified DNA.

If you are storing the DNA... Then place at...
<2 weeks 2°C to 8°C
>2 weeks —25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.
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m Allelic ladder requirements for electrophoresis ........... ... i i 29
B Materials required for electrophoresis ...t e e 30
B Set up the SeqStudio™ instruments for electrophoresis (before first use of the kit) ............ 30
B Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit) ........... 32
B Set up the 3130/3130xlI instruments for electrophoresis (before first use of the kit) ............ 36
B Set up the 3730/3730xl instruments for electrophoresis (before first use of the kit) ............ 38
B Prepare samples for electrophoresis ... i 41

Allelic ladder requirements for electrophoresis

To accurately genotype samples, you must run an allelic ladder with the samples.

Instrument N;:l rg;)::so:oallue:c On(ae;nljvz;::stion Number of samples per allelic ladder(s)
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500x/ 1 per injection 24 samples 23 samples + 1 allelic ladder
3130 1 per 4 injections 4 samples 15 samples + 1 allelic ladder
3130x/ 1 per injection 16 samples 15 samples + 1 allelic ladder

3730/3730x/, 3 per injection 48 samples 15 samples + 1 allelic ladder

48-capillary

SeqgStudio™ 1 per 6 injections 4 samples 23 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment migration speed and
sizing variation between runs. Follow the guidelines in the preceding table, which should account for
normal variation in run speed. Perform internal validation studies to verify the required allelic ladder
injection frequency, to ensure accurate genotyping of all samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the samples. Size
values obtained for the same sample can differ between instrument platforms, because of different
polymer matrices and electrophoretic conditions.
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Materials required for electrophoresis

Appendix B, “Materials required but not supplied” lists the required materials that are not supplied with

this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

Set up the SeqStudio” instruments for electrophoresis
(before first use of the kit)

Electrophoresis software setup

The following table lists the data collection software and the run modules that you can use to analyze
PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 151.

Data Collection
Software v1.2.1

ESIE PRV EEEETE Additional software Run modules and conditions
Analyzer Software
SeqStudio™ SeqgStudio™ None Run Module: HIDAnalysis

Injection Conditions: 1.2 kV/10 sec
Run Conditions: 11 kV/1,120 sec
Dye Set J6

Kit: GlobalFiler Express (to enable marker-to-marker
pull-up reduction feature)

30
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Set up the SeqStudio™ instruments for electrophoresis (before first use of the kit)

Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)

(Cat. No. 4425042).

You need to perform manual calibration for each dye set only once before first use. To determine if a
dye set requires manual calibration, review the calibration history for the dye set.

The following figure is an example of a passing 6-dye spectral calibration.

Capillary 1

GlobalFiler™ Express PCR Amplification Kit User Guide 31



2%  Chapter 3 Perform electrophoresis
Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)

Set up the 3500/3500xL instruments for electrophoresis
(before first use of the kit)

Electrophoresis software setup
The following table lists the data collection software and the run modules that you can use to analyze

PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 151.

Note: We conducted original validation studies for the kit using the 3130x/, 3500, or 3500xL
configurations. Subsequent validation studies for the kit were performed using the 3730x/ 48-capillary
configuration and the SeqStudio™ Genetic Analyzer.

. . 3500 Data
Genetic Operating Collection Additional software Plate templates, assa.y_s, run modules, and
analyzer system conditions
Software
3500 Windows™ 10 v4.0.1 None Assays: AB_J6_LS_POP4 (and _xI)
3500xL anq AB_JGQSB_LS_POP4 (and _xI),
which contain instrument protocols
AB_HID36_POP4_J6_NT3200 (and _xI) and
AB_HID36_POP4_J60OSR_NT3200 (and _xI)
All assays use the following conditions:
¢ Run Module: HID36_POP4(xl)
¢ |njection Conditions: 1.2kV/15 sec
(24 sec for xl)
* Run Conditions: 13kV/1,550 sec
* Dye Set J6 or J6-OSR
3500 Windows™ 7 v3, v3.1 None Plate templates: 6dye_36_POP4 (and _xI)
3500xL Assays (DCv3.1 and earlier): GF+Norm_POP4
. ™ (and _xI) and GF_POP4 (and _xI), which
3500 Windows 7 v2 g'%gg‘éat‘zr contain instrument protocol HID36_POP4
5 %
3500xL (and_xI)_J6_NT3200.
X (Cat. No. 4480670)
All assays use the following conditions:
3500 Windows™ v1 HID Updater e Run module: HID36_POP4(x)
3500xL Vista 3500 DC v2 . o e
(Cat. No. 4480670) Injection conditions: 1.2 kV/15 sec
(24 sec for xl)
* Run conditions: 13 kV/1,550 sec
* Dye Set J6
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Obtain and run the HID Updater (v1 and v2 software only)

Perform this procedure if you are using 3500 Series Software v1 or v2.

You can run 6-dye samples on 3500 Data Collection Software. Before running on either system
for the first time, run the HID Updater 3500 DC v2 (Cat. No. 4480670). The HID Updater installs
plate templates, assays, and instrument protocols that can be used to run GlobalFiler" Express PCR
Amplification Kit samples. For more information, refer to the release notes provided with the Updater.

Note: If you have a new instrument installed by a Thermo Fisher Scientific representative, the updater
may have been run during installation.

1. Shut down the 3500/3500xL Data Collection Software.

2. Download the updater from www.thermofisher.com/us/en/home/technical-resources/
software-downloads/3500-Series-Genetic-Analyzers-for-Human-Identification.html.

3. Open the Read me file and review the software release notes.
4. Click the updater .exe file.
5. Follow the on-screen prompts.

6. Restart the computer.
Modify 3500 QC protocol

The GlobalFiler" Express PCR Amplification Kit has been validated with data that was analyzed using
both the 3rd Order Least Squares method (80-460 base pairs) and Local Southern method (60-460
base pairs).

Before using the QC protocol to acquire data, modify it to:

¢ Change the Baseline Window and Peak Window Settings default settings to the settings shown in
the following figure.

* (Change the size calling default setting to to Local Southern, if needed.

1. In the Library tab, open the QC Protocol window.

2. Create a new QC protocol:
a. Name the new QC protocol according to your laboratory naming convention.

b. Set the following parameters:

Parameter Setting
Size Standard GS600_LIZ_(60-460)
Size Range Partial
Sizing Start Size 60 bp
Sizing Stop Size 460 bp
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(continued)

Parameter

Setting

Size Calling Method

Local Southern Method or 3rd Order Least
Squares

After checking the "Use Baselining" box: 33
Baseline Window Pts.
Peak Window Size 13

c. Click Save.

Setup n OC Protocol

|

* Protocol Name e | Locked |

Description: |

SieStandard:  |GSOLIZ(E0460) v €— '

Sizecaller (sizeCaller .10 ~] |

mﬁc Settings | |

=1l

Analysis Range F_ulll_- Sizing Range: ’E':TI_'J < Size Calling Methed: |Ml I

Analysis Start Point: | 0 Sizing Start Size: 60 A T. |

Analysis Stop Point: | 1000000 Sizing Stop Size 460 A

| |

| |

| /| Blue 'J| Green [# Yellow (/| Red 7 Purple Orange '

| Peak Amplitude Threshold 175 175 175 175 175 175 :

| Common Settings :

.! Use Smoothing [U r t - | . |

| Use Baselining (Baseline Window (Pts)] “'“33_ I e l
i Minimumm Peak Half Width | 2

Peak Window Size 13 <«

Polynomial Degree 3 . I

Slope Threshold Pesk Start 00 {

Siope Threshold PeakEnd | 00 I

¥

|

= I

3. Add the QC protocol to the HID assay.
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Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)

(Cat. No. 4425042).

The following figure is an example of a passing 6-dye spectral calibration.

To enable off-scale recovery (OSR) with 3500 Series Data Collection Software 4.0.1, select the J6-OSR
dye set in the spectral calibration and use the J6 OSR assay to run samples.

= Indemity va Sean Bumier

Cibtestad Dats = BEENEEER i o =

e B8 88 88 88 _

Intamity v Scan burmbar
Iivtessity vs Fined Mumber

FEFEEREE ol el

Inéanurty v Pocal Burrizar
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Set up the 3130/3130x/ instruments for electrophoresis
(before first use of the kit)

Electrophoresis software setup
The following table lists the data collection software and the run modules that you can use to analyze

PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 151.

Note: We conducted original validation studies for the GlobalFiler" Express PCR Amplification Kit
using the 3130xI, 3500, or 3500xL configurations. Subsequent validation studies for the kit were
performed using the 3730x/ 48-capillary configuration and the SeqStudio™ Genetic Analyzer.

. . Data "
ECTE OPErEiiY Collection Al @] Run modules and conditions
Analyzer System software
Software
3130 Windows™ 7 Data 3130/3730 DC v4 | * HIDFragmentAnalysis36_POP4_1 Injection
Collection 6-Dye Module v1 conditions: 3 kV/5 sec
Software v4ll * Run conditions: 15 kV/1500 sec
* Dye Set J6
3130 x/ * HIDFragmentAnalysis36_POP4_1 Injection
conditions: 3 kV/10 sec
* Run conditions: 15 kV/1500 sec
* Dye Set J6

' Requires activation of 6-dye license.

Obtain and activate 6-dye license

1. Confirm that you are running Data Collection Software v4 (Help » About).

2. Obtain a 3130 DC v4 6-Dye Module v1 License key. Contact your local Human Identification
representative for information.

3. Ensure that all network cards in the computer are enabled.

IMPORTANT! You can run the 3130 Series Data Collection Software v4 using only the network
cards that are enabled when you activate the software license. For example, if you activate the
software when your wireless network card is disabled, you will not be able to run the software
when the wireless network card is enabled.
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4. Select Tools » License Manager to display the Software Activation dialog box.

3w Series Data Collection Software 4 Software Activation

Py

1.  Reguestlicense file for Computer ID:

d4beda7d416 d4beddard417

This ID = unigue fo this compuifer and cannot be used to obiain 2 ficense Me for another computer.

a. Enter the license key (from CD or email):

b. Enter your email address:

john.doe@thermofisher. com

c. Is this computer currently connected to the internet?

Yes. Connected. ] l Mo, Mot Connected.

2.  Retrieve the licensze file from email, then save it to the desktop of this computer.

3.  Find the license file:

4, Click Install and Validate License ]

Close

Erowse..,

5. Request the software license file by performing steps 1a, 1b, and 1c as listed on the activation

screen. The license file will be emailed to you.
6. Obtain the software license file from your email.

7. Make a copy of the software license file and keep it in a safe location.

8. Copy the software license file to the desktop of the Data Collection Software v4 computer.

9. If the Software Activation dialog box has closed, select Tools » License Manager.

10. Click Browse, then navigate to the software license file saved on your computer.

11. Click Install and Validate License.
A message is displayed when the license is installed and validated.

12. Click Close.
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Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)

(Cat. No. 4425042).

The following figure is an example of a passing 6-dye spectral calibration.

1.0

0.8

0.6

0.4

0.2

0.

Intensity vs Scan Number

Set up the 3730/3730x/ instruments for electrophoresis

(before first use of the Kit)

Electrophoresis software setup

The following table lists the data collection software and the run modules that you can use to analyze
PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 151.

Software v4l1]

. . Data o
Genetic Operating Collection Additional Run modules and conditions
Analyzer System software
Software
3730x/ | Windows™ 10 Data None * GeneMapper36_POP7_1 Injection
Collection conditions: 2 kV/10 sec
Software v5 e Run conditions: 15 kV/1,200 sec
3730 | Windows™ 7 Data 3130/3730 DCv4 | * DyeSetJ6
Collection 6-Dye Module v1

' Requires activation of 6-dye license.
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Obtain and activate the 6-dye license
1. Confirm that you are running Data Collection Software v4 (Help » About)

2. Obtain a 3730 DC v4 6-Dye Module v1 License key. Contact Thermo Fisher Scientific for
information.

3. Ensure that all network cards in the computer are enabled.

IMPORTANT! You can run the 3730 Series Data Collection Software v4 using only the network
cards enabled when you activate the software license. For example, if you activate the software
when your wireless network card is disabled, you will not be able to run the software when the
wireless network card is enabled.

4. Select Tools » License Managerto display the Software Activation dialog box.

3w Series Data Collection Software 4 Software Activation L&

1. Request license file for Computer ID:

00256421334 002564e213a5

Thiz ID & unigue fo this comouter and cannot be used fo obiain 3 ficense fe for another computer.

a. Enter the license key (from CD or email):

AID-166c-95af-030c-452e-a 163-974c-e6c7-12a6

b, Enter your email address:

john. doe@lifetech. com

c. Is this computer currently connected to the internet?

Yes, Connected. ] [ Mo. Mot Connected.

2.  Retrieve the license file from email, then save it to the desktop of this computer.

3.  Find the license file:

Browse...

4, (Click Install and Validate License ]

Close
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5. Request the software license file by performing steps 1a, 1b, and 1c as listed on the activation
screen. The license file will be emailed to you.
6. Obtain the software license file from your email.
7. Make a copy of the software license file and keep in a safe location.
8. Copy the software license file to the desktop of the Data Collection Software v4 computer.
9. If the Software Activation dialog box has closed, select Tools » License Manager.
10. Click Browse, then navigate to the software license file saved on your computer.

11. Click Install and Validate License.
A message is displayed when the license is installed and validated.

12. Click Close.

Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)
(Cat. No. 4425042).

The following figure is an example of a passing 6-dye spectral calibration.

Intensity vs Scan Number
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Prepare samples for electrophoresis

Prepare samples for electrophoresis

Prepare the samples for electrophoresis immediately before loading.

1. Pipet the required volumes of components into an appropriately sized polypropylene tube:

Reagent Volume per reaction
GeneScan" 600 LIZ"™ Size Standard v2.0 0.5 uL
Hi-Di™ Formamide 9.5 uL

Note: Include volume for additional samples to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested amount.
Determine the appropriate amount of size standard based on your experiments and results.

2. Vortex the tube, then briefly centrifuge.

3. Into each well of a MicroAmp™ Optical 96-Well Reaction Plate, add:
® 10 pL of the formamide/size standard mixture
* 1 pL of PCR product or Allelic Ladder

Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge the plate to ensure
that the contents of each well are mixed and collected at the bottom.

5. Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.
6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.
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Overview of GeneMapper" ID-X Software

GeneMapper" ID-X Software is an automated genotyping software application for forensic casework,
databasing, and paternity data analysis.

GeneMapper™" ID-X Software v1.4 or later analyzes 4-dye, 5-dye, and 6-dye data and is required to
correctly analyze data that is generated using the GlobalFiler™ Express PCR Amplification Kit. After
electrophoresis, the data collection software stores information for each sample in a .fsa or .hid file. The
GeneMapper™" ID-X Software v1.4 or later allows you to analyze and interpret the data from the .fsa

or .hid files.
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i
Allelic ladder requirements for data analysis

Allelic ladder requirements for data analysis

HID analysis requires at least one allelic ladder sample per run folder. Perform the appropriate
internal validation studies before you use multiple allelic ladder samples in an analysis.

For multiple allelic ladder samples, the GeneMapper ™ ID-X Software calculates allelic bin offsets by
using an average of all allelic ladders that use the same panel in a run folder.

Allelic ladder samples in an individual run folder are considered to be from a single run. When the
software imports multiple run folders into a project, only the ladders in their respective run folders
are used for calculating allelic bin offsets and subsequent genotyping.

Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type column in a project.
Analysis will fail if the Allelic Ladder Sample Type is not specified.

Injections containing the allelic ladder must be analyzed with the same analysis method and
parameter values that are used for samples, to ensure proper allele calling.

Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can contain full and/or
partial repeat units. An off-ladder allele is an allele that occurs outside the bin window of any
known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample result according to
your laboratory protocol.

File names and versions used in this section

The file names and version numbers of panel, bin, and stutter files that are shown in this section may
differ from the file names that you see when you download or import files.

If you need help to determine the correct files to use, contact your local Human Identification
representative, or go to thermofisher.com/support.
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Set up the GeneMapper" ID-X Software for analysis (before
first use of the kit)

Workflow: Set up GeneMapper™ ID-X Software

Before you use GeneMapper' ID-X Software to analyze data for the first time, you must do the
following:

“Check panel, bin, and stutter file versions on your computer” on page 44
v
“(If needed) Download newer versions of panel, bin, and stutter files” on page 45
v
“Import panels, bins, and marker stutter” on page 45
v

“(Optional) Define custom table or plot settings” on page 48

Check panel, bin, and stutter file versions on your computer
1. Start the GeneMapper'" ID-X Software , then log in with the appropriate user name and password.
2. Select Tools » Panel Manager.

3. Check the version of files that are currently available in the Panel Manager:

a. Select Panel Manager in the navigation pane.
#* Panel Manager
b. Expand the Panel Manager folder and any File Edt Bins Wiew Help
§ubfo|der§ to identify the anglyss flle version that L WEE
is already installed for your kit choice.

F28 " Panel Manager

4. Check the version of files available for import into the
Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to, then open the Panels folder, then check the version of panel, bin, and stutter files
installed.

5. Check for newer versions of the files as described in the next procedure.
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(If needed) Download newer versions of panel, bin, and stutter files
1. Go to www.thermofisher.com/GMIDXsoftware.

2. If the file versions listed are newer than the versions on your computer, download the file
AmpFLSTR Analysis Files.

Note: When downloading new versions of analysis files, see the associated Read Me file for
details of changes between software file versions. Perform the appropriate internal validation
studies before using new file versions for analysis.

3. Unzip the file.

Import panels, bins, and marker stutter

To import the latest panel, bin set, and marker stutter from the website into the GeneMapper™ ID-X
Software database:

1. Start the GeneMapper™ ID-X Software, then log in with the appropriate user name and password.

2. Select Tools » Panel Manager.

' Panel Manager
File Edit Bins View Help

OX WHR

=R .~ Panel Manager

3. Find, then open the folder containing the panels, bins,
and marker stutter:

a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to, then open the AmpFLSTR Analysis Files folder that you unzipped in the previous
procedure.

4. Select AmpFLSTR_Panels.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel Manager,
AmpFLSTR_Panels. This folder contains the panel and associated markers.

#* Import Panels E|

Lok in: |E AmpFLSTR Analysis Files w3X b | ? "||E

\ [Z] AmpFLSTR_Bins_w3H.bxt
§ 2} B AmpFLSTR_Panels Ext

My Recent E] AmpFLSTR_Skutker 3% Ext
Documents

@ File name: |.C\mpFL5TR_PaneIs_v3X.txt | [ Import ]

Deskkop Files of type: |.0.II Filas w | Cancel
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5. Import the bins file:
a. Select the AmpFLSTR_Panels folder in the navigation pane.

s* Panel Manager
File Edit Eins ‘iew Help

w o B W W ® Binset: | AmpFLSTR Bins_... v| i W B 5 W

=

=) ghy Panel Manager Panel Hame Comment
- AmpFLSTR_Parels w3 | |1 [Profiler_v1.2x mull
2 |Profiler_Plus_w1.2% null
3 |SGM_Plus_v1.2% null
4 |COfiler_wl.2% null
S |Identifiler_w1.2% null
& |Profiler_Plus_CODIS_w1.2%  |null
7 |CoOfiler_CODIS_w1.2% null
& |SEfiler_Plus_w1.2% null
g9 |MiniFiler_w1.2¥% null
10 |Identifiler _CODIS_wi1.2¥% null
11 ['Filer _w1.2¥% null
12 |MGM_v3.2% null
13 |Identifiler_Phus_w1.2¥ null
14 |Identifiler_Direct_wi.2¥% null
= 15 |MGM_SElect_wz.2¥ null
16 |MGM_SElect_Express_wi.1%  |null
7 | GlobalFiler_Ex k4 il
[ a4 ][ Cancel ][ Apply ][ Help ]

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the AmpFLSTR Analysis Files folder.

d. Select AmpFLSTR_Bins.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the AmpFLSTR_Panels

folder.

#* Import Panels

Look in: |[E] AmpFLSTR, Analysis Files w3x hd | ? “|| E

3

B ampFLSTR_Bins kxk
L\b [Z] AmpFLSTR_Pariels w3k bt

My Recent E:l AmpFLSTR _Stutter_w3x.txt
Dacuments

F Filenams: | AmpFLSTR_Eins_v3%.txt L[ port

)

Deskiop Files af type: |P.II Files - | Cancel

46 GlobalFiler™ Express PCR Amplification Kit User Guide




Chapter 4 Analyze data with GeneMapper™ ID-X Software ~ [E¥7i¥
Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit) = =1

6. (Optional) View the imported panels and bins in the navigation pane: Double-click the
AmpFLSTR_Panels folder.

The panel information is displayed in the right pane and the markers are displayed below it.

#* Panel Manager

File Edit Bins Yiew Help
G X M MW W= enSeti [AmpRLSTR Bins v VML ERE EEEEEEN | e
- ~ | Dirdier Mrame |Dye Color |Min Sine | Mo Sime | Cortrol Alleles Marer | Comunerte | ¥ Maker | Ladder Alleles
W e Blue  |90.5  |146.5 |15,16 4 nane 0 9,10,11,12,13,14,15,16,17,18
L 2 | Eiue 1510|2150 |1416 4 nane 0 11,12,13,14,15,16,17,18,19,2
i 3 |D165539 Blue  |221.5  |2735 |30 4 nane 0 5,8,9,10,11,12,13,14,15
TPOX 4 |CsFiPo Blue  |277.0  |325.0  |11,12 4 rone ] 6,7,8,9,10,11,12,13,14,15
Yindel 5 [TPOX Blue 3325 |3845 |8 4 nane 0 5,6,7,8,,10,11,12,13,14,15
.g:sEh?g & |findel Green  |79.5 |85 |2 5 rone 1,2
s 7 [AMEL Green (970 (1075 |xy B nane ] P
DiEsst & |Dasiize Green (1085  |176.5  |12,13 4 nane 0 5,6,7,8,,10,11,12,13,14,15,1
Y5391 a |Dzisit Green (1795|2465  |28,31 4 nane 0 24,24.2,75,26,27,28,28.2,29,.
'ETZ;:;S 10 |D18551 Green  |255.5 |347.5  |12,15 4 none 0 7,9,10,10.2,11,12,13,13.2,14,
i 11 |D¥s3a1 Green (3595 |395.5 |11 4 none 7,8,9,10,11,12,13
FGa 12 [Dz5441 vellow  |75.0  [113.5  |14,15 4 nane 0 8,9,10,11,11.3,12,13, 14,15, 1
-D2251045 13 |D195433 vellow (1155  |173.5 |14,15 4 nane 0 6,7,8,9,10,11,12,12.2,13,13.2
'5?22;?? 14 |THO1 Vellow  [174.0 |219.5  |7,9.3 4 none 0 4,5,6,7,8,9,9.3,10,11,13.3
oone 15 |FGA vellow |221.0  |380.0  |24,26 4 none ] 13,14,15,16,17,18,19,20,21,2
sE33 16 |D2251045  |Red 835  |126.5 11,16 3 nane 0 8,9,10,11,12,13,14,15, 16,17,
-D1051248 17 |DEsa1a Red 1335 (1895 |11 4 nane 0 7,8,9,10,11,12,13,14,15,16,1
-D151656 18 |D135317 Red 197.0  |z43.0 |11 4 none 0 5,6,7,8,9,10,11,12,13,14,15,1
:g;?:gé : 19 |D73E20 Red 56,5  |304.5 (7,12 4 nane 0 6,7,8,9,10,11,12,13,14,15
= 20 |SE33 Red 6.0 4440 17,252 4 nane 0 4.2,6.3,8,9,11,12,13,14,15, 1¢
""" R nanie: 21 |Di051z48  |Purple  |G0.0 [132.0 12,15 4 nane 0 ,9,10,11,12,13,14,15, 16,17,
22 |D151656 Purple (1540  |208.5  |13,16 4 rone O 9,10,11,12,13,14,14.3,15,15.:
23 |D1z3as1 Purple (2110|2705 |18,19 4 nane 0 14,15,16,17,18,19,18.3,20,21
24 |D251338 Purple (2755|3555 |20,23 4 nane 0 11,12,13,14,15,16,17,18,19,2
[ o4 ][ Cancel ][ Apply ][ Help ]

7. Import the stutter file:
a. Select the AmpFLSTR_Panels folder in the navigation panel.

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog box.

¢. Navigate to, then open the AmpFLSTR Analysis Files folder.
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d. Select AmpFLSTR_Stutter.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set in the
AmpFLSTR_Panels folder and overwrites any existing stutter ratios associated with the panels
and bins in that folder.

#* Import Panels El

Loak in: |[h AmpFLSTR. Analysis Filas w3k it | ? ”|| E

3 [Z] AmpFLSTR_Bins_w3¥.bxt
Bb [Z] AmpFLSTR_Panels_vax.bxt
My Recant B AmpFLSTR Stutte 1
Docurnents

'T File niarne: |AmpFLSTR Stutter_v3X.kxt | [ Impart ]

Desktop Files of type: |.C\II Files w | Cancel

8. View the imported marker stutters in the navigation pane:
a. Double-click the AmpFLSTR_Panels folder to display the folder.

b. Double-click the folder to display its list of markers below it.

c. Double-click a marker to display the Stutter Ratio & Distance view for the marker in the right
pane.

#* Panel Manager -

File Edit Eins Wiew Help
B W E M W™ binSet ArerLSTR Bnsvax J HLERE EEEEEEN 9
é =y GlobalFiler_Express_v1.1% "

[+ D351358
VWA

Please enter the stutter filter(s) for D21511 marker here If left blank, the global stutter filter will be applied.

[} D165533 Minus Stutter Plus Stutter
CSF1PO
[ TROX Ratio From Distance To Distance Ratio From Distance To Distance
windel 1 L1142 3.25 4.75 1
B AMEL - -
[+ DBS1179 3 3
=k D21511
8 Stutter R.atio & Distance 4 4

: Bﬁzi [ mew ][ Edt || oelete |

[ D25441
(- D195433
- THOL
- FGA
[ D2251045

9. Click Apply, then click OK to add the panel, bin set, and marker stutter to the GeneMapper™ ID-X
Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels, bin sets, and
marker stutter are not imported into the GeneMapper™ ID-X Software database.

(Optional) Define custom table or plot settings

Default views for table and plot settings are provided with the software. For information on defining
custom views, see GeneMapper" ID-X Software Getting Started Guide— Basic Features.
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Create an analysis method

Create an analysis method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis method for each
version of the software. For example, an analysis method that is created in GeneMapper'™ ID-X Software

version 1.2 is not compatible with analysis methods that are created in earlier versions of software, or
with GeneMapper™ Software v3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper ID-X Manager.
[ ,* GeneMapper® ID-X mm__

Find Mame Containing:

Projects | Analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards | Report Settings|

[ mew.. || open.. || savess.. || mport.. || Export.. |

ittt (somey

2. Click the Analysis Methods tab, then click New to open the Analysis Method Editor with the
General tab selected.

3. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To complete this step
quickly, do not save the analysis method until you finish entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.
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Create an analysis method

Enter Analysis Method settings

Enter General tab settings
1.

Analysis Method Editor

General | allele | Peak Detector | Peak Quality | 5Q & GQ Settings |

Enter a Name and select the Security Group appropriate for your software configuration.

3

rAnalysis Method Descripkion
Mame: |GInbaIFiIerExpress_AnaIysisMethod_v3><| |
Security Group: |GeneMapper ID-% Security Group W |
Descripkion: ~
@
Instrument: |
Analysis Tyvpe: HID

[ Save ][ Zancel ][ Help ]

2. (Optional) Enter a Description and Instrument.
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Enter Allele tab settings

IMPORTANT! Perform appropriate internal validation studies to determine the appropriate settings to
use.

1. Select the AmpFISTR_Bins_v3X bin set.

)

Analysis Method Editor

General | Allele | Peak Detectar | Peak Quality | 50 & G0 Settings

Bin Set: |.C\mpFL5TR_Bins_v3X - |
Use marker-specific stutker ratio and diskance if availablg
Marker Repeat Type: Ti Tetra Penta Hexa
Global Cut-off Walue 0.1 0.1 0.0 0.0
MinusA Ratio 0.0 0.0 0.0 0.0
Minusd Diskance From 0.0 a.n a.n a.n
To  |0.0 0.0 0.0 0.0
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From 0.0 0.0 0.0 0.0
To |00 0.0 0.0 0.0
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Diskance From |0.0 0.0 0.0 0.0
To  |0.0 0.0 0.0 0.0
Amelogenin Cutaff

Range Filker, .. Factory Defauls

[ Save As H Save H Cancel H Help ]

Figure 3 Settings used in developmental validation of the kit

2. (Optional) To apply the stutter ratios contained in the AmpFLSTR_Stutter.txt, select the Use
marker-specific stutter ratio and distance if available checkbox (selected by default).

3. If using GeneMapper™ ID-X Software v1.4 or later, enter values for the 4 Marker Repeat Types.

4. Enter the appropriate filter settings.
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Enter Peak Detector tab settings

Figure 4 shows the Peak Detector tab settings that are used in the developmental validation of the kit.
Figure 5 shows the settings for use on the 3730/3730xI DNA Analyzer.

Enter the appropriate values for each field:

Field Values to enter or select Additional information
Ranges Enter the values shown in Figure 4, or adjust as -
needed depending on the polymer and genetic
analyzer that you are using.
Peak Enter the appropriate settings. The software uses these parameters to specify
Detection IMPORTANT! Perform appropriate internal the minimum peak height, in order to limit
validation studies to determine the appropriate | the number ofmdetected peaks..AIthough
peak amplitude thresholds for interpretation of | GéneMapper " ID-X Software displays peaks
data. that fall below the specified amplitude in
electropherograms, the software does not label
or determine the genotype of these peaks.
Smoothing Enter the values shown in Figure 4, or adjust For more information, see the GeneMapper™

and Baseline

as needed dependent on the polymer you are
using.

3730/3730xI DNA Analyzer with POP-7"
polymer only: With the Smoothing setting of
None, the instances of spacing failures for the
D2S441 and D1S1656 markers in some allelic
ladder samples are significantly reduced. With
the default Smoothing setting of Light, failures
of base-pair spacing quality assessment are
observed.

ID-X Software v1.4 New Features and Installation
Procedures User Bulletin (Pub. No. 4477684
Rev. B), "Known issues: 3730 DNA Analyzer
allelic ladder failures".

Size Calling
Method

Select 3rd Order Least Squares, or another
method if validated by your internal validation.

IMPORTANT! Because of the small amplicon
sizes that are generated by the this kit, the

3rd Order Least Squares sizing method is
validated for use with this kit. Perform internal
validation studies before using other sizing
calling methods.

Normalization

(Optional) Select the Normalization checkbox.

A Normalization checkbox is available on this
tab in GeneMapper " ID-X Software for use in

conjunction with data run on the 3500 Series

Genetic Analyzers.

52
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Create an analysis method

Analysis Method Editor [ % |
General | Allele | Peak Detector | peak Quality | SQ & GQ Settings |
Peak Detection Algorithm: Advanced
Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds
| Full Range v |All Sizes = B8 [ ‘ - l
Start Pt:|0 Start Size:|0 -
Stop Pt: | 10000 Stop Size: | 1000 G: | e |
' = | o |
—Smoothing and Baselining "
] Min. Peak Half Width 2 |pts
Smoothing () None }
@ Light Polynomial Degree 3 ‘
() Heavy Peak Window Size 13 Ims
Baseline Window: E33 pts Slope Threshold
Peak Start: 0.0 ‘
~Size Calling Method M
Peak End 0.0

() 2nd Order Least Squares

@) 3rd Order Least Squares Normalzation

() Cubic Spline Interpolation ] Use N lization, if licabl

() Local Southern Method

[ Factory Defaults ]
| save || cancel || Hep |

Figure 4 Settings used in developmental validation of the kit
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Analysis Method Editor

| General | Allele | Peak Detector | peak Quality | SQ & GQ Settings |
Peak Detection Algorithm: Advanced
Peak Detection
_ 5izing Peak Amplitude Threshalds:
i w | Al Sizes - B: R:
Start PL:{0 Start Size:| 0
Stop Pt: 10000 Stop Size: | 1000 G: p:
Y: o
—Smoothing and Baselining
_ ) Min. Peak Half width: |2 pts
Smoothing (@ Mone
_ i : 3
) Light Polynomial Degree
(™) Heavy Peak Window Size: 9 pts
Baseline Window: 33 pts ST
Peak Start: 0.0
—Size Calling Method Peak End: 0.0
(71 2nd Order Least Squares
i@ 3rd Order Least Squares Mormalization
':;:' Cubic Spline Interpolation [] Use Normalization, if applicable
(7 Local Southern Method
(7 Global Southern Method
[ Factory Defaults
[ Save ] [ Cancel ] [ Help ]

Figure 5 Settings for use on the 3730/3730xI DNA Analyzer.
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Enter Peak Quality tab settings

Create an analysis method

IMPORTANT! Perform the appropriate internal validation studies to determine the heterozygous and
homozygous minimum peak height thresholds, maximum peak height threshold, and the minimum peak

height ratio threshold for interpretation of data.

Enter the following values:

Analysis Method Editor

General | Sllels | Peak Detector | Peak Quality | S0 B 50 Setkings

]

Min/Max Peak Height (LPH/TMPH)

Haomozyaaous min peak height
Heterozygous min peak height
Max Peak Height (MPH)

Peak Height: Fatio {PHR
Min peak height ratio

Broad Peak (B0

UL

Max peak width (basepairs)

Allele Mumber (AR}
Max expected alleles:
Faor autasamal markers & AMEL

Far ¥ markers

Allelic Ladder Spike
Spike Detection Enable

Cuk-off Yalue

™

i II
£

Sample Spike Detection
Spike Detection Enable

’ Factory Defaults

Save As ][ Save H Cancel H Help ]
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Enter SQ and GQ tab settings

IMPORTANT! The values that are shown are the software defaults and are the values we used during
developmental validation. Perform appropriate internal validation studies to determine the appropriate
values to use.

Enter the following values:

Analysis Method Editor f'5__<

Cuality weights are between 0 and 1,
~Sample and Contral G0 \Weighting

Broad Peak (BL n.g allele Mumber (M) 1.0
Cuk of Bin Allele (BIM) n.a Low Peak Height [(LPH) 0.3
Cverlap (OWL) 0.8 Maz; Peak Height (MPH) 0.3
Marker Spike {SPE) 0.3 Off-scale (05) 0.8
BMEL Cross Check (ACC) 0.0 Peak: Height Ratio (PHR) 0.3

Contral Concordance (CC) Weight = 1.0 (Only applicable bao conkrals)

—30 Weighting

Broad Peak (B0

—allelic Ladder G0 wWeighting
Spike: (S5PK/SPK) Off-scale (03)

S & G0 Ranges

Sizing Cuality: From |0.75 tol1.0 From OO0k (025

Genotype Quality;  From  |0.75 tol.0 FromOObx (0,25

I Reset Defaults

[ Save ][ Cancel H Help ]

Note: Set the ACC GQ Weighting according to the values you determine during internal validation
studies of the ACC PQV. For example, set the ACC GQ Weighting to 0.3 or higher to flag samples in
which the Amelogenin result is anything other than X, X or X, Y, or does not agree with the results for
the DYS391 or Y indel markers.
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Create a size standard definition file if needed

If you cannot use the default settings that are provided, create a new size standard definition file.

About the GS600_LIZ_ (60-460) size standard definition file

The GS600_LIZ_(60-460) size standard definition that is provided with GeneMapper™ ID-X Software
and used with the Local Southern size calling method contains the following peaks: 60, 80, 100, 114,
120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360, 380, 400, 414, 420,
440, and 460.

This size standard definition has been validated for use with this kit on the genetic analyzers listed
in “Instrument and software compatibility” on page 15. If you need to create your own size standard
definition, see “Create a size standard definition file” on page 58.

If you use POP-7" polymer on a 3730 instrument

The 60 bp size-standard peak may occasionally be obscured by the primer peak. The issue can be
addressed by either of the following steps:
* Re-inject samples in which the 60 base-pair peak is not recognized.

* Use the 80-460 bp size-standard definition after performing appropriate validation studies (as a
general rule, the 60 base-pair peak is not required for accurate fragment sizing with the 3rd Order
Least Squares sizing method).

For more information, see the GeneMapper™ ID-X Software v1.4 New Features and Installation
Procedures User Bulletin (Pub. No. 4477684 Rev. B), “Known issues: 3730 DNA Analyzer sizing
failures”.
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Create a size standard definition file
1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X Manager.

2. Click the Size Standards tab, then click New.

| Analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards | Report Settings |
| Name [Last Saved Owiner Type [Description
CE_F_HID_GSS00 (75-400) |2007-08-09 13:23:5 | gmid: Advanced
CE_F_HID_G5500 (75-450) (2007-05-09 13:24:1 | gmidx
CE_G5_HID_GS500 2006-10-11 13:12:5 | grickc
GSE00_LIZ 2007-06-26 10:43:1 gricx
i
gick
qrid:
i

GSE00_LIZ+Naormalzation_{ |2012-06-06 12:57
GEE00_LIZ+Narmalization_{ |2007-06-27 01:43:1
GHE00_LIZ_(60-460) 2012-08-06 12:21:3
GSE00_LIZ_(B0-400) 2007-06-27 01:43:1

| EN T

3. Specify settings in the Size Standard Editor:
a. Enter a name as shown in the following figure or enter a new name.

b. In the Security Group field, select the Security Group appropriate for your software
configuration.

c. In the Size Standard Dye field, select Orange.
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d. In the Size Standard Table, enter the peak sizes that correspond to your size standard.

| 4? Size Standard Editor N

Edit

—Size Standard Description
Mame: G5600_LIZ_{50-460)

Security Group: :GeneMapper ID-X Security Group

Description:

Size Standard Dye: :Drange -

—Size Standard Table

PP e
L]

Size in Basepairs
1 p0.o I "

[ Insert H Delete

80.0

100.0

$a | A M2

114.0

" 5 |1z0.0

6 (1400

m

j 7 [160.0

a8 (1500

9 [Z00.0

10 (214.0

11 (2200

12 (240.0

13 |250.0

14 (2600

15 [2G60.0

16 (300.0

17 [314.0

[ QK H Cancel ][ Help ]
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Analyze and edit sample files with GeneMapper" ID-X
Software

1. In the Project window, select Edit » Add Samples to Project, then navigate to the disk or
directory that contains the sampile files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method Select GlobalFilerExpress_AnalysisMethod (or the name of the analysis

method you created).

Panel Select GlobalFiler_Express.

Size Standard Use a size range of 60-460 bp for Local Southern size calling method or a
size range of 80-460 bp for 3rd Order Least Squares size-calling method.!"]

' The GlobalFiler™ Express PCR Amplification Kit was originally validated with the GeneScan™ 600 LIZ™ Size Standard v2.0. If
you use a different size standard, perform the appropriate internal validation studies to support the use of this size standard
with the GlobalFiler™ Express PCR Amplification Kit.

3. Click Analyze, enter a name for the project (in the Save Project dialog box), then click OK to start
analysis.

* The status bar displays the progress of analysis as a completion bar.

* The table displays the row of the sample currently being analyzed in green (or red if analysis
failed for the sample).

* The Analysis Summary tab is displayed, and the Genotypes tab is available when the
analysis is complete.

Fie Edt Analys View Tools Admin Help
COM | % | DEHE WU | MEB | B @ | rabesetng: | [35000ata analyss_eoye Al PBR|De
[

i e [

Analysis Summary Summey Generaton Date: 3 24, 214 359

Selectrun flder to dsplay: (AL

Sonplestans [ Total = of savpls
o

[
§ Uraraeed
o

ayeed o
G nlyss Seting Changed %

Click a ink below to display a fitered Samples Table containing only the samples selected.

Alelic

Run Foder
5 2014:04-19:09-44-42917

o 2 Atz 8| &
1 1 | o
s 214041509 442927 Y - s

Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SO, C6Q)

Tota # of sanges ] @oneor ]
o

o 0 o
0 0 o
0 0 0

‘Sample Quality per project (based on sample PQUS: SOS, SSPK, MIX, OMR, SQ, CGQ)

[ T (] Sone ]

Samples B 2

‘Analyss Conpleted.
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Examine or edit a project

Display electropherogram plots from the Samples and Genotypes tabs of the Project window to
examine the data.

For more information on using the GeneMapper ID-X
Software

See “Related documentation” on page 151 for a list of available documents.
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Importance of validation

Validation of a DNA typing procedure for human identification applications is an evaluation of the
efficiency, reliability, and performance characteristics of the procedure. By challenging the procedure
with samples that are commonly encountered in forensic and parentage laboratories, the validation
process uncovers attributes and limitations that are critical for sound data interpretation (Sparkes,
Kimpton, Watson, 1996; Sparkes, Kimpton, Gilbard, 1996; Wallin, 1998).

Experiment conditions

62

We conducted developmental validation experiments according to the updated and revised guidelines
from the Scientific Working Group on DNA Analysis Methods (SWGDAM, December 2012). Based on
these guidelines, we conducted experiments that comply with guidelines 2.0 and 3.0 and its associated
subsections. This DNA methodology is not novel. (Moretti et al., 2001; Frank et al., 2001; Wallin et al.,
2002; and Holt et al., 2000).

We used conditions that produced optimum PCR product yield and that met reproducible performance
standards. It is our opinion that while these experiments are not exhaustive, they are appropriate for a
manufacturer of STR kits intended for forensic and/or parentage testing use.
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Laboratory requirements for internal validation

Each laboratory using this kit must perform internal validation studies. Performance of this kit is
supported when used according to the following developmentally validated parameters. Modifications
to the protocol should be accompanied by appropriate validation studies performed by the laboratory.

Developmental validation

Except where noted, all developmental validation studies were performed using the Veriti" Thermal
Cycler according to the protocol described in the Perform PCR chapter.

SWGDAM guideline 2.2.1

“Developmental validation is the acquisition of test data and determination of conditions and limitations
of a new or novel DNA methodology for use on forensic, database, known or casework reference
samples.” (SWGDAM, December 2012)

SWGDAM guideline 3.9.2

“The reaction conditions needed to provide the required degree of specificity and robustness should
be determined. These include, but are not limited to, thermal cycling parameters, the concentration

of primers, magnesium chloride, DNA polymerase, and other critical reagents.” (SWGDAM, December
2012)

PCR components

We examined the concentration of each component of the kit. We established that the concentration of
each component was within the range where data indicated that the amplification met the required
performance criteria for specificity, sensitivity, and reproducibility. For example, blood and buccal
samples on treated-paper substrates or swab-sample lysates were amplified in the presence of varying
concentrations of magnesium chloride, and the results were analyzed on a 3500xL Genetic Analyzer
(Figure 6). The performance of the multiplex is most robust within £20% of the optimal magnesium
chloride concentration.
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Figure 6 Buccal swab lysate amplified with the GlobalFiler" Express PCR Amplification Kit in the
presence of varying concentrations of magnesium chloride and analyzed on a 3500xL Genetic Analyzer

(Y-axis scale 0 to 28,000 RFU).
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PCR cycle number

Reactions were amplified for 24, 25, 26, and 27 cycles on the Veriti" Thermal Cycler using a buccal
swab lysate. As expected, the amount of PCR product increased with the number of cycles. A full
profile was generated for all numbers of thermal cycles (24-27) and off-scale data were collected for
several allele peaks at 27 cycle (Figure 7).

None of the cycle numbers tested produced nonspecific peaks.

[[] Mark Sample For Deletion

&5 105 145 125 225 285 305 245 385 a5 285

24 cycles

o boddides defelob dnaltew ol cwmem g g o Fuk

[[] Mark Sample For Deletion

&5 105 145 125 225 265 305 245 385 a5 285

25 cycles

NN A TR O VNI T (A T S oY

[ Mark Sample for Deletion

105 145 125 225 265 205 345 385 425 285

26 cycles
lmm.l NI T O TR A 111 Y T VR WO TU SO

[ Mark Sample for Deletior

5

145 125 225 265 303 345 385 425 285

- l 27 cycles

Figure 7 Representative GlobalFiler™ Express PCR Amplification Kit profiles obtained from amplification
of buccal swab lysates using 24, 25, 26, and 27 cycles, analyzed on a 3500xL Genetic Analyzer (Y-axis
scale 0 to 25,000 RFU).

Thermal cycling temperatures

Thermal cycling parameters were optimized using a Design of Experiments (DOE) approach that
attempts to identify the combination of temperatures and hold times that produce the best assay
performance. Optimal assay performance was determined through evaluation of assay sensitivity, peak-
height balance, and resistance to PCR inhibitors.

For example, annealing/extension temperatures of 58, 59, 60, 61, and 62°C were tested using a Veriti""
Thermal Cycler (Figure 8). The PCR products were analyzed using a 3500xL Genetic Analyzer.

Of the tested annealing temperatures, 59°C to 61°C produced robust profiles. At 58°C, many smaller
amplicons were preferentially amplified relative to the larger amplicons, generating a ski-slope-like
STR profile. At 62°C, the yield of most loci was reduced, and the yield of Amelogenin and D7S820
was significantly affected. The optimal combination of specificity, sensitivity, and resistance to PCR
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inhibition was observed at 60°C. Thermal cycler temperature is critical to assay performance; therefore,
routine, regularly scheduled thermal cycler calibration is recommended.
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Figure 8 Electropherograms obtained from amplification of blood sample on an FTA" card at annealing
temperatures of 58, 59, 60, 61, and 62°C, analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to 20,000
RFU).

Accuracy, precision, and reproducibility
SWGDAM guideline 3.5

“Precision and accuracy of the assay should be demonstrated: Precision characterizes the degree
of mutual agreement among a series of individual measurements, values and/or results. Precision
depends only on the distribution of random errors and does not relate to the true value or specified
value. The measure of precision is usually expressed in terms of imprecision and computed as a
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standard deviation of the test results. Accuracy is the degree of conformity of a measured quantity to its
actual (true) value. Accuracy of a measuring instrument is the ability of a measuring instrument to give

responses close to a true value.” (SWGDAM, December 2012)

Accuracy observation

Laser-induced fluorescence detection of length polymorphism at short tandem repeat loci is not a
novel methodology (Holt et al., 2000; and Wallin et al., 2002). However, accuracy and reproducibility of

profiles have been determined from various sample types.

The following four figures show the size differences that are typically observed between sample alleles
and allelic ladder alleles on the 3130x/, 3500, and 3500xL Genetic Analyzers with POP-4™ Polymer
and the 3730 Genetic Analyzer with POP-7" Polymer. The X-axis in the following figures represents
the nominal nucleotide sizes for the GlobalFiler" Express Allelic Ladder. The dashed lines parallel to
the X-axis represent the +0.25-nt windows. The y-axis represents the deviation of each sample allele
size from the corresponding Allelic Ladder allele size. All sample alleles are within £0.5 nt from a
corresponding allele in the Allelic Ladder, irrespective of the capillary electrophoresis platforms.
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Figure 9 Allele Size vs. Allelic Ladder Sizing for 84 samples analyzed on a 3130x/ Genetic Analyzer.
Size and ladder sizing for the GlobalFiler™ Express PCR Amplification Kit were calculated using the

GeneScan' 600 LIZ" Size Standard v2.0.
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Figure 10 Allele Size vs. Allelic Ladder Sizing for 84 samples analyzed on a 3500 Genetic Analyzer. Size
and ladder sizing for the GlobalFiler" Express kit were calculated using the GeneScan" 600 LIZ" Size

Standard v2.0.
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Figure 11 Allele Size vs. Allelic Ladder Sizing for 84 samples analyzed on a 3500xL Genetic Analyzer.
Size and ladder sizing for the GlobalFiler" Express kit were calculated using the GeneScan" 600 LIZ"

Size Standard v2.0.
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Figure 12 Allele Size vs. Allelic Ladder Sizing for 84 samples analyzed on an 3730 Genetic Analyzer. Size
and ladder sizing for the GlobalFiler" Express kit were calculated using the GeneScan” 600 LIZ" Size
Standard v2.0.

Precision and size window description

Sizing precision enables the determination of accurate and reliable genotypes. The recommended
method for genotyping is to use a +0.5-nt “window” around the size obtained for each allele in

the allelic ladder. A +0.5-nt window allows for the detection and correct assignment of alleles. Any
sample allele that sizes outside the specified window could be either:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the allelic ladder.
* An allele that does correspond to an allele in the allelic ladder, but whose size is just outside a
window because of measurement error.

The measurement error inherent in any sizing method can be defined by the degree of precision in
sizing an allele multiple times. Precision is measured by calculating the standard deviation in the size
values obtained for an allele that is run in several injections on a capillary instrument.
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Precision observation

Table 2 lists typical precision results obtained from multiple runs of the GlobalFiler" Express Allelic Ladder
using the GeneScan™ 600 LIZ™ Size Standard v2.0. The results were obtained within a set of injections on a
single capillary array. The number of repeated injections for each genetic analyzer platform is shown in the

following table:

CE platform Capillaries ?nl;:::tt)gnzf Sizing method
3130x/ 16/injection 5 Local Southern, 60-460 bp
3500 8/injection 12 Local Southern, 60-460 bp
3500xL 24/injection 4 Local Southern, 60-460 bp
3730 48/injection 4 3rd Order Least Square

The mean sizes and the standard deviation for the allele sizing were calculated for all the alleles in each run
(Table 2). The mean range and the standard deviation range show the lowest and highest values obtained
across multiple runs.

Sample alleles can occasionally size outside of the +0.5-nt window for a respective Allelic Ladder allele
because of measurement error. The frequency of such an occurrence is lowest in detection systems with the
smallest standard deviations in sizing. The figures in “Accuracy observation” on page 67 illustrate the tight
clustering of allele sizes obtained on the Applied Biosystems™ genetic analyzers, where the standard deviation
in sizing is typically less than 0.15 nt. The instance of a sample allele sizing outside the +0.5-nt window
because of measurement error is relatively rare when the standard deviation in sizing is approximately 0.15 nt
or less (Smith, 1995).

For sample alleles that do not size within a +0.5-nt window, the PCR product must be rerun to distinguish
between a true off-ladder allele versus measurement error of a sample allele that corresponds to an allele in
the Allelic Ladder. Repeat analysis, when necessary, provides an added level of confidence in the final allele
assignment.

GeneMapper™ ID-X Software automatically flags sample alleles that do not size within the prescribed window
around an allelic ladder allele by labeling the allele as OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections. Cross—platform sizing
differences occur due to several factors including type and concentration of polymer, run temperature, and
electrophoresis conditions. Variations in sizing can also occur between runs on the same instrument and
between runs on different instruments of the same platform type because of these factors.

IMPORTANT! To minimize the variation in sizing between runs and to ensure accurate genotyping, follow the
guidelines in “Allelic ladder requirements for data analysis” on page 43 and use allelic ladders obtained from
the same run as samples to analyze the samples.

For more information on precision and genotyping, see Lazaruk et al., 1998 and Mansfield et al., 1998.
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Q Table2 Precision results of multiple runs of the GlobalFiler™ Express Allelic Ladder

o

Q

g 3130x/ 3500 3500xL 3730

@

2 Allele

Y Mean Staljnd.ard Mean Star_1d'f1rd Mean Star)de.ard Mean Star_1dr_:1rd

< deviation deviation deviation deviation

%

s AMEL

9

§ X 98.86-98.89 0.022-0.027 98.63-98.68 0.031-0.051 98.58-98.62 0.042-0.047 100.47-100.49 0.065-0.069

k<]

= Y 104.90-104.93 0.025-0.037 104.71-104.77 0.019-0.050 104.67-104.69 0.030-0.043 106.20-106.22 0.050-0.061

Q

S | csF1PO

X

~ 6 282.58-282.63 0.022-0.042 283.17-283.26 0.017-0.062 283.17-283.26 0.046-0.059 282.49-282.63 0.048-0.079

D

g) 7 286.54-286.59 0.026-0.046 287.12-287.21 0.026-0.049 287.13-287.25 0.035-0.054 286.48-286.62 0.066-0.079

S

@ 8 290.49-290.54 0.029-0.045 291.09-291.18 0.031-0.066 291.10-291.22 0.044-0.056 290.47-290.62 0.065-0.070
9 294.44-294.49 0.026-0.039 295.04-295.14 0.030-0.061 295.07-295.18 0.032-0.055 294.47-294.62 0.061-0.081
10 298.38-298.42 0.038-0.052 298.99-299.09 0.006-0.059 299.01-299.12 0.032-0.063 298.49-298.61 0.072-0.076
11 302.28-302.33 0.025-0.043 302.91-302.99 0.016-0.062 302.91-303.03 0.035-0.054 302.46-302.63 0.061-0.082
12 306.19-306.25 0.038-0.044 306.84-306.91 0.025-0.063 306.84-306.97 0.040-0.063 306.46-306.62 0.070-0.080
13 310.15-310.20 0.029-0.043 310.81-310.91 0.042-0.064 310.83-310.96 0.045-0.058 310.46-310.61 0.064-0.091
14 314.18-314.23 0.038-0.042 314.87-314.96 0.005-0.078 314.88-315.01 0.037-0.047 314.46-314.61 0.058-0.074
15 318.40-318.45 0.034-0.039 319.10-319.18 0.004-0.063 319.10-319.25 0.045-0.061 318.45-318.62 0.064-0.081

D10S1248

8 85.31-85.33 0.025-0.036 85.39-85.46 0.024-0.051 85.37-85.40 0.031-0.046 86.20-86.26 0.060-0.068
9 89.40-89.43 0.025-0.035 89.53-89.58 0.022-0.055 89.49-89.52 0.033-0.045 90.15-90.22 0.062-0.075
10 93.47-93.49 0.030-0.037 93.62-93.68 0.035-0.057 93.58-93.63 0.040-0.053 94.07-94.17 0.066-0.075
11 97.54-97.57 0.026-0.040 97.73-97.79 0.006-0.054 97.70-97.73 0.045-0.050 98.04-98.11 0.057-0.069

L.

Ayqronpoude. pue ‘uoisioald ‘Aoeindoy

s1nsa. pue syusulLedxy G Je1deyn

5
|-



cl

apIND J8sN Iy uonedyIdwY HOd Sseldxg | 1o]i4/eqolD

3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
12 101.62-101.65 0.029-0.036 101.84-101.90 0.017-0.053 101.80-101.86 0.041-0.045 101.96-102.07 0.048-0.074
13 105.70-105.73 0.029-0.037 105.96-106.03 0.034-0.052 105.90-105.96 0.037-0.043 105.90-106.00 0.064-0.068
14 109.75-109.79 | 0.030-0.038 | 110.02-110.09 | 0.014-0.065 | 109.98-110.05 | 0.038-0.048 109.85-109.95 0.065-0.074
15 113.74-113.79 0.027-0.039 114.05-114.13 0.001-0.058 114.01-114.08 0.019-0.048 113.77-113.88 0.064-0.068
16 117.65-117.69 0.026-0.035 117.95-118.02 0.001-0.046 117.90-117.97 0.038-0.050 117.70-117.81 0.059-0.070
17 121.52-121.56 0.029-0.043 121.85-121.91 0.004-0.054 121.81-121.86 0.032-0.048 121.64-121.75 0.069-0.083
18 125.40-125.45 0.028-0.041 125.77-125.85 0.022-0.062 125.73-125.79 0.036-0.048 125.56-125.69 0.066-0.082
19 129.32-129.37 0.027-0.045 129.73-129.78 0.028-0.049 129.68-129.75 0.040-0.053 129.47-129.60 0.061-0.071
D12S391
14 216.01-216.08 0.040-0.040 216.47-216.57 0.019-0.061 216.54-216.61 0.040-0.060 215.51-215.66 0.054-0.071
15 220.06-220.12 0.040-0.045 220.52-220.59 0.039-0.067 220.61-220.67 0.040-0.055 219.47-219.59 0.054-0.074
16 224.08-224.14 0.040-0.047 224.56-224.64 0.018-0.081 224.66-224.72 0.050-0.059 223.48-223.60 0.062-0.078
17 228.02-228.08 0.029-0.047 228.53-228.62 0.030-0.095 228.61-228.69 0.052-0.065 227.36-227.48 0.063-0.072
18 231.99-232.07 0.033-0.043 232.53-232.60 0.017-0.070 232.58-232.68 0.044-0.057 231.30-231.42 0.063-0.076
19 235.95-236.01 | 0.030-0.044 | 236.50-236.55 | 0.026-0.076 | 236.55-236.64 | 0.050-0.058 235.20-235.32 0.064-0.083
19.3 | 239.02-239.08 | 0.029-0.046 | 239.52-239.62 | 0.001-0.071 | 239.60-239.70 | 0.048-0.065 238.19-238.32 0.062-0.075
20 239.95-240.03 0.028-0.054 240.51-240.61 0.001-0.068 240.58-240.68 0.036-0.061 239.21-239.33 0.061-0.086
21 244.03-244.09 0.033-0.045 244.55-244.65 0.025-0.061 244.62-244.72 0.047-0.055 243.07-243.20 0.067-0.081
22 247.99-248.04 0.033-0.042 248.51-248.60 0.039-0.063 248.57-248.69 0.046-0.055 246.88-247.01 0.057-0.088
23 251.99-252.05 | 0.024-0.039 | 252.50-252.58 | 0.028-0.056 | 252.57-252.66 | 0.051-0.056 250.84-250.97 0.065-0.074
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
24 255.97-256.02 0.031-0.047 256.50-256.58 0.014-0.055 256.54-256.64 0.038-0.053 254.90-255.01 0.064-0.075
25 259.86-259.90 0.033-0.042 260.41-260.52 0.036-0.076 260.46-260.56 0.037-0.059 258.86-258.97 0.067-0.089
26 263.80-263.84 | 0.032-0.039 | 264.37-264.46 | 0.033-0.058 | 264.41-264.52 | 0.045-0.061 262.77-262.90 0.064-0.079
27 267.90-267.95 | 0.033-0.049 | 268.46-268.55 | 0.028-0.064 | 268.54-268.63 | 0.042-0.052 266.86-266.98 0.069-0.076
D13S317
5 198.77-198.81 0.023-0.035 198.95-199.01 0.004-0.055 198.96-198.99 0.045-0.055 199.47-199.56 0.046-0.055
6 202.77-202.82 0.024-0.043 202.92-202.97 0.035-0.065 202.94-202.97 0.039-0.048 203.51-203.58 0.047-0.056
7 206.75-206.79 | 0.022-0.034 | 206.87-206.93 | 206.87-206.93 | 206.89-206.94 | 0.036-0.046 207.55-207.64 0.044-0.053
8 210.82-210.87 0.027-0.037 210.93-210.99 0.009-0.065 210.96-210.98 0.044-0.050 211.70-211.78 0.046-0.053
9 214.85-214.89 0.028-0.037 214.95-214.99 0.008-0.054 214.97-215.00 0.032-0.049 215.74-215.81 0.045-0.057
10 218.95-218.97 | 0.022-0.033 | 219.04-219.09 | 0.032-0.054 | 219.08-219.09 | 0.028-0.053 219.76-219.83 0.042-0.058
11 223.00-223.02 0.022-0.041 223.08-223.15 0.010-0.064 223.13-223.16 0.045-0.054 223.81-223.87 0.045-0.059
12 227.11-227.13 0.024-0.040 227.17-227.25 0.031-0.061 227.24-227.25 0.052-0.067 227.90-227.96 0.047-0.054
13 231.05-231.09 0.029-0.040 231.15-231.20 0.020-0.058 231.19-231.21 0.043-0.050 231.87-231.92 0.040-0.053
14 235.01-235.05 | 0.029-0.036 | 235.11-235.17 | 0.020-0.063 | 235.15-235.18 | 0.042-0.057 235.80-235.86 0.043-0.051
15 239.05-239.08 | 0.031-0.039 | 239.15-239.21 | 0.005-0.062 | 239.19-239.22 | 0.023-0.055 239.85-239.90 0.041-0.056
16 243.18-243.21 0.025-0.036 243.26-243.31 0.005-0.046 243.29-243.32 0.035-0.049 243.89-243.93 0.048-0.051
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation

D16S539
5 227.17-227.21 0.031-0.038 227.46-227.54 0.029-0.063 227.32-227.40 0.044-0.057 228.05-228.18 0.059-0.073
8 239.33-239.37 | 0.028-0.044 | 239.66-239.73 | 0.001-0.057 | 239.49-239.58 | 0.042-0.051 240.14-240.26 0.067-0.077
9 243.46-243.51 0.029-0.038 243.77-243.87 0.005-0.049 243.63-243.72 0.027-0.046 244.18-244.30 0.060-0.073
10 247.59-247.63 0.025-0.045 247.90-247.98 0.001-0.049 247.76-247.84 0.039-0.047 248.20-248.32 0.059-0.070
11 251.65-251.68 0.027-0.039 251.95-252.03 0.008-0.057 251.79-251.89 0.045-0.055 252.23-252.34 0.068-0.073
12 255.61-255.65 | 0.025-0.037 | 255.93-256.00 | 0.006-0.050 | 255.78-255.86 | 0.039-0.045 256.26-256.38 0.059-0.074
13 259.55-259.59 | 0.022-0.036 | 259.89-259.98 | 0.001-0.059 | 259.72-259.84 | 0.051-0.057 260.28-260.40 0.063-0.069
14 263.55-263.60 0.025-0.038 263.91-264.00 0.015-0.059 263.75-263.86 0.050-0.054 264.30-264.43 0.062-0.076
15 267.59-267.63 0.027-0.041 267.93-268.04 0.025-0.056 267.79-267.89 0.043-0.055 268.32-268.43 0.055-0.077

D18S51
7 261.06-261.11 0.024-0.038 261.26-261.37 0.005-0.060 261.21-261.29 0.033-0.048 263.60-263.73 0.047-0.064
9 269.20-269.24 0.025-0.041 269.40-269.49 0.028-0.056 269.33-269.39 0.038-0.054 271.85-271.99 0.048-0.057
10 273.27-273.32 0.026-0.043 273.45-273.53 0.024-0.049 273.41-273.45 0.048-0.054 276.01-276.11 0.045-0.064

10.2 275.27-275.32 0.028-0.040 275.43-275.52 0.014-0.050 275.42-275.45 0.034-0.045 277.97-278.10 0.053-0.060
11 277.35-277.37 0.022-0.035 277.50-277.59 0.009-0.058 277.48-277.52 0.043-0.059 280.14-280.26 0.050-0.058
12 281.39-281.44 0.026-0.037 281.55-281.64 0.008-0.054 281.51-281.54 0.050-0.053 284.28-284.40 0.054-0.058
13 285.42-285.46 0.027-0.038 285.58-285.66 0.018-0.056 285.52-285.55 0.042-0.047 288.40-288.53 0.044-0.064
13.2 287.38-287.42 0.028-0.037 287.54-287.62 0.025-0.052 287.49-287.53 0.049-0.053 290.40-290.51 0.051-0.059

14 289.43-289.46 | 0.033-0.037 | 289.60-289.67 | 0.025-0.058 | 289.52-289.57 | 0.042-0.051 292.56-292.68 0.048-0.062
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
14.2 291.41-291.43 0.027-0.035 291.56-291.64 0.023-0.060 291.50-291.54 0.041-0.052 294.55-294.65 0.054-0.059
15 293.43-293.47 0.022-0.032 293.57-293.66 0.035-0.063 293.53-293.57 0.041-0.045 296.70-296.82 0.051-0.060
16 297.44-297.47 | 0.024-0.039 | 297.58-297.69 | 0.008-0.055 | 297.54-297.57 | 0.034-0.048 300.86-300.95 0.049-0.056
17 301.40-301.43 | 0.025-0.035 | 301.55-301.64 | 0.009-0.058 | 301.49-301.55 | 0.052-0.056 304.98-305.09 0.051-0.060
18 305.36-305.39 0.028-0.046 305.51-305.60 0.028-0.065 305.47-305.52 0.043-0.045 309.12-309.23 0.048-0.054
19 309.38-309.41 0.021-0.039 309.50-309.60 0.019-0.065 309.47-309.54 0.037-0.063 313.27-313.38 0.052-0.062
20 313.44-313.48 | 0.030-0.040 | 313.55-313.66 | 0.000-0.065 | 313.53-313.59 | 0.033-0.063 317.41-317.52 0.050-0.058
21 317.69-317.71 0.027-0.040 317.78-317.91 0.021-0.065 317.78-317.83 0.038-0.057 321.56-321.65 0.057-0.062
22 322.00-322.01 0.028-0.044 322.07-322.20 0.012-0.067 322.06-322.10 0.026-0.056 325.74-325.85 0.050-0.061
23 326.04-326.05 0.020-0.036 326.12-326.23 0.030-0.060 326.11-326.15 0.052-0.063 329.85-329.97 0.044-0.055
24 330.13-330.15 | 0.024-0.035 | 330.21-330.30 | 0.030-0.055 | 330.19-330.25 | 0.036-0.058 333.99-334.10 0.051-0.061
25 334.18-334.22 | 0.030-0.037 | 334.27-334.36 | 0.027-0.072 | 334.28-334.30 | 0.046-0.057 338.14-338.26 0.050-0.056
26 338.22-338.26 0.025-0.049 338.29-338.41 0.008-0.052 338.30-338.35 0.036-0.053 342.29-342.41 0.052-0.063
27 342.29-342.34 0.026-0.038 342.37-342.47 0.011-0.058 342.38-342.42 0.045-0.063 346.45-346.57 0.047-0.057
D19S433
6 118.28-118.35 0.024-0.047 118.50-118.61 0.026-0.068 118.52-118.55 0.042-0.048 120.32-120.46 0.056-0.091
7 122.03-122.10 0.024-0.045 122.28-122.39 0.042-0.085 122.33-122.34 0.040-0.052 124.04-124.19 0.056-0.089
8 125.82-125.89 0.022-0.050 126.11-126.21 0.025-0.063 126.15-126.16 0.046-0.061 127.78-127.91 0.064-0.092
9 129.64-129.68 | 0.031-0.049 | 129.94-130.05 | 0.040-0.067 | 129.99-130.01 | 0.051-0.054 131.52-131.67 0.063-0.107
10 133.46-133.52 | 0.033-0.047 | 133.81-133.93 | 0.034-0.073 | 133.86-133.89 | 0.039-0.058 135.27-135.42 0.068-0.089
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
11 137.33-137.38 0.036-0.048 137.69-137.82 0.044-0.072 137.74-137.78 0.047-0.058 139.00-139.17 0.062-0.085
12 141.22-141.27 0.021-0.044 141.63-141.76 0.044-0.068 141.67-141.73 0.042-0.058 142.78-142.93 0.072-0.091
12.2 143.21-143.27 0.030-0.051 143.63-143.75 0.042-0.084 143.69-143.74 0.038-0.055 144.68-144.85 0.064-0.085
13 145.17-145.22 0.028-0.047 145.60-145.73 0.032-0.068 145.65-145.71 0.044-0.058 146.52-146.71 0.065-0.084
13.2 147.16-147.23 0.031-0.04 147.61-147.73 0.037-0.065 147.67-147.71 0.034-0.060 148.45-148.61 0.072-0.077
14 149.11-149.17 0.036-0.045 149.56-149.69 0.041-0.076 149.64-149.69 0.047-0.062 150.30-150.48 0.059-0.082
14.2 151.11-151.18 0.029-0.051 151.58-151.71 0.035-0.074 151.63-151.71 0.046-0.068 152.22-152.40 0.066-0.093
15 153.07-153.13 | 0.029-0.053 | 153.56-153.67 | 0.032-0.072 | 153.61-153.67 | 0.047-0.056 154.08-154.25 0.062-0.092
15.2 155.06-155.15 0.030-0.040 155.57-155.68 0.036-0.075 155.63-155.69 0.050-0.057 156.00-156.17 0.057-0.089
16 157.02-157.11 0.032-0.052 157.53-157.66 0.031-0.077 157.60-157.66 0.046-0.063 157.86-158.04 0.070-0.086
16.2 | 159.03-159.12 | 0.038-0.050 | 159.57-159.67 | 0.036-0.071 159.61-159.68 | 0.030-0.060 159.79-159.96 0.069-0.087
17 160.98-161.07 0.038-0.048 161.49-161.61 0.007-0.072 161.56-161.62 0.040-0.070 161.63-161.82 0.070-0.094
17.2 162.97-163.04 0.036-0.047 163.50-163.62 0.015-0.073 163.57-163.63 0.051-0.061 163.58-163.75 0.064-0.100
18.2 166.99-167.07 0.030-0.045 167.55-167.66 0.024-0.067 167.61-167.68 0.052-0.060 167.48-167.67 0.065-0.094
19.2 170.89-170.97 0.028-0.044 171.45-171.56 0.034-0.074 171.52-171.61 0.038-0.059 171.28-171.46 0.068-0.095
D1S1656
9 159.91-159.94 0.018-0.037 159.94-160.03 0.000-0.054 159.98-160.00 0.030-0.052 160.85-160.91 0.046-0.058
10 163.93-163.97 0.023-0.036 163.97-164.04 0.016-0.054 163.99-164.02 0.036-0.043 164.81-164.88 0.047-0.058
11 167.94-167.97 | 0.026-0.036 | 167.97-168.05 | 0.028-0.059 | 168.03-168.03 | 0.031-0.046 168.78-168.84 0.051-0.061
12 171.94-171.98 0.025-0.033 172.02-172.07 0.018-0.057 172.03-172.05 0.034-0.048 172.72-172.80 0.050-0.059
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
13 175.95-175.99 0.023-0.033 176.01-176.08 0.012-0.056 176.05-176.07 0.040-0.044 176.69-176.76 0.046-0.066
14 180.02-180.06 0.031-0.038 180.11-180.16 0.004-0.059 180.14-180.16 0.046-0.055 180.71-180.80 0.049-0.060
14.3 183.09-183.12 0.022-0.041 183.17-183.21 0.032-0.056 183.19-183.22 0.027-0.051 183.70-183.78 0.049-0.062
15 184.00-184.04 0.029-0.035 184.10-184.16 0.032-0.052 184.12-184.15 0.035-0.054 184.61-184.67 0.050-0.055
15.3 187.15-187.18 0.020-0.034 187.23-187.30 0.024-0.059 187.28-187.30 0.042-0.049 187.65-187.72 0.049-0.053
16 188.05-188.08 0.021-0.030 188.16-188.22 0.031-0.068 188.19-188.22 0.027-0.045 188.56-188.63 0.056-0.060
16.3 191.19-191.24 0.017-0.035 191.30-191.36 0.023-0.063 191.35-191.37 0.032-0.054 191.62-191.69 0.047-0.055
17 192.10-192.14 0.030-0.039 192.22-192.30 0.021-0.063 192.26-192.28 0.038-0.050 192.52-192.58 0.052-0.063
17.3 195.23-195.26 0.021-0.038 195.37-195.42 0.011-0.060 195.40-195.42 0.035-0.055 195.56-195.64 0.053-0.060
18.3 199.28-199.31 0.020-0.035 199.40-199.47 0.036-0.056 199.44-199.47 0.023-0.049 199.54-199.59 0.050-0.067
19.3 | 203.24-203.27 | 0.025-0.038 | 203.37-203.46 | 0.013-0.057 | 203.40-203.41 | 0.035-0.047 203.50-203.56 0.044-0.060
20.3 207.19-207.22 0.029-0.034 207.32-207.39 0.022-0.057 207.34-207.38 0.041-0.049 207.46-207.52 0.051-0.064
D21S11
24 182.84-182.89 0.020-0.038 183.09-183.14 0.018-0.056 182.98-183.05 0.024-0.049 183.41-183.58 0.060-0.075
242 | 184.92-184.98 | 0.029-0.033 | 185.17-185.23 | 0.026-0.055 | 185.06-185.14 | 0.039-0.055 185.42-185.58 0.051-0.076
25 186.94-187.00 0.027-0.038 187.21-187.26 0.021-0.057 187.11-187.17 0.041-0.054 187.45-187.60 0.053-0.074
26 191.04-191.10 0.019-0.033 191.33-191.37 0.024-0.055 191.21-191.29 0.037-0.059 191.47-191.63 0.060-0.072
27 195.16-195.20 0.025-0.036 195.45-195.52 0.014-0.058 195.35-195.41 0.033-0.051 195.55-195.69 0.059-0.067
28 199.20-199.24 | 0.029-0.039 | 199.49-199.57 | 0.007-0.059 | 199.39-199.46 | 0.021-0.056 199.51-199.66 0.063-0.070
28.2 201.21-201.26 0.027-0.039 201.48-201.53 0.012-0.058 201.38-201.45 0.042-0.054 201.52-201.66 0.053-0.072
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
29 203.16-203.22 0.022-0.037 203.46-203.55 0.004-0.059 203.34-203.41 0.029-0.044 203.48-203.64 0.055-0.070
29.2 205.22-205.27 0.022-0.034 205.49-205.56 0.008-0.067 205.38-205.45 0.039-0.054 205.58-205.74 0.065-0.073
30 207.19-207.25 | 0.022-0.038 | 207.48-207.55 | 0.008-0.060 | 207.36-207.44 | 0.039-0.047 207.54-207.68 0.065-0.067
30.2 | 209.17-209.23 | 0.025-0.041 | 209.45-209.51 | 0.020-0.060 | 209.34-209.41 | 0.038-0.051 209.55-209.70 0.062-0.086
31 211.20-211.24 0.021-0.039 211.48-211.54 0.012-0.061 211.37-211.45 0.048-0.051 211.54-211.71 0.066-0.083
31.2 213.17-213.23 0.021-0.041 213.45-213.53 0.004-0.054 213.33-213.41 0.051-0.057 213.56-213.71 0.059-0.063
32 215.22-215.27 0.020-0.036 215.52-215.57 0.035-0.055 215.40-215.48 0.031-0.044 215.56-215.70 0.057-0.074
32.2 217.26-217.31 0.020-0.034 217.54-217.59 0.031-0.052 217.44-217.51 0.026-0.053 217.57-217.72 0.061-0.075
33 219.33-219.38 0.025-0.041 219.61-219.71 0.006-0.056 219.54-219.60 0.044-0.060 219.58-219.75 0.063-0.074
33.2 221.30-221.34 0.024-0.037 221.60-221.68 0.039-0.061 221.52-221.58 0.028-0.046 221.53-221.70 0.053-0.074
34 223.44-223.48 0.027-0.038 223.75-223.81 0.038-0.058 223.65-223.72 0.050-0.059 223.71-223.86 0.067-0.075
34.2 225.37-225.41 0.033-0.040 225.68-225.76 0.038-0.072 225.59-225.66 0.048-0.063 225.62-225.75 0.062-0.074
35 227.46-227.50 0.032-0.043 227.79-227.86 0.028-0.067 227.68-227.75 0.045-0.058 227.70-227.84 0.069-0.076
35.2 229.41-229.44 0.025-0.042 229.74-229.80 0.024-0.058 229.64-229.72 0.043-0.068 229.63-229.76 0.065-0.077
36 231.40-231.45 | 0.037-0.045 | 231.76-231.83 | 0.026-0.065 | 231.66-231.75 | 0.041-0.054 231.53-231.66 0.056-0.075
37 235.50-235.54 | 0.025-0.044 | 235.84-235.93 | 0.019-0.065 | 235.75-235.84 | 0.042-0.054 235.63-235.77 0.061-0.076
38 239.48-239.53 0.026-0.042 239.83-239.89 0.001-0.059 239.71-239.82 0.047-0.059 239.53-239.69 0.057-0.078
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation

D22S1045
8 88.49-88.51 0.024-0.027 88.33-88.40 0.006-0.045 88.29-88.33 0.029-0.038 90.00-90.01 0.057-0.063
9 91.47-91.48 0.023-0.032 91.33-91.39 0.006-0.047 91.29-91.32 0.026-0.043 92.94-92.96 0.056-0.069
10 94.46-94.47 0.027-0.037 94.31-94.38 0.004-0.051 94.28-94.31 0.034-0.042 95.88-95.91 0.059-0.065
11 97.44-97.46 0.027-0.033 97.30-97.37 0.006-0.050 97.28-97.29 0.030-0.040 98.83-98.87 0.051-0.068
12 100.44-100.46 0.018-0.031 100.31-100.36 0.032-0.053 100.28-100.29 0.027-0.043 101.79-101.83 0.051-0.055
13 103.47-103.49 | 0.018-0.035 | 103.36-103.39 | 0.011-0.070 | 103.31-103.33 | 0.028-0.050 104.76-104.78 0.058-0.065
14 106.49-106.50 | 0.022-0.034 | 106.36-106.43 | 0.001-0.054 | 106.32-106.34 | 0.034-0.041 107.71-107.77 0.050-0.059
15 109.48-109.49 0.028-0.039 109.36-109.41 0.014-0.053 109.33-109.34 0.040-0.049 110.67-110.72 0.052-0.059
16 112.46-112.48 0.032-0.041 112.34-112.39 0.006-0.065 112.30-112.33 0.044-0.051 113.63-113.68 0.054-0.062
17 115.39-115.41 0.023-0.034 115.27-115.34 0.001-0.051 115.24-115.26 0.024-0.037 116.60-116.64 0.048-0.059
18 118.28-118.30 0.025-0.028 118.15-118.23 0.001-0.052 118.10-118.13 0.014-0.033 119.56-119.62 0.046-0.064
19 121.15-121.17 0.029-0.037 121.06-121.10 0.014-0.051 120.98-121.00 0.029-0.048 122.53-122.60 0.044-0.059

D2S1338
11 280.99-281.04 | 0.027-0.035 | 281.61-281.74 | 0.009-0.060 | 281.68-281.78 | 0.049-0.055 281.21-281.39 0.062-0.066
12 284.94-284.99 | 0.031-0.042 | 285.60-285.67 | 0.031-0.059 | 285.60-285.71 | 0.048-0.052 285.24-285.42 0.058-0.069
13 288.88-288.95 0.028-0.036 289.53-289.60 0.026-0.062 289.53-289.66 0.037-0.050 289.29-289.45 0.060-0.075
14 292.82-292.88 0.027-0.045 293.46-293.53 0.019-0.060 293.46-293.58 0.046-0.051 293.33-293.50 0.060-0.075
15 296.70-296.76 0.033-0.041 297.27-297.34 0.037-0.057 297.29-297.41 0.034-0.060 297.42-297.56 0.059-0.064
16 300.63-300.69 | 0.026-0.042 | 301.22-301.30 | 0.009-0.061 | 301.26-301.37 | 0.045-0.052 301.44-301.59 0.060-0.072
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
17 304.53-304.58 0.029-0.041 305.12-305.20 0.027-0.064 305.14-305.27 0.038-0.054 305.48-305.65 0.062-0.074
18 308.46-308.52 0.024-0.036 309.05-309.14 0.015-0.064 309.11-309.22 0.040-0.061 309.50- 309.67 0.057-0.066
19 312.46-312.51 | 0.029-0.042 | 313.06-313.16 | 0.008-0.061 | 313.12-313.25 | 0.043-0.059 313.54-313.72 0.062-0.066
20 316.62-316.67 0.020-0.037 317.21-317.30 0.026-0.065 317.27-317.39 0.047-0.057 317.60-317.76 0.057-0.064
21 320.81-320.86 0.025-0.043 321.40-321.49 0.042-0.064 321.45-321.58 0.038-0.063 321.65-321.82 0.061-0.074
22 324.89-324.95 0.029-0.045 325.44-325.53 0.016-0.058 325.50-325.63 0.049-0.075 325.72-325.88 0.053-0.068
23 328.91-328.99 | 0.029-0.038 | 329.48-329.58 | 0.031-0.066 | 329.57-329.67 | 0.050-0.062 329.76-329.93 0.057-0.077
24 332.95-333.00 | 0.025-0.034 | 333.53-333.61 | 0.018-0.056 | 333.58-333.69 | 0.049-0.060 333.80-333.99 0.060-0.073
25 336.94-337.00 0.024-0.035 337.51-337.59 0.016-0.065 337.57-337.67 0.050-0.058 337.85-338.05 0.057-0.065
26 340.96-341.00 0.026-0.037 341.50-341.57 0.009-0.060 341.57-341.68 0.033-0.061 341.91-342.10 0.060-0.079
27 345.05-345.09 | 0.023-0.036 | 345.58-345.67 | 0.023-0.057 | 345.64-345.74 | 0.047-0.054 345.98-346.18 0.060-0.067
28 349.37-349.42 | 0.026-0.038 | 349.79-349.89 | 0.032-0.062 | 349.90-349.95 | 0.043-0.050 350.21-350.38 0.050-0.063
D2S441
8 76.79-76.81 0.019-0.034 76.57-76.62 0.001-0.046 76.55-76.60 0.026-0.047 78.52-78.54 0.070-0.078
9 80.93-80.95 0.026-0.034 80.74-80.77 0.000-0.047 80.70-80.75 0.035-0.048 82.51-82.55 0.067-0.072
10 85.04-85.08 0.018-0.033 84.87-84.91 0.006-0.052 84.84-84.88 0.029-0.036 86.55-86.57 0.061-0.066
11 89.16-89.18 0.023-0.031 89.01-89.05 0.015-0.048 88.97-89.02 0.036-0.043 90.56-90.59 0.050-0.068
11.3 92.32-92.35 0.025-0.033 92.19-92.24 0.018-0.049 92.16-92.18 0.032-0.040 93.68-93.70 0.058-0.064
12 93.25-93.27 0.020-0.029 93.12-93.17 0.015-0.050 93.09-93.12 0.033-0.041 94.57-94.59 0.052-0.068
13 97.18-97.20 0.022-0.031 97.07-97.11 0.005-0.048 97.03-97.06 0.032-0.046 98.44-98.47 0.047-0.061
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
14 101.30-101.32 0.025-0.033 101.18-101.23 0.011-0.053 101.17-101.18 0.011-0.045 102.46-102.49 0.053-0.067
15 105.43-105.45 0.028-0.033 105.33-105.38 0.001-0.055 105.32-105.34 0.038-0.047 106.50-106.53 0.047-0.061
16 109.55-109.56 | 0.027-0.037 | 109.46-109.51 | 0.030-0.055 | 109.45-109.46 | 0.031-0.046 110.51-110.56 0.053-0.061
17 113.74-113.76 0.031-0.038 113.67-113.72 0.005-0.052 113.65-113.68 0.048-0.051 114.64-114.70 0.053-0.056
D3S1358
9 96.60-96.64 0.022-0.033 96.49-96.55 0.008-0.047 96.47-96.49 0.039-0.049 98.32-98.38 0.061-0.073
10 100.76-100.79 | 0.026-0.037 | 100.66-100.71 | 0.004-0.052 | 100.63-100.65 | 0.044-0.051 102.48-102.54 0.060-0.072
11 104.95-104.97 | 0.026-0.037 | 104.81-104.90 | 0.016-0.051 104.80-104.83 | 0.040-0.048 106.63-106.71 0.060-0.064
12 108.98-109.00 0.024-0.039 108.83-108.92 0.023-0.046 108.83-108.85 0.040-0.044 110.66-110.74 0.054-0.067
13 113.23-113.25 0.032-0.037 113.08-113.17 0.000-0.061 113.07-113.09 0.047-0.052 114.94-115.00 0.055-0.063
14 117.21-117.24 0.024-0.041 117.09-117.14 0.015-0.047 117.06-117.07 0.015-0.035 119.07-119.13 0.051-0.066
15 121.09-121.12 0.023-0.034 120.96-121.04 0.004-0.053 120.92-120.94 0.031-0.050 123.11-123.19 0.049-0.069
16 125.20-125.24 0.030-0.036 125.09-125.15 0.024-0.061 125.05-125.06 0.033-0.047 127.36-127.41 0.053-0.065
17 129.33-129.37 0.023-0.038 129.22-129.29 0.013-0.063 129.18-129.20 0.037-0.047 131.58-131.63 0.051-0.061
18 133.36-133.40 | 0.020-0.035 | 133.26-133.32 | 0.018-0.055 | 133.22-133.23 | 0.044-0.052 135.68-135.75 0.051-0.065
19 137.35-137.39 0.026-0.036 137.24-137.31 0.014-0.058 137.21-137.21 0.041-0.048 139.73-139.80 0.049-0.055
20 141.66-141.71 0.027-0.036 141.56-141.62 0.005-0.054 141.52-141.54 0.038-0.046 144.02-144.09 0.058-0.061
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N 3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
D5S818
7 138.53-138.55 0.025-0.039 138.60-138.68 0.004-0.050 138.58-138.60 0.038-0.056 139.69-139.76 0.051-0.061
8 142.59-142.60 0.027-0.034 142.66-142.71 0.034-0.053 142.63-142.66 0.040-0.051 143.72-143.77 0.052-0.060
9 146.68-146.71 0.013-0.034 146.75-146.82 0.017-0.048 146.74-146.75 0.036-0.048 147.69-147.77 0.045-0.063
10 150.82-150.83 0.022-0.032 150.90-150.97 0.020-0.054 150.89-150.90 0.030-0.042 151.67-151.76 0.047-0.052
11 154.91-154.93 0.029-0.039 155.00-155.06 0.015-0.057 154.98-155.02 0.041-0.052 155.65-155.74 0.045-0.064
12 159.00-159.03 | 0.025-0.038 | 159.10-159.17 | 0.038-0.056 | 159.09-159.12 | 0.037-0.053 159.64-159.70 0.043-0.055
13 163.04-163.09 | 0.019-0.032 | 163.16-163.21 | 0.015-0.051 163.13-163.17 | 0.037-0.053 163.61-163.69 0.050-0.061
14 167.07-167.10 0.026-0.034 167.16-167.24 0.030-0.055 167.17-167.20 0.040-0.044 167.57-167.66 0.056-0.064
15 171.08-171.12 0.021-0.032 171.20-171.26 0.025-0.051 171.20-171.22 0.034-0.056 171.56-171.64 0.055-0.064
16 175.09-175.13 0.029-0.032 175.22-175.27 0.038-0.062 175.22-175.25 0.038-0.055 175.54-175.61 0.052-0.061
§ 17 179.10-179.14 0.021-0.039 179.25-179.31 0.005-0.052 179.25-179.27 0.005-0.050 179.50-179.59 0.054-0.066
g 18 183.16-183.20 0.021-0.035 183.32-183.39 0.026-0.062 183.30-183.37 0.027-0.049 183.49-183.58 0.053-0.070
%:” D7S820
% 6 262.40-262.42 0.025-0.040 262.54-262.60 0.034-0.057 262.55-262.60 0.035-0.051 262.97-263.01 0.049-0.058
% 7 266.41-266.43 | 0.027-0.044 | 266.56-266.62 | 0.020-0.058 | 266.55-266.61 | 0.043-0.052 266.96-266.99 0.050-0.057
?; 8 270.41-270.43 0.025-0.033 270.57-270.63 0.027-0.068 270.58-270.62 0.037-0.053 270.92-270.98 0.050-0.057
% 9 274.43-274.45 0.029-0.034 274.59-274.64 0.027-0.051 274.62-274.64 0.035-0.050 274.92-274.97 0.052-0.060
% 10 278.44-278.46 0.026-0.032 278.61-278.69 0.007-0.060 278.63-278.66 0.038-0.059 278.92-278.97 0.051-0.058
(f) 11 282.43-282.45 0.023-0.032 282.62-282.67 0.011-0.066 282.60-282.64 0.035-0.048 282.91-282.96 0.043-0.068
§
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3130x/ 3500 3500xL 3730
Gles Standard Standard Standard Standard
Mean deviation Mean deviation Mean deviation Mean deviation
12 286.40-286.41 0.028-0.036 286.58-286.64 0.033-0.057 286.57-286.60 0.042-0.054 286.91-286.96 0.051-0.068
13 290.35-290.38 0.026-0.032 290.54-290.61 0.025-0.057 290.54-290.58 0.036-0.045 290.91-290.95 0.052-0.059
14 294.30-294.33 0.027-0.037 294.49-294.57 0.015-0.062 294.51-294.54 0.033-0.054 294.89-294.94 0.050-0.053
15 298.25-298.26 | 0.026-0.051 | 298.46-298.54 | 0.006-0.060 | 298.46-298.49 | 0.042-0.052 298.89-298.94 0.058-0.060
D8S1179
5 114.45-114.46 0.029-0.036 114.21-114.27 0.032-0.052 114.15-114.18 0.031-0.046 116.07-116.10 0.052-0.064
6 118.42-118.43 0.024-0.035 118.20-118.25 0.000-0.054 118.12-118.16 0.029-0.044 120.19-120.24 0.056-0.062
7 122.38-122.40 0.022-0.036 122.17-122.21 0.034-0.057 122.09-122.12 0.035-0.050 124.33-124.37 0.057-0.065
8 126.39-126.41 0.024-0.031 126.18-126.23 0.008-0.052 126.08-126.12 0.035-0.049 128.45-128.50 0.049-0.070
9 130.41-130.43 0.030-0.038 130.21-130.25 0.018-0.062 130.11-130.13 0.039-0.047 132.58-132.61 0.051-0.059
10 134.45-134.49 0.024-0.035 134.25-134.30 0.015-0.049 134.17-134.19 0.037-0.054 136.68-136.75 0.048-0.062
11 138.52-138.57 | 0.028-0.032 | 138.32-138.36 | 0.004-0.054 | 138.24-138.27 | 0.037-0.050 140.81-140.86 0.053-0.068
12 142.66-142.70 0.027-0.040 142.45-142.50 0.012-0.053 142.37-142.39 0.032-0.040 144.93-144.98 0.051-0.060
13 146.89-146.93 0.017-0.039 146.71-146.74 0.023-0.054 146.61-146.64 0.034-0.042 149.11-149.16 0.053-0.060
14 151.05-151.08 | 0.025-0.035 | 150.85-150.89 | 0.025-0.053 | 150.76-150.78 | 0.034-0.040 153.21-153.26 0.053-0.067
15 155.21-155.24 | 0.025-0.038 | 155.00-155.04 | 0.015-0.057 | 154.90-154.93 | 0.036-0.046 157.31-157.36 0.046-0.059
16 159.37-159.40 0.028-0.035 159.16-159.19 0.004-0.057 159.07-159.08 0.032-0.046 161.39-161.45 0.052-0.066
17 163.46-163.49 0.020-0.035 163.25-163.28 0.031-0.051 163.16-163.19 0.030-0.048 165.50-165.54 0.054-0.062
18 167.54-167.57 | 0.022-0.037 | 167.32-167.36 | 0.031-0.048 | 167.23-167.26 | 0.037-0.050 169.59-169.62 0.050-0.062
19 171.62-171.64 0.025-0.034 171.39-171.42 0.024-0.063 171.30-171.33 0.036-0.051 173.66-173.72 0.057-0.062

Ayqronpoude. pue ‘uoisioald ‘Aoeindoy

s1nsa. pue syusulLedxy G Je1deyn

SENI

7
L



¥8

apIND J8sN Iy uonedyIdwY HOd Sseldxg | 1o]i4/eqolD

3130x/ 3500 3500xL 3730
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Mean deviation Mean deviation Mean deviation Mean deviation

DYS391
7 364.73-364.78 0.028-0.044 365.17-365.27 0.028-0.062 365.11-365.19 0.045-0.066 367.09-367.32 0.053-0.065
8 368.80-368.85 | 0.027-0.045 | 369.25-369.35 | 0.025-0.060 | 369.18-369.28 | 0.043-0.061 371.22-371.44 0.054-0.068
9 372.81-372.85 | 0.027-0.036 | 373.25-373.34 | 0.022-0.064 | 373.18-373.28 | 0.046-0.057 375.29-375.52 0.043-0.063
10 376.80-376.86 0.029-0.039 377.24-377.34 0.011-0.067 377.17-377.27 0.044-0.063 379.37-379.59 0.050-0.066
11 380.85-380.89 0.030-0.042 381.26-381.34 0.005-0.057 381.21-381.30 0.044-0.054 383.46-383.67 0.056-0.067
12 384.90-384.95 | 0.030-0.038 | 385.24-385.35 | 0.024-0.064 | 385.21-385.29 | 0.049-0.059 387.45-387.65 0.055-0.074
13 389.00-389.04 | 0.023-0.046 | 389.33-389.43 | 0.027-0.065 | 389.30-389.37 | 0.046-0.056 391.61-391.80 0.055-0.070

FGA
13 223.48-223.53 0.028-0.038 223.35-223.42 0.038-0.080 223.43-223.50 0.036-0.060 226.22-226.30 0.050-0.069
14 227.48-227.55 0.037-0.043 227.38-227.46 0.029-0.079 227.47-227.53 0.045-0.061 230.28-230.34 0.051-0.073
15 231.52-231.59 0.024-0.041 231.40-231.48 0.034-0.073 231.50-231.56 0.050-0.065 234.36-234.41 0.059-0.078
16 235.55-235.62 0.031-0.039 235.43-235.49 0.024-0.077 235.53-235.59 0.047-0.062 238.42-238.47 0.057-0.073
17 239.58-239.64 0.017-0.036 239.45-239.52 0.004-0.071 239.55-239.60 0.025-0.052 242.50-242.54 0.053-0.080
18 243.70-243.75 0.027-0.035 243.55-243.64 0.039-0.087 243.65-243.72 0.042-0.051 246.55-246.61 0.051-0.073
19 247.82-247.87 0.022-0.036 247.63-247.71 0.011-0.065 247.76-247.81 0.053-0.056 250.63-250.67 0.053-0.074
20 251.86-251.89 0.023-0.034 251.68-251.75 0.004-0.070 251.78-251.83 0.024-0.046 254.71-254.76 0.057-0.074
21 255.81-255.84 0.027-0.039 255.61-255.70 0.006-0.070 255.74-255.79 0.032-0.047 258.77-258.84 0.060-0.074
22 259.73-259.77 | 0.031-0.039 | 259.55-259.61 | 0.000-0.072 | 259.66-259.71 | 0.024-0.056 262.85-262.91 0.061-0.073
23 263.74-263.78 | 0.028-0.041 | 263.55-263.62 | 0.031-0.078 | 263.68-263.72 | 0.050-0.056 266.92-266.98 0.060-0.079
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24 267.74-267.79 0.022-0.029 267.55-267.62 0.025-0.067 267.65-267.73 0.038-0.055 270.94-271.01 0.058-0.081
25 271.79-271.84 0.031-0.038 271.58-271.66 0.024-0.067 271.72-271.77 0.041-0.053 275.08-275.15 0.060-0.081
26 275.80-275.87 0.024-0.032 275.61-275.67 0.027-0.063 275.73-275.80 0.044-0.054 279.16-279.20 0.055-0.074
26.2 277.84-277.88 0.026-0.035 277.62-277.70 0.009-0.064 277.76-277.84 0.044-0.059 281.25-281.29 0.059-0.081
27 279.82-279.85 0.028-0.038 279.59-279.66 0.040-0.059 279.70-279.78 0.025-0.060 283.20-283.26 0.059-0.075
28 283.81-283.84 0.029-0.038 283.59-283.65 0.008-0.064 283.68-283.74 0.042-0.053 287.29-287.33 0.051-0.082
29 287.79-287.84 0.030-0.048 287.57-287.63 0.027-0.048 287.67-287.75 0.040-0.055 291.39-291.45 0.062-0.082
30 291.80-291.85 | 0.034-0.046 | 291.57-291.63 | 0.029-0.065 | 291.69-291.75 | 0.044-0.051 295.53-295.60 0.063-0.083
30.2 293.58-293.63 0.027-0.038 293.35-293.42 0.019-0.057 293.46-293.53 0.043-0.050 297.22-297.28 0.063-0.072
31.2 297.55-297.61 0.034-0.037 297.31-297.37 0.008-0.055 297.42-297.50 0.044-0.053 301.32-301.38 0.056-0.085
32.2 | 301.49-301.54 | 0.032-0.044 | 301.24-301.33 | 0.006-0.066 | 301.38-301.44 | 0.031-0.057 305.43-305.49 0.062-0.078
33.2 | 305.42-305.46 | 0.028-0.040 | 305.17-305.25 | 0.028-0.064 | 305.31-305.37 | 0.036-0.056 309.52-309.57 0.059-0.085
42.2 342.26-342.29 0.028-0.049 341.96-342.00 0.008-0.060 342.11-342.18 0.036-0.052 346.61-346.66 0.060-0.086
43.2 346.34-346.37 0.033-0.042 346.01-346.09 0.022-0.071 346.17-346.27 0.036-0.060 350.71-350.78 0.063-0.085
442 | 350.42-350.45 | 0.025-0.047 | 350.10-350.16 | 0.027-0.077 | 350.24-350.34 | 0.042-0.047 354.79-354.84 0.061-0.078
452 | 354.49-354.55 | 0.022-0.041 | 354.18-354.24 | 0.028-0.077 | 354.34-354.42 | 0.050-0.062 358.91-358.96 0.065-0.089
46.2 358.43-358.46 0.027-0.053 358.12-358.18 0.008-0.064 358.27-358.37 0.028-0.060 362.98-363.02 0.060-0.097
47.2 362.45-362.49 0.030-0.043 362.13-362.19 0.046-0.066 362.29-362.37 0.051-0.058 367.09-367.14 0.072-0.094
48.2 | 366.52-366.54 | 0.027-0.041 | 366.21-366.24 | 0.017-0.065 | 366.37-366.45 | 0.044-0.060 371.22-371.30 0.062-0.092
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50.2 374.50-374.53 0.026-0.038 374.16-374.21 0.029-0.074 374.32-374.41 0.037-0.062 379.46-379.51 0.068-0.098
51.2 378.51-378.57 0.027-0.040 378.13-378.21 0.042-0.065 378.32-378.41 0.047-0.066 383.56-383.62 0.063-0.095
SE33
4.2 307.08-307.10 | 0.024-0.037 | 307.12-307.19 | 0.031-0.080 | 307.19-307.22 | 0.038-0.053 310.30-310.35 0.047-0.057
6.3 316.31-316.34 0.028-0.036 316.31-316.39 0.018-0.057 316.40-316.43 0.036-0.051 319.58-319.65 0.045-0.063
8 321.56-321.58 0.024-0.037 321.54-321.62 0.006-0.065 321.65-321.67 0.041-0.067 324.71-324.77 0.047-0.057
9 325.67-325.70 | 0.024-0.038 | 325.63-325.72 | 0.017-0.063 | 325.76-325.77 | 0.047-0.062 328.83-328.88 0.056-0.062
11 333.77-333.80 | 0.029-0.039 | 333.74-333.83 | 0.032-0.053 | 333.86-333.88 | 0.041-0.049 337.06-337.12 0.051-0.063
12 337.85-337.87 0.030-0.040 337.83-337.88 0.016-0.060 337.93-337.94 0.048-0.054 341.22-341.28 0.052-0.061
13 341.90-341.93 0.029-0.038 341.85-341.93 0.011-0.062 341.98-342.00 0.025-0.052 345.34-345.43 0.053-0.061
14 346.01-346.03 | 0.032-0.048 | 345.93-346.02 | 0.026-0.055 | 346.07-346.09 | 0.044-0.053 349.47-349.55 0.051-0.063
15 350.07-350.09 | 0.031-0.041 | 349.99-350.10 | 0.022-0.055 | 350.11-350.14 | 0.037-0.051 353.55-353.63 0.050-0.058
16 354.17-354.20 0.030-0.043 354.11-354.20 0.026-0.060 354.22-354.25 0.043-0.060 357.75-357.82 0.054-0.067
17 358.26-358.29 0.031-0.038 358.20-358.29 0.008-0.060 358.34-358.36 0.055-0.065 361.90-361.97 0.057-0.062
18 362.32-362.33 | 0.026-0.042 | 362.26-362.35 | 0.010-0.065 | 362.41-362.43 | 0.024-0.059 366.01-366.09 0.059-0.065
19 366.28-366.29 | 0.026-0.041 | 366.20-366.31 | 0.030-0.064 | 366.34-366.36 | 0.042-0.052 370.09-370.16 0.059-0.068
20 370.32-370.34 0.026-0.036 370.24-370.33 0.031-0.065 370.38-370.40 0.036-0.050 374.26-374.33 0.059-0.069
20.2 372.32-372.33 0.028-0.041 372.23-372.31 0.026-0.054 372.37-372.39 0.048-0.059 376.32-376.39 0.051-0.067
21 374.33-374.34 0.027-0.036 374.25-374.33 0.026-0.065 374.39-374.40 0.041-0.049 378.37-378.44 0.059-0.072
21.2 | 376.34-376.35 | 0.025-0.035 | 376.23-376.32 | 0.033-0.064 | 376.39-376.41 | 0.047-0.051 380.47-380.51 0.059-0.070
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22.2 370.32-370.34 0.026-0.036 380.22-380.30 0.040-0.065 370.38-370.40 0.036-0.050 384.54-384.60 0.042-0.072
23.2 372.32-372.33 0.028-0.041 384.30-384.41 0.034-0.074 372.37-372.39 0.048-0.059 388.72-388.78 0.061-0.069
242 | 374.33-374.34 | 0.027-0.036 | 388.36-388.45 | 0.023-0.059 | 374.39-374.40 | 0.041-0.049 392.84-392.88 0.061-0.072
252 | 376.34-376.35 | 0.025-0.035 | 392.34-392.42 | 0.033-0.062 | 376.39-376.41 | 0.047-0.051 396.89-396.93 0.061-0.071
26.2 380.33-380.36 0.028-0.044 396.47-396.54 0.010-0.072 380.38-380.40 0.003-0.055 401.09-401.14 0.062-0.075
27.2 384.45-384.47 0.024-0.039 400.48-400.57 0.041-0.065 384.48-384.52 0.050-0.056 405.22-405.25 0.062-0.081
28.2 | 388.50-388.51 | 0.032-0.043 | 404.41-404.50 | 0.021-0.067 | 388.52-388.57 | 0.042-0.059 409.28-409.32 0.061-0.070
29.2 | 392.49-392.52 | 0.030-0.046 | 408.37-408.49 | 0.037-0.076 | 392.51-392.54 | 0.046-0.056 413.39-413.45 0.062-0.075
30.2 396.61-396.65 0.035-0.043 412.39-412.49 0.010-0.071 396.62-396.66 0.030-0.055 417.54-417.60 0.064-0.077
31.2 400.64-400.67 0.036-0.050 416.40-416.49 0.026-0.058 400.65-400.70 0.047-0.054 421.59-421.65 0.060-0.074
32.2 | 404.58-404.60 | 0.037-0.046 | 420.56-420.65 | 0.006-0.063 | 404.58-404.61 | 0.050-0.061 425.81-425.85 0.060-0.077
33.2 | 408.56-408.60 | 0.033-0.050 | 424.57-424.68 | 0.027-0.077 | 408.55-408.60 | 0.049-0.056 429.91-429.96 0.063-0.075
34.2 412.58-412.60 0.024-0.049 428.62-428.72 0.033-0.063 412.57-412.58 0.043-0.057 434.03-434.07 0.064-0.085
35 416.59-416.60 0.019-0.042 430.63-430.72 0.033-0.074 416.57-416.60 0.048-0.057 436.09-436.13 0.069-0.094
35.2 420.74-420.77 0.037-0.051 432.62-432.72 0.038-0.068 420.71-420.74 0.042-0.066 438.11-438.15 0.069-0.082
36 424.76-424.81 0.030-0.055 434.62-434.74 0.031-0.072 424.73-424.78 0.048-0.066 440.17-440.20 0.068-0.084
37 428.79-428.82 0.030-0.050 438.57-438.71 0.039-0.070 428.75-428.79 0.054-0.059 444 .19-444.23 0.068-0.084
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THO1
4 178.72-178.81 0.022-0.042 179.17-179.24 0.001-0.080 179.17-179.24 0.046-0.059 180.08-180.29 0.056-0.075
5 182.76-182.83 | 0.030-0.047 | 183.21-183.29 | 0.034-0.070 | 183.21-183.28 | 0.045-0.054 184.03-184.25 0.053-0.081
6 186.80-186.87 | 0.031-0.042 | 187.28-187.36 | 0.034-0.068 | 187.29-187.36 | 0.043-0.054 187.99-188.19 0.056-0.078
7 190.85-190.92 0.023-0.042 191.34-191.43 0.025-0.064 191.35-191.42 0.045-0.052 191.95-192.15 0.049-0.071
8 194.88-194.96 0.026-0.040 195.39-195.49 0.031-0.070 195.39-195.46 0.042-0.047 195.91-196.13 0.065-0.069
9 198.91-198.99 | 0.029-0.043 | 199.44-199.53 | 0.000-0.080 | 199.43-199.50 | 0.050-0.057 199.90-200.08 0.054-0.074
9.3 201.95-202.04 0.025-0.041 202.46-202.55 0.010-0.067 202.47-202.53 0.047-0.053 202.92-203.11 0.060-0.078
10 202.86-202.94 0.027-0.044 203.38-203.48 0.013-0.065 203.36-203.44 0.039-0.053 203.84-204.04 0.052-0.078
11 206.83-206.90 0.031-0.041 207.31-207.45 0.026-0.071 207.32-207.40 0.047-0.057 207.81-208.00 0.058-0.075

13.3 217.84-217.91 0.029-0.042 218.35-218.43 0.017-0.088 218.37-218.44 0.041-0.052 218.72-218.92 0.057-0.068

TPOX
5 337.43-337.50 0.024-0.046 338.35-338.51 0.008-0.061 338.30-338.51 0.049-0.060 338.62-338.92 0.078-0.089
6 341.43-341.54 0.030-0.052 342.41-342.59 0.012-0.065 342.35-342.56 0.055-0.065 342.67-342.96 0.071-0.095
7 345.60-345.67 | 0.030-0.050 | 346.57-346.71 | 0.021-0.053 | 346.49-346.69 | 0.050-0.059 346.76-347.04 0.081-0.092
8 349.60-349.66 | 0.035-0.042 | 350.55-350.76 | 0.021-0.061 | 350.51-350.72 | 0.040-0.055 350.74-351.05 0.075-0.102
9 353.66-353.71 0.026-0.048 354.66-354.79 0.028-0.078 354.58-354.79 0.046-0.064 354.78-355.08 0.084-0.110
10 357.69-357.76 0.035-0.051 358.71-358.85 0.006-0.061 358.64-358.84 0.051-0.068 358.81-359.12 0.082-0.101
11 361.72-361.77 | 0.031-0.045 | 362.73-362.88 | 0.011-0.066 | 362.66-362.89 | 0.047-0.075 362.85-363.16 0.082-0.098
12 365.71-365.78 | 0.035-0.056 | 366.73-366.89 | 0.028-0.075 | 366.68-366.89 | 0.055-0.075 366.88-367.18 0.085-0.094
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13 369.72-369.79 0.035-0.046 370.76-370.92 0.030-0.062 370.70-370.91 0.054-0.066 370.94-371.22 0.089-0.101
14 373.71-373.79 0.035-0.052 374.77-374.93 0.022-0.071 374.70-374.91 0.055-0.077 374.96-375.25 0.087-0.103
15 377.72-377.79 | 0.037-0.050 | 378.78-378.94 | 0.005-0.065 | 378.70-378.92 | 0.059-0.067 379.02-379.30 0.076-0.097

Y indel
1 81.26-81.31 0.022-0.035 81.08-81.17 0.015-0.049 81.05-81.10 0.033-0.045 82.91-82.99 0.067-0.077
2 86.53-86.58 0.028-0.034 86.38-86.43 0.011-0.060 86.34-86.35 0.028-0.046 88.23-88.31 0.064-0.072

VWA
11 156.50-156.52 | 0.023-0.033 | 156.60-156.65 | 0.015-0.048 | 156.55-156.59 | 0.040-0.048 157.91-158.01 0.042-0.064
12 160.56-160.59 0.019-0.036 160.67-160.71 0.005-0.053 160.64-160.66 0.038-0.055 161.82-161.93 0.054-0.059
13 164.61-164.65 0.021-0.035 164.73-164.77 0.011-0.047 164.68-164.72 0.037-0.052 165.83-165.93 0.053-0.059
14 168.81-168.86 | 0.023-0.032 | 168.95-169.00 | 0.029-0.052 | 168.93-168.97 | 0.040-0.047 169.96-170.07 0.049-0.057
15 172.75-172.77 0.026-0.033 172.86-172.91 0.017-0.055 172.84-172.87 0.037-0.040 173.90-174.01 0.054-0.064
16 176.76-176.80 0.021-0.034 176.91-176.95 0.008-0.049 176.87-176.90 0.037-0.049 177.90-177.99 0.051-0.060
17 180.81-180.83 0.019-0.033 180.95-180.99 0.004-0.056 180.90-180.96 0.045-0.053 181.87-181.98 0.054-0.063
18 184.84-184.89 | 0.025-0.037 | 185.02-185.06 | 0.010-0.050 | 184.97-185.01 0.038-0.053 185.78-185.91 0.056-0.062
19 188.93-188.95 | 0.024-0.034 | 189.10-189.16 | 0.027-0.054 | 189.08-189.12 | 0.043-0.052 189.77-189.88 0.055-0.056
20 193.00-193.02 0.028-0.039 193.19-193.24 0.023-0.059 193.16-193.20 0.036-0.057 193.76-193.86 0.049-0.055
21 197.02-197.05 0.029-0.037 197.23-197.28 0.008-0.060 197.19-197.24 0.046-0.052 197.67-197.79 0.054-0.066
22 201.03-201.06 0.026-0.035 201.25-201.31 0.035-0.056 201.21-201.26 0.044-0.054 201.66-201.76 0.058-0.076
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Extra peaks in the electropherogram

Causes of extra peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes for the
appearance of extra peaks include stutter products, incomplete 3" A nucleotide addition (at the n-1
position), dye artifacts, and mixed DNA samples (see DNA Advisory Board (DAB) Standard 8.1.2.2).

Extra peaks: Stutter

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor peak one repeat
unit smaller than the target STR allele product (minus stutter), or less frequently, one repeat larger (plus
stutter) (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter products at tetranucleotide STR
loci has revealed that the minus stutter product is missing a single tetranucleotide core repeat unit
relative to the main allele (Walsh et al., 1996). Although plus-stutter is normally much less significant
than minus-stutter in STR loci with tetranucleotide repeats, the incidence of plus-stutter may be more
significant in trinucleotide repeat-containing loci.

Contact HID Support for more information on plus stutter.

The proportion of the stutter product relative to the main allele (percent stutter) is measured by dividing
the height of the stutter peak by the height of the main allele peak.

Stutter observations
Peak heights were measured for amplified samples at the loci used in the kit. All data were generated
on the 3500xL Genetic Analyzer. Some conclusions from these measurements and observations are:
* For each locus, the stutter percentage generally increases with allele length.
* Smaller alleles display a lower level of stutter relative to the longer alleles within each locus.
* Each allele within a locus displays a consistent stutter percentage.

* Peaks in the stutter position that are above the stutter filter percentage specified in the software
are not filtered (stutter filter percentage is calculated as the mean stutter for the locus plus three
standard deviations). Peaks in the stutter position that have not been filtered and remain labeled
can be further evaluated.

* The measurement of stutter percentage for allele peaks that are off-scale may be unusually high
due to artificial truncation of the main allele peak.

Marker-specific plus stutter observed in the population study with the GlobalFiler" Express PCR
Amplification Kit is shown in Figure 13 through Figure 19 and listed in Table 3.

Additional marker-specific plus stutter observed in the population study with the GlobalFiler™ Express
PCR Amplification Kit is listed in “Stutter observations” on page 91. Examples of non-standard stutter
peaks at two loci are shown in “Example of non-standard stutter peaks observed at the D2251045 and
SE33 loci” on page 96.

The stutter filter settings that are derived from this data are listed in “Stutter percentage filter settings
that are provided with the GeneMapper™ ID-X Software” on page 98.
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Workflow

Number of samples

Treated paper

284 blood samples on FTA™ Classic Cards
272 buccal samples on Indicating FTA™ Cards

Untreated paper

45 blood samples on FTA™ Bloodstain Cards

90 buccal samples on Bode Buccal DNA Collector™ Device

Buccal swab

45 buccal swab samples lysed in Prep-n-Go™ Buffer

18.0
80
17.0
16.0
15.0
14.0
130
12.0 —

i -
1.0 F | .

.
10.0 I o
: .
2.0 — i
H .
an : ¥
. i
7.0 ;1! "
. T
. B
L)

8.0 I E
H
50 | .

w| i Al
- L]

Parcant Stubier

i
a0 1. ! .
20 I H
10
00
11518 151817 18 ™ 2 LE:RURRE-ARTRLE RI ALRRRFRERTAL R RERL AL F i Fed oL . e ] 4 B W MmIzEMISIEITWIs N
D15 1656 D541 0251338 DE51358

Figure 13 Stutter percentages for D1S1656, D2S441, D2S1338, and D3S1358 loci (Blue=FAM" dye,

black=NED™ dye, purple=SID™ dye)
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Figure 14 Stutter percentages for D5S818, D7S820, D8S1179, and D10S1248 (Green=VIC™ dye,

red=TAZ" dye, purple=SID™ dye)
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Figure 15 Stutter percentages for D12S391, D13S317, and D16S539 loci (Blue=FAM™ dye, red=TAZ"

dye, purple=SID™ dye)
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Figure 16  Stutter percentages for D18S51, D19S433, and D21S11 loci (Green=VIC" dye, black=NED™

dye)
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Figure 17 Stutter percentages for D2251045, DYS391, CSF1PO, and THO1 loci (Blue=FAM™ dye,
green=VIC" dye, black=NED" dye, red=TAZ" dye). Red and orange data points associated with
D22S1045 locus indicate minus and plus stutter, respectively.
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Figure 18 Stutter percentages for FGA and TPOX loci (Blue=FAM™ dye, black=NED™ dye)
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Figure 19  Stutter percentages for SE33 and VWA loci (Blue=FAM" dye, red=TAZ" dye)
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Table 3 Marker-specific plus stutter observed in the population study with the GlobalFiler" Express PCR
Amplification Kit. Data produced on a 3500xL Genetic Analyzer using a 50-RFU threshold cutoff. Markers
that showed negligible plus stutter are omitted.

Loci Observations Mean Star.‘d?rd Minimum Maximum
deviation
D10S1248 156 1.2437 1.0038 0.17 4.58
D12S391 107 0.8623 0.9123 0.22 5.91
D16S539 185 0.859 0.7155 0.19 6.4
D18S51 137 1.0282 0.7157 0.25 5.9
D19S433 31 1.944 1.322 0.27 5.2
D1S1656 448 0.9966 0.6624 0.3 7.26
D21S11 264 1.0044 0.5295 0.42 4.66
D22S1045 787 3.68075 1.53 0.61 11.06
D2S1338 28 1.593 1.75 0.19 7.13
D2S441 259 0.9106 0.6228 0.31 4.65
D3S1358 214 1.282 1.707 0.28 10.3
D8S1179 156 1.2453 1.1121 0.36 7.15
FGA 109 1 1.157 0.32 8.82
THO1 16 1.42 1.5 0.24 6.09
VWA 80 1.069 1.027 0.2 5.01

Example of non-standard stutter peaks observed at the D22S1045 and SE33 loci

STR loci such as D1S1656 (Figure 20) and SE33 (Figure 21) include more complex nucleotide
sequences including regions of dinucleotide repeats which can yield additional stutter peaks. If these
stutter peaks exceed the peak amplitude threshold (typically 175 RFU), they may be detected as
additional alleles in the profile. The stutter file that is provided with the GeneMapper " ID-X Software for
analysis of GlobalFiler™ kit data contain a minus 2—-nt stutter filter for SE33 and D1S1656 to prevent
these peaks from being called in normal profiles (see “Stutter percentage filter settings that are provided
with the GeneMapper™ ID-X Software” on page 98).
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Main allele peak

Minus stutter
l Plus stutter
]

Figure 20 GlobalFiler" Express PCR Amplification Kit electropherogram showing plus stutter associated
with the D22S1045 STR locus. Data produced on a 3500xL Genetic Analyzer.
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Figure 21 Example of a -2 nt reproducible artifact at the SE33 locus. Data produced on a 3500xL
Genetic Analyzer.
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Stutter percentage filter settings that are provided with the GeneMapper™ ID-X

Software

The settings in Table 4 were derived using the data shown earlier in this section. The proportion of
the stutter product relative to the main allele (stutter percent) is measured by dividing the height of the

stutter peak by the height of the main allele peak.

IMPORTANT! The values that are shown in the table are the values that were determined during
developmental validation studies using specific data sets. Always perform internal validation studies to
determine the appropriate values to use for your applications.

Table 4 Marker-specific stutter filter percentages for GlobalFiler” Express kit loci

Locus [l % Stutter
CSF1PO 11.40
D10S1248 12.50
D12S391 15.08
D13S317 9.98
D16S539 10.17
D18S51 13.47
D19S433 10.58
D1S1656 13.08
D1S1656 (-2 nt) 1.79
D21S11 11.42
D2251045 17.30
D2251045 (+3 nt) 8.27
D2S1338 13.14
D2S441 8.75
D3S1358 12.45
D5S818 10.84
D7S820 10.21
D8S1179 10.20
DYS391 8.54
FGA 11.96
SE33 14.42
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Table 4 Marker-specific stutter filter percentages for GlobalFiler Express kit loci (continued)

Locus [l % Stutter
SE33 (-2 nt) 4.97
THO1 5.24
TPOX 5.43
vWA 12.33

M These percentages are used as stutter filters in AmpFLSTR_Stutter.txt

Extra peaks: Addition of 3' A nucleotide

3’ A nucleotide addition definition

Many DNA polymerases can catalyze the addition of a single nucleotide (predominantly adenosine) to
the 3’ ends of double-stranded PCR products (Clark, 1988; Magnuson et al., 1996). This nontemplate
addition results in a PCR product that is one nucleotide longer than the actual target sequence. The
PCR product with the extra nucleotide is referred to as the “+A” form.

3’ A observations

The efficiency of +A addition is related to the particular sequence of the DNA at the 3" end of the PCR
product.

The GlobalFiler™ Express PCR Amplification Kit includes two main design features that promote
maximum +A addition:

* The primer sequences have been optimized to encourage +A addition.

* The PCR chemistry allows complete +A addition with a short final incubation at The new, highly
robust PCR chemistry allows complete +A addition with a short final incubation at 60°C for
8 minutes. .

This final extension step gives the DNA polymerase additional time to complete +A addition to all
double-stranded PCR products. Figure 22 shows examples of incomplete and normal +A addition. Final
extension incubation for longer than the recommended time can result in double +A addition, in which
two nontemplate adenosine residues are added to the PCR product. Double +A addition can cause
"shoulders" on the right side of main allele peaks, and is therefore to be avoided.
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Figure 22 Omitting the final extension step results in shoulders on main allele peaks due to incomplete

A nucleotide addition. Examples shown are the smaller amplicons of FAM™, NED™, and SID™ dye channel
data from a REO00x] Cenetic Analvzer ticina the ClohalFiler™ Exnrece PCR Ambplification Kit
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Due to improved PCR buffer chemistry, the lack of +A addition is generally less of an issue with the
GlobalFiler™ Express PCR Amplification Kit than with earlier generation kits. However, "shouldering"
of allele peaks can still be observed if the amount of input DNA is greater than recommended
concentration. Amplification of excess input DNA can also result in off-scale data.

Extra peaks: Artifacts

Artifact definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are typically reproducible.
Anomalies are non-reproducible, intermittent occurrences that are not observed consistently in a
system (for example, spikes and baseline noise).

Artifact observation

Due to improvements in PCR primer manufacturing processes, the incidence of artifacts has been
greatly reduced in the GlobalFiler™ Express kit. Kit electropherograms are free of reproducible dye
artifacts in the kit read region of 74-444 nt for commonly used analytical thresholds. Figure 23 shows
the low baseline-level fluorescence that is observed in a typical negative control PCR.

However, it is important to consider noise and other amplification-related artifacts when interpreting
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Figure 23 Examples of fluorescence background in data produced on a 3500xL Genetic Analyzer (Y-axis
scale 0 to 200 RFU).
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Characterization of loci

SWGDAM guideline 3.1

“The basic characteristics of a genetic marker should be determined and documented.” (SWGDAM,
December 2012)

Loci in this kit

This section describes basic characteristics of the 21 autosomal STR loci, Y STR locus, Y indel
locus, and sex-determining marker (Amelogenin), that are amplified with the GlobalFiler™ Express PCR
Amplification Kit. Most of these loci have been extensively characterized by other laboratories.

Nature of polymorphisms

The primers for the Amelogenin locus flank a 6-nucleotide deletion in intron 1 of the X homolog.
Amplification generates 99-nt and 105-nt products from the X and Y chromosomes, respectively. (Sizes
are the actual nucleotide size according to sequencing results, including 3" A nucleotide addition, and
size may not correspond exactly to allele mobility observed on capillary electrophoresis platforms.)
Except for D22S1045, a trinucleotide STR, the remaining loci are tetranucleotide short tandem repeat
(STR) loci. The length differences among alleles of a particular locus are caused by differences in the
number of repeat units.

We have sequenced all the alleles in the GlobalFiler" Express PCR Amplification Kit Allelic Ladder,
including microvariants. In addition, other groups in the scientific community have sequenced alleles

at some of these loci (Nakahori et al., 1991; Puers et al., 1993; Mdller et al., 1994; Barber et al., 1995;
Moller and Brinkmann, 1995; Barber et al., 1996; Barber and Parkin, 1996; Brinkmann et al., 1998;
Momhinweg et al., 1998; Watson et al., 1998). Among the various sources of sequence data on the loci,
there is consensus on the repeat patterns and structure of the STRs.

Inheritance

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from families of Utah
Mormon, French Venezuelan, and Amish descent. These DNA sets have been extensively studied all
over the world and are routinely used to characterize the mode of inheritance of various DNA loci.
Each family set contains three generations, generally including four grandparents, two parents, and
several offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance patterns
(Begovich et al., 1992).

Mapping

102

The GlobalFiler™ Express PCR Amplification Kit loci have been mapped, and the chromosomal
locations have been published (Nakahori et al., 1991; Edwards et al., 1992; Kimpton et al., 1992; Mills et
al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993; Barber and Parkin, 1996; and Lareu,
et al., 1996).
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Genetic linkage

Two sets of STR loci in the GlobalFiler Express PCR Amplification Kit are located on the same
chromosomes. VWA and D12S391 are located approximately 6.3 million bp apart on the p arm of
chromosome 12; D2S1338 and D2S441 are located approximately 150 million bp apart on opposite
arms of chromosome 2. Linkage disequilibrium analysis was conducted on the genotype results from
1,034 individuals of three ethnic groups (350 African American, 349 Caucasian, and 335 Hispanic).

STR locus genotype results from the population study were analyzed using the Linkage Disequilibrium
module of GenePop software version 4.0.10 (Raymond and Rousset, 1995; Rousset, 2008). See Table 5
for results.

The relatively high probability values indicate that there is no statistically significant linkage
disequilibrium found between the pairs of loci that are located on the same chromosome.

An independent analysis of data from the same collection of population samples (Budowle, et al., 2010)
also concluded that the 15 STR loci that are shared between the NGM™ and NGM SElect™ kits were
independent at the population level (note that the SE33 locus was not part of this analysis). Therefore,
to calculate the rarity of a profile for comparison to single-source and mixture samples, the frequencies
of all loci including VWA and D12S391 could be multiplied. However, the analysis of the CEPH pedigree
families demonstrated a degree of linkage between VWA and D12S391 that does not support the
assumption of independence for kinship analysis.

Table 5 GenePop software LD Result (p-value for pairwise analysis of loci)

Chromosome African- , . .
Chromosome Nuclear P Caucasian Hispanic
Locus " : merican
map position('] Coordinates!'] (n = 350) (n = 293)
(million bp) (n = 350)
VWA 12p13.31 5.9
0.86 0.29 0.27
D12S391 12p13.2 12.2
D2S441 2p14 68
0.11 0.32 0.19
D2S1338 2935 218

' STR locus mapping data was obtained from the NCBI Map Viewer http://www.ncbi.nlm.nih.gov/projects/mapview/
map_search.cgi?taxid=9606 or the UCSC Genome Browser (http://genome.ucsc.edu/). GenePop LD analysis probability results
(p values) greater than 0.05 were considered to indicate that linkage disequilibrium between the loci within the population tested was
not statistically significant.

Species specificity

SWGDAM Guideline 3.2

“The ability to detect genetic information from non-targeted species (e.g., detection of microbial DNA in
a human assay) should be determined. The detection of genetic information from non-targeted species
does not necessarily invalidate the use of the assay, but may help define the limits of the assay.”
(SWGDAM, December 2012)
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Nonhuman study observation

The GlobalFiler™ Express PCR Amplification Kit provides the required specificity for detecting human
alleles. Species specificity testing was performed to ensure that there is no cross-reactivity with
nonhuman DNA that may be present in forensic casework samples.

The following species were tested (in the specified amounts) using standard PCR and capillary
electrophoresis conditions for the GlobalFiler™ Express PCR Amplification Kit kit:

* Primates: gorilla, chimpanzee, and macaque (1.0 ng each)

* Non-primates: mouse, dog, sheep, pig, rabbit, cat, horse, hamster, rat, chicken, and cow (10.0 ng
each)

* Microorganisms: Candida albicans, Enterococcus faecalis, Escherichia coli, Fusobacterium
nucleatum, Lactobacillus casei, Staphylococcus aureus, Streptococcus mitis, Streptococcus
mutans, Streptococcus salivarius, and Streptococcus viridans (equivalent to 105 copies) (These
microorganisms are commonly found in the oral cavity (Suido et al., 1986; Guthmiller et al., 2001).)

Results were evaluated for the presence of any amplified peaks that would indicate cross reactivity of
the GlobalFiler" Express PCR Amplification Kit with any of these non-human species.

Figure 24 shows example electropherogram results from the species specificity tests. The chimpanzee
and gorilla DNA samples produced partial profiles in the 70-400 nucleotide region (gorilla data not
shown). Macaque DNA produced an Amelogenin X peak, a 6-FAM™ dye peak at 359 bp, a NED™ dye
peak at 278 bp, and two small SID™ dye peaks at 304 bp and 328 bp.

Human| ©
DNA 007 | l Horse

L l Chimpanzee Chicken
NI l Hllu | 81 ll i i i

Dog| I Rat

Cat Mouse

Bovine | | Microbes

Pig Negative

o Control

e

Figure 24 Representative electropherograms for some species tested in a species specificity study. Data
produced on a 3500xL Genetic Analyzer.
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Among the non-primate species, most produced no peaks over a threshold of 175 RFU. Horse
yielded reproducible VIC™ dye peaks at 94 bp (<100 RFU) due to Amelogenin cross-reactivity. Pig
yielded reproducible TAZ" dye peaks at 424 bp (<200 RFU). Individual replicate PCRs of dog,

mouse, and chicken yielded single, small (<50 RFU), non-reproducible peaks. These non-reproducible
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cross-reactivities were not detectable when the dog, mouse, or chicken DNA were amplified in the
presence of human blood or buccal samples on an FTA™ card (data not shown).

Sensitivity
SWGDAM guideline 3.3

“The ability to obtain reliable results from a range of DNA quantities, to include the upper and lower
limits of the assay, should be evaluated.” (SWGDAM, December 2012)

Sample collection factors that can affect DNA quantity

The GlobalFiler™ Express PCR Ampilification Kit has been optimized at 15 pL PCR reaction volume to
overcome the PCR inhibition expected when amplifying:

* Blood samples that are obtained directly from unpurified 1.2 mm treated paper discs

* Buccal cells that are obtained directly from unpurified 1.2 mm treated paper discs (with the addition
of Prep-n-Go™" Buffer)

* Buccal swab sample lysate is prepared using Prep-n-Go™ Buffer
Depending on the following conditions, DNA quantities present on the 1.2 mm disc may vary from
laboratory to laboratory:

* Volume of blood that is spotted onto the treated paper

* (Collecting devices that are used

* Collection methods that are applied

* Swab-to-paper transfer protocol that is used

It is essential to optimize the PCR conditions for types of blood samples and spotting protocol. See
“Optimize PCR cycle number (before first use of the kit)” on page 18.

Effect of DNA quantity on results

If too much DNA is added to the PCR reaction, the increased amount of PCR product that is generated
can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument
(“off-scale” data).
Off-scale data is a problem because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For example, an allele
peak that is off-scale can cause the corresponding stutter peak to appear higher in relative
intensity, thus increasing the calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy results in poor
spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.

To ensure minimal occurrence of offscale data when using the GlobalFiler" Express PCR Amplification
Kit , optimize PCR cycle number according to instructions in the Perform PCR chapter.
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When the total number of allele copies added to the PCR is extremely low, unbalanced amplification of
the alleles may occur because of stochastic fluctuation.
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Sensitivity observation

Figure 25 shows the results of amplification of different input DNA amounts. The y-axis is magnified for
the lower amounts of DNA. All data was collected using the 3500xL Genetic Analyzer. The amount of
DNA was calculated based on the assumptions of 100% cell lysis efficiency and that each cell contains

6 pg of DNA.

To determine an appropriate minimum peak height threshold for your instruments and data, perform
internal validation studies.
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Figure 25 Effect of amplifying varying amounts of white blood cells (WBCs) lysed in Prep-n-Go ™ Buffer.
Samples were amplified for 25 PCR cycles.
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Stability

SWGDAM guideline 3.4

“The ability to obtain results from DNA recovered from biological samples deposited on various
substrates and subjected to various environmental and chemical insults should be evaluated. In

most instances, assessment of the effects of these factors on new forensic DNA procedures is not
required. However, if substrates and/or environmental and/or chemical insults could potentially affect
the analytical process, then the process should be evaluated to determine the effects of such factors.”
(SWGDAM, December 2012)

DNA on FTA™ cards

The following aged samples were prepared to examine the sample-on-substrate stability:

* Finger-prick blood that was spotted onto FTA™ Classic Cards stored for 210 days

e Buccal cells that were collected with the EasiCollect™ device, stored for 120 days
Aged FTA™ samples were amplified with the GlobalFiler"™ Express kit in a Veriti" Thermal Cycler, then
the PCR products were collected and detected using a 3500xL Genetic Analyzer. The analysis shows

that the age of the FTA™ samples did not impact the performance of the GlobalFiler™ Express kit
(Figure 26 and Figure 27).

["] Mark Sample for Delstion

Sample A
30d

| l mll l L ml .11 uhm i i e
Sample A
= l m[x TR Y T 210 days
o Sample B
- l“ [ | 30 days
Sample B
hl || 210 days

Figure 26 Amplification of blood on FTA™ card stored for various amounts of time at room temperature
(Y-axis scale 0 to 19,000 RFU or 0 to 23,000 RFU).
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Figure 27 Amplification of buccal cells on Indicating FTA™ card stored for various amounts of time at

room temperature (Y-axis scale 0 to 12,000 RFU).

DNA on 4N6FLOQSwabs™ sample collectors

110

Aged buccal cell samples on 4N6FLOQSwabs™ sample collectors were prepared to verify their
sample-on-substrate stability. Buccal swabs were collected from 12 individuals over the course of

4 months. The aged 4N6FLOQSwabs™ samples were lysed in Prep-n-Go " Buffer and amplified using
the GlobalFiler" Express kit in a Veriti" Thermal Cycler. The PCR products were run on a 3500xL

Genetic Analyzer.

The results from the aged buccal samples collected on 4AN6FLOQSwabs™ collectors are shown
in Figure 28. The analysis revealed that buccal samples on 4N6FLOQSwabs™ collectors, air-dried
immediately after collection and aged up to 4 months at room temperature, produce acceptable profiles

when amplified with the GlobalFiler" Express kit.
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ure 28 Amplification of buccal cells on 4N6FLOQSwabs™ sample collectors stored for various
ounts of time at room temperature and lysed in Prep-n-Go™" Buffer (Y-axis scale 0 to 5,000 RFU).

ation data

SWGDAM guideline 3.7

“The distribution of genetic markers in populations should be determined in relevant population
groups.” (SWGDAM, December 2012)

Population data overview

To

interpret the significance of a match between genetically typed samples, you must know the

population distribution of alleles at each locus in question. If the genotype of the relevant evidence
sample is:

Different from the genotype of the reference sample for a suspect, then the suspect is excluded as
the donor of the biological evidence that was tested. An exclusion is independent of the frequency
of the two genotypes in the population.

The same as the genotype of the reference sample for a suspect, then the suspect is included as a
possible source of the evidence sample.

The probability that another, unrelated individual would also match the evidence sample is estimated by
the frequency of that genotype in the relevant populations.

GlobalFiler™
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Loci in the kit

The GlobalFiler™ Express PCR Amplification Kit contains loci for which extensive population data are
available. For additional information on the loci shared between many of the AmpF{STR™ kits, see the
population data and additional studies section of the AmpFe¢STR™ NGM SElect™ PCR Amplification Kit
Kit User Guide (Pub. No. 4458841) and the AmpF¢STR" Identifiler™ Plus PCR Amplification Kit User
Guide (Pub. No. 4440211).

Population samples used in these studies

The GlobalFiler™ Express PCR Amplification Kit was used to generate the population data provided
in this section. Whole blood samples, provided by the Interstate Blood Bank (Memphis, Tennessee)
and Boca Biolistics (Coconut Creek, Florida), were collected in the United States (with no geographical
preference) from randomly selected individuals of known ethnicities. Ethnicities of sample donors were:

* African-American—330 samples
* Asian—153 samples

® (Caucasian—343 samples

* Hispanic—368 samples

DNA was extracted with a 6100 Nucleic Acid Prep Station.

The GlobalFiler™ Express PCR Amplification Kit contains loci for which extensive population data are
available.

In addition to the alleles that we observed and recorded in our databases, other alleles have been

published or reported to us by other laboratories (see the STRBase at www.cstl.nist.gov/div831/
strbase).

Concordance studies

The primer sequences used in the GlobalFiler™ kit and GlobalFiler™ Express kit are identical. We
compared allele calls between the two kits. Genotype data from 200 blood samples on FTA™Classic
Cards showed 100% concordance between the two kits. The GlobalFiler" kit genotypes of the above
population data were also compared against the genotypes generated using the Identifiler™ Plus kit
and the NGM SElect™ kit. The few discordant genotypes observed were exclusively found in loci where
degenerate primers were added in the GlobalFiler™ kit to rescue known SNPs found in the primer
binding sites.

Probability of Identity definition

112

The P, value is the probability that two individuals selected at random will have an identical genotype
(Sensabaugh, 1982).
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Probability of identity observation

Chapter 5 Experiments and results a8

Population data

Table 6 shows the Autosomal STR allele frequencies at GlobalFiler™ kit loci by population group.

Table 7 shows the Y-specific allele frequencies by population group for GlobalFiler" Express PCR
Amplification Kit DYS391 and Y indel loci. The Y-specific allele frequencies were not included in the
probability of identity calculation.

Table 8 shows the Probability of identity (P)) values of the GlobalFiler™ Express PCR Amplification Kit
loci individually and combined.

Table 6 Autosomal allele frequencies by population group for GlobalFiler” Express PCR
Amplification Kit STR loci. (*=Alleles not detected or not detected in significant quantities)

Allele Afric(z;nj;gg)rican Asian (n = 153) U.SinC:l:;zg)sian U?n I;Ii:g:)nic
CSF1PO
5 * * * .
6 0.15* * * *
7 3.79 * * 0.95
8 9.39 0.33* 0.29* 0.54*
9 3.79 2.61 2.77 2.58
10 26.21 26.14 27.99 25.14
11 23.33 21.9 31.78 27.45
11.1 * * * 0.14*
12 27.88 38.56 30.76 37.91
13 4.39 9.8 5.98 4.62
14 1.06 0.65* 0.44* 0.54*
15 * * * 0.14*
16 * * * .
D10S1248
7 0.15% * * *
8 * * * 0.14*
9 0.15* ‘ . 0.14*
10 * 0.33* * 0.14*
11 3.64 * 0.58* 0.27
12 14.09 10.78 3.5 4.48
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
13 22.88 36.93 29.45 25.95
14 27.88 22.55 29.74 36.14
15 18.48 22.55 19.39 22.69
16 10.15 5.23 13.41 7.74
17 2.27 1.63 3.64 2.31
18 0.30* * 0.29* *
19 * x * *

D12S391

13 * * * 0.14*
14 * * * 0.14*
15 7.58 2.61 4.37 4.08
15.1 0.15* * * *

16 5.15 0.98* 3.35 5.03
16.1 0.15* * * *

17 16.52 8.17 10.35 7.34
17.1 0.45* * * 0.27*
17.3 0.61* * 1.9 1.22
18 24.55 28.43 16.18 19.7
18.3 1.21 * 2.19 217
19 13.94 23.86 12.54 18.75
19.1 0.61* * * *

19.3 0.30* * 0.58* 1.22
20 11.52 16.99 9.77 17.12

20.3 * * 0.15* *
21 7.27 10.78 13.56 8.7

21.3 0.15* * 0.15* *
22 5 3.59 10.79 6.79
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Population data

PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
23 3.64 3.27 8.16 3.67
24 0.61* 0.98* 3.64 1.9
25 0.61* 0.33* 1.9 1.36
26 * * 0.29* 0.27
27 * * 0.15* 0.14*
D13S317

5 . x x x

6 x * * x

7 * * 0.15* *

8 2.27 29.74 10.93 8.97
9 2.27 12.09 7.14 16.3
10 3.03 13.73 6.85 9.65
11 29.24 25.49 29.01 22.83
12 43.79 14.38 30.76 27.45
13 14.55 3.92 10.64 10.05
14 4.55 0.33* 4.52 4.76
15 0.30* 0.33* * *
16 . x . x
17 . x x x

D16S539

4 * * * .

5 . x . x

6 * * * 0.14*
8 3.33 * 1.46 2.04
9 21.67 31.05 12.68 10.19
10 11.52 14.05 4.08 15.76
11 30 20.59 32.22 31.79
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
12 19.09 21.57 30.9 24.18
13 13.03 11.44 16.76 14.4
14 1.36 1.31* 1.75 1.22
15 * * 0.15* 0.27*
16 * x * x

D18S51

6 * x * *

7 * * * *

9 * * * 0.14*
10 0.15* * 1.17 0.68
10.2 0.15* * * *
11 0.45* 1.31% 0.87 1.22
12 6.21 5.56 15.01 10.46
13 3.94 17.32 11.95 11.41

13.2 0.30* * * *
14 5.91 22.88 17.64 16.3

14.2 0.45* * * 0.14*
15 16.52 16.99 15.31 12.23

15.2 * * * 0.14*
16 18.18 12.42 11.95 12.91
17 16.36 6.54 10.79 17.39
18 14.09 4.9 8.31 7.74
19 9.7 5.23 4.08 3.53
20 4.7 1.96 1.31 1.9

20.2 0.15* * * *
21 1.82 1.96 1.02 217
22 0.61* 0.98* 0.29* 0.68
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PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
23 0.30* 0.98* 0.29* 0.54*
24 * 0.65* * 0.27
25 * * * 0.14*
26 * 0.33* * *
07 * * * .
o8 . x . x

D19S433
5.0 x * * x
6 * * * .
7 . x . x
8 . x x x
9 0.30* 0.33* * *
10 1.21 * 0.15* 0.41*
10.2 0.15% * * *
11 9.85 * * 1.63
11.2 0.30* * * 0.27
12 10.45 4.58 7.29 8.42
12.1 * * 0.15* *
12.2 3.94 0.33* 0.15* 1.49
13 27.88 28.1 27.26 18.48
13.2 5.3 2.61 1.6 6.93
14 18.94 23.2 35.13 30.71
14.2 5.3 9.48 2.04 4.62
15 6.67 7.52 16.18 13.04
15.2 4.39 20.26 3.5 6.79
16 1.52 0.33* 5.69 4.08
16.2 3.18 2.61 0.29* 217
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
17 * * 0.29* 0.54*
17.2 0.61* 0.65* 0.15* 0.41*
18 * * 0.15* *
18.2 * * * *
19.2 * * * *
D1S1656
8 * x * *
9 0.15* * * 0.14*
10 1.36 * 0.29* 0.41*
11 5.3 3.59 6.27 3.94
12 8.48 4.25 15.74 9.38
13 11.06 13.73 7 7.07
14 25 6.21 6.27 11.28
14.3 0.91 * 0.29* 0.27*
15 16.97 20.26 15.31 15.49
15.3 1.82 * 8.75 2.99
16 10 31.05 9.33 15.08
16.1 * * * 0.27*
16.3 7.27 0.65* 4.96 5.16
17 2.73 14.05 4.96 6.79
17.1 * * 0.29* *
17.3 5.76 3.59 12.68 15.76
18 0.45* 0.33* 0.29* 0.82
18.3 1.82 1.63 5.98 4.48
19 0.15* * * *
19.3 0.61* 0.33* 1.6 0.68
20 * 0.33* * *
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
20.3 0.15* * * *
1 . x . x
D21S11
23.2 * * * *
o4 * * * .
24.2 * * * 0.27
o5 . x x x
26 0.30* * 0.58* 0.41*
27 5.91 * 2.62 1.49
28 25.15 4.9 16.76 11.41
28.2 * 0.65* * 0.14*
29 15.61 26.8 23.76 21.06
29.2 * * 0.15* *
29.3 0.15* * 0.15* *
30 20.76 30.72 23.18 2717
30.2 1.67 0.65* 2.77 1.77
31 8.79 9.48 6.85 5.16
31.2 4.55 3.92 8.89 11.14
31.3 * 0.33* * *
32 1.36 2.61 2.33 1.36
32.2 712 14.38 9.62 12.5
33 0.91 0.98* * 0.14*
33.2 3.18 4.58 1.9 53
34 0.15% * * *
34.2 * * 0.44* 0.14*
35 3.64 * * 0.27
350 . x x x
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
36 0.76 * * 0.14*
37 * x x x
38 * * * 0.14*
39 * * * *

D22S1045

7 * x x x

8 0.61* * * *

9 * * * *
10 4.09 * 0.44* 0.68
11 14.7 15.36 13.85 7.61
12 6.21 0.33* 0.58* 0.95
13 0.30* 0.33* 1.02 1.09
14 7.88 0.33* 3.35 2.04
15 23.33 33.66 36.3 43.48
16 20.3 23.86 36.3 34.65
17 20.45 24.18 7.58 8.42
18 212 1.96 0.58* 0.95
19 * x x x
20 * * * 0.14*

D2S1338

10 * x * x
11 * x x x
12 * x * *
13 0.15* * 0.15* *
14 * * 0.15* *
15 0.30* * 0.15* *
16 5.3 1.63 4.08 3.8

GlobalFiler™ Express PCR Amplification Kit User Guide




Chapter 5 Experiments and results 78
Population data

Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
17 10 14.05 18.37 17.8
18 4.85 13.07 8.31 6.52
19 16.21 16.67 14.14 17.53
20 10.45 8.82 15.74 13.86
21 11.97 2.94 2.92 3.67
22 12.42 5.88 1.75 6.52
23 9.24 18.3 10.06 14.27
24 8.79 11.11 10.2 8.83
25 6.97 5.88 12.1 5.43
26 2.58 * 1.6 1.49
27 0.76 0.33* 0.29* 0.14*
28 * 0.98* * 0.14*
29 * 0.33* * *

D2S441

8 0.15* * * *

9 * * 0.58* 0.14*
9.1 * 2.94 * *
10 9.09 20.59 19.83 30.3
11 35.61 36.27 33.09 31.93
11.3 2.88 2.61 5.1 4.62
12 20.45 20.92 4.08 3.8
12.3 0.15* * 0.29* 0.41*
13 3.48 6.21 3.35 1.9
14 26.21 9.8 28.86 23.1
15 1.97 0.65* 4.37 3.4
16 * * 0.44* 0.41*
17 * x * *
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
D3S1358

8 * x x x

9 0.30* * * 0.14*
10 * * * *
11 * * 0.29* *
12 0.15* 0.33* * 0.14*
13 0.61* * 0.15* 0.41*
14 9.09 2.61 15.16 9.1
15 28.18 49.02 27.26 34.65
15.2 0.30* * * *
16 32.42 21.9 24.34 26.9
17 22.27 19.61 19.68 17.93
18 6.06 6.54 11.66 9.92
19 0.61* * 1.46 0.82
20 * x * *
21 * * * *

D5S818

6 * x x x

7 0.30* 1.63 * 5.3

8 6.21 0.33* 0.73 1.49

9 1.97 9.15 5.39 5.03
10 7.27 22.22 5.54 4.35
11 25 28.76 33.82 38.18
12 35.45 24.51 37.61 30.16
13 21.82 12.75 14.87 14.54
14 1.67 0.65* 1.75 0.95
15 0.30* * 0.29* *

GlobalFiler™ Express PCR Amplification Kit User Guide
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PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)
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Population data

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
16 * * * .
17 . x . x
18 . x x x
19 x * * x
D7S820
5 . x . x
6 0.30* * * *
7 0.45* 0.33* 1.31 1.09
8 21.67 16.99 16.47 12.5
9 11.67 7.52 16.62 8.29
9.1 * 0.33* * *
10 30.45 20.26 27.26 25.14
10.3 * * * 0.14*
11 19.85 31.37 20.99 29.35
11.3 * * * 0.14*
12 13.03 20.26 14.58 19.02
13 2.27 2.61 2.33 3.94
13.1 0.15* * * *
14 0.15* 0.33* 0.29* 0.41*
15 * * 0.15* *
16 * * * .
D8S1179
4 . x x x
5 x * * x
6 * * * .
7 . x . x
8 0.30* * 2.04 0.68
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
9 0.30* * 1.31 0.27*
10 3.33 9.8 10.5 9.51
11 5.61 9.48 6.71 5.03
12 11.36 13.4 15.16 12.5
13 18.18 24.18 33.24 33.15
14 35.91 15.69 18.8 23.23
15 18.03 22.22 9.04 11.41
16 5.91 4.25 2.77 3.53
17 1.06 0.98* 0.44* 0.68
18 * x x x
19 * x * *
20 * * * *

FGA
12.2 * * * *
13 * x * *
14 * * * *
15 * x * x
16 * 0.33* 0.15* *
16.1 0.30* * * *
17 * 0.33* 0.15* *
18 0.91 3.27 1.02 0.68
18.2 0.61* * * *
19 6.97 4.25 5.69 7.61
19.2 0.45* * * *
20 6.82 3.92 14.87 8.7
20.2 0.30* * 0.44* 0.27*
21 11.67 13.07 18.22 13.45
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Population data

PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
21.2 0.15* 0.33* 0.29* *
22 17.27 14.38 19.24 14.4
22.2 0.15* * 0.87 0.54*
23 17.27 2712 14.87 12.91
23.2 * 0.65* 0.44* 0.41*
23.3 0.30* * * *
24 18.94 18.3 14.43 15.62
24.2 - 0.33* . -
25 9.55 9.8 6.71 13.72
26 4.09 3.27 1.9 7.07
26.2 * * * *
27 2.58 0.65* 0.58* 3.12
28 1.21 * 0.15* 0.95
29 * * * 0.41*
30 0.15* * * 0.14*
30.2 0.15* ‘ . -
31.2 * * * *
32.2 * * * *
33.2 * * * *
34.2 0.15% * * *
42.2 * * * *
43.2 * * * *
44.2 * * * *
45.2 * * * *
46.2 * * * *
47.2 * * * *
48.2 * * * *
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Chapter 5 Experiments and results

Population data

Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
50.2 * * * *
51.2 * * * *
SE33
4.0 * * * *
5.2 0.15* * * *
6.3 * * 0.15* *
8 * x * *

9 * * * *
11 * x * *
11.2 0.76 * * 0.14*
12 0.15* 0.33* 0.44* 0.14*

12.1 * * 0.15* *
12.2 0.30* * 0.15* 0.14*
13 1.36 * 0.87 1.22
13.2 0.45* * * 0.14*
14 3.33 * 3.64 1.77
14.2 0.15* * * 0.82
14.3 * * 0.15* *
15 4.24 1.31* 3.64 4.89
15.2 0.15* * 0.15* 0.14*
16 6.97 3.59 5.39 5.57
16.2 0.30* * * 0.27*
16.3 * * * 0.14*
17 7.73 5.23 6.56 8.7
17.2 0.15* * * *
17.3 * * 0.15* *
18 10.76 4.9 7.87 10.05
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express

Chapter 5 Experiments and results 78

Population data

PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g)rican Asian (n = 153) U.S(.anl;g)sian U?n I;Iiggg)nic
18.2 0.15* * * 0.27*
19 15 9.48 8.31 8.15
19.2 0.30* * 0.29* *
19.3 * * 0.29* *
20 9.55 6.86 5.25 4.48
20.2 0.91 0.33* 0.87 0.82
21 5.76 6.21 2.04 3.12
21.2 0.91 1.63 1.17 1.09
22 1.97 2.61 0.58* 1.09
22.2 1.36 2.29 3.35 2.31
23 0.30* * * *
23.2 0.61* 2.61 2.62 2.85
23.3 * * * 0.14*
24 0.30* 0.33* 0.15* 0.14*
24.2 1.67 6.54 4.52 2.31
25.2 242 719 3.79 3.12
26 0.15* * * 0.27*
26.2 5.61 7.52 4.52 6.39
27.2 5.91 3.59 6.85 7.07
27.3 * * * 0.14*
28.2 3.94 7.84 7.73 6.25
29.2 2.58 8.5 7.87 5.84
30.2 1.21 7.52 4.66 3.8
31 * * * 0.14~
31.2 1.06 1.63 2.77 2.31
32 * * 0.44* *
32.2 0.76 1.31% 1.6 2.04
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Chapter 5 Experiments and results

Population data

Table 6 Autosomal allele frequencies by population group for GlobalFiler Express
PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant

quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
33 * * 0.29* 0.41*
33.2 0.45* 0.33* 0.15* 0.54*
34 * * 0.29* 0.41*
34.2 0.15* * * 0.27*
35 * * 0.15* *
35.2 * 0.33* * *
36 * * 0.15* *
37 * * * 0.14*
38 * x * *
THO1
3 * x * *
4 * * * *
5 0.45* * 0.15* *
6 15.45 13.07 21.72 27.17
6.1 0.15* * * *
7 37.42 26.14 17.64 32.74
8 20.61 3.59 11.37 8.7
9 16.06 51.63 17.06 12.77
9.3 8.33 4.25 31.2 17.12
10 1.52 1.31% 0.87 1.49
11 * x * x
13.3 * * * *
TPOX
4 * * * *
5 * x * x
6 8.03 * 0.15* 0.54*
7 2.27 0.98* * 0.14*
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Table 6 Autosomal allele frequencies by population group for GlobalFiler Express

Chapter 5 Experiments and results 78

Population data

PCR Amplification Kit STR loci. (*=Alleles not detected or not detected in significant
quantities) (continued)

Allele Africanf;;g;ican Asian (n = 153) U.S(.anléiz)sian U?n I;Iiggg)nic
8 35.91 49.35 50.15 47.83
9 19.09 13.07 12.97 8.02
10 9.55 3.59 4.66 6.11
11 21.67 29.74 28.28 26.36
12 3.33 3.27 3.79 10.73
13 0.15% * * 0.14*
14 * * * 0.14*
15 x * * x
16 * * * .
VWA
10 . x x x
11 0.45* * * 0.14*
12 * * * 0.27*
13 0.91 * 0.15* 0.14*
14 7.27 23.53 8.75 6.52
15 20.91 1.63 12.24 9.78
16 27.58 15.36 22.3 30.57
17 19.85 29.74 27.41 2717
17.3 * * * 0.14*
18 13.79 19.61 17.78 18.07
19 6.52 9.15 10.06 6.39
20 1.97 0.98* 1.31 0.82
21 0.61* * * *
20 x * * x
23 0.15* * * *
o4 . x . x
o5 . x x x
GlobalFiler™ Express PCR Amplification Kit User Guide 129



i9®  Chapter 5 Experiments and results

Population data

Table 7 Y-specific frequencies by population group for GlobalFiler” Express PCR Amplification Kit
DYS391 and Y indel loci. (*=Alleles not detected or not detected in significant quantities)

Allele Afric(zra1n=A2n‘11§;‘ican Asian (n = 65) U.SinC:;gg?ian U?n I;Ii:gg;ﬂc
DYS391
6 * * * *
7 * * * *
8 * * x x
9 1.22 3.08* 1.72 6.59
10 71.54 83.08 44.64 52.75
11 26.42 13.85 51.93 36.26
12 0.41* * 1.72 3.3
13 0.41* * * 1.10*
14 * * * *
Y indel
1 1.22 67.69 * 0.55*
2 98.78 32.31 100 99.45

Table 8 Probability of identity (P)) values for the GlobalFiler" Express PCR Amplification Kit STR

loci

Locus Afric(e:ln=A3r;g;’ican Asian (n = 153) U.SénC:gig?ian U?n I;Iiggg)nic
CSF1PO 0.0850 0.1317 0.1333 0.1353
D10S1248 0.0693 0.1045 0.0943 0.1131
D12S391 0.0377 0.0664 0.0231 0.0318
D13S317 0.1451 0.0817 0.0761 0.0564
D16S539 0.0727 0.0915 0.1043 0.0809
D18S51 0.0322 0.0402 0.0311 0.0281
D19S433 0.0388 0.0663 0.0862 0.0484
D1S1656 0.0340 0.0564 0.0223 0.0247
D21511 0.0453 0.0671 0.0520 0.0487
D22S1045 0.0559 0.1073 0.1309 0.1604
D251338 0.0225 0.0337 0.0316 0.0316
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Population data

Table 8 Probability of identity (Pl) values for the GlobalFiler Express PCR Amplification Kit STR
loci (continued)

Locus Afric(la1n=A£g;ican Asian (n = 153) U.SénC:l;i:as)sian U?n Ei;gg)nic
D2S441 0.1030 0.0961 0.0976 0.1079
D3S1358 0.0984 0.1689 0.0749 0.0949
D5S818 0.0968 0.0883 0.1341 0.1122
D7S820 0.0784 0.0875 0.0680 0.0790
D8S1179 0.0762 0.0527 0.0631 0.0661

FGA 0.0322 0.0555 0.0384 0.0282

SE33 0.0118 0.0139 0.0085 0.0081

THO1 0.0949 0.1750 0.0801 0.0902

TPOX 0.0833 0.1788 0.1757 0.1456

VWA 0.0622 0.0840 0.0650 0.0926
Combined 6.18 x 10 27 3.34x 1024 3.71x10-26 3.09x 10 -6

Probability of paternity exclusion observation

Allele frequencies, observed heterozygosity (Ho), expected heterozygosity (He), Match Probability (MP), and
p-value of each locus was calculated using a software program developed by Ge (Li et al., 2013) and shown in
the following table.

Departures from Hardy-Weinberg Equilibrium (HWE) expectations of each locus were derived using Arlequin
(Excoffier et al., 2010). After Bonferroni correction (Weir, 1990), (p-value = 0.05/21 = 0.0024), no departures
from HWE were observed at any locus.

The average observed heterozygosity across the 21 autosomal STR loci was 0.815 in the African American
population, 0.779 in the Asian population, 0.804 in the U.S. Caucasian population, and 0.789 in the Hispanic
population. The most heterozygous locus was SE33 (mean observed heterozygosity across all populations of
0.948), and the least heterozygous STR locus was TPOX (mean observed heterozygosity across all populations
of 0.652). The cumulative match probability (including the Y chromosome loci) was 2.17 x 1027 for African
American, 2.26 x 10725 for Asian, 5.27 x 10727 for Caucasian, and 5.0 x 10~27 for Hispanics.
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Table 9 Allele frequencies, observed heterozygosity (Ho), expected heterozygosity (He), Match probability (MP), and p-value of STR loci

African American Asian U.S. Caucasian U.S. Hispanic

Marker p- p- p- p-
Ho He MP value Ho He MP value Ho He MP value Ho He MP value

Y indel - - 0.976 - - - 0.556 - - - 1.000 - - - 1.000 -

DYS391 - - 0.540 - - - 0.709 - - - 0.472 - - - 0.409 -
D3S1358 | 0.772 | 0.762 | 0.094 | 0.902 | 0.686 | 0.682 | 0.151 | 0.012 | 0.753 | 0.786 | 0.079 | 0.698 | 0.698 | 0.758 | 0.098 | 0.291
VWA 0.752 | 0.798 | 0.068 | 0.116 | 0.829 | 0.784 | 0.080 | 0.309 | 0.841 | 0.807 | 0.064 | 0.621 | 0.842 | 0.782 | 0.080 | 0.463
D16S539 | 0.772 | 0.797 | 0.071 | 0.026 | 0.800 | 0.764 | 0.092 | 0.457 | 0.801 | 0.749 | 0.103 | 0.047 | 0.770 | 0.774 | 0.084 | 0.835
CSF1PO | 0.772 | 0.773 | 0.086 | 0.020 | 0.743 | 0.721 | 0.125 | 0.128 | 0.721 | 0.720 | 0.131 | 0.745 | 0.727 | 0.710 | 0.137 | 0.619
TPOX | 0.693 | 0.755 | 0.093 | 0.579 | 0.671 | 0.665 | 0.168 | 0.770 | 0.633 | 0.644 | 0.181 | 0.598 | 0.669 | 0.667 | 0.153 | 0.102
D8S1179 | 0.782 | 0.793 | 0.068 | 0.662 | 0.814 | 0.828 | 0.052 | 0.795 | 0.793 | 0.797 | 0.065 | 0.122 | 0.755 | 0.802 | 0.064 | 0.518
D21S11 | 0.861 | 0.849 | 0.039 | 0.553 | 0.800 | 0.791 | 0.069 | 0.667 | 0.873 | 0.837 | 0.046 | 0.385 | 0.827 | 0.839 | 0.044 | 0.315
D18S51 | 0.931 | 0.868 | 0.031 | 0.324 | 0.829 | 0.853 | 0.038 | 0.572 | 0.873 | 0.872 | 0.030 | 0.962 | 0.849 | 0.870 | 0.031 | 0.945
D2S441 | 0.772 | 0.756 | 0.099 | 0.421 | 0.714 | 0.746 | 0.101 | 0.238 | 0.757 | 0.766 | 0.090 | 0.077 | 0.791 | 0.763 | 0.094 | 0.611
D19S433 | 0.812 | 0.825 | 0.051 | 0.663 | 0.714 | 0.802 | 0.064 | 0.130 | 0.785 | 0.774 | 0.083 | 0.859 | 0.820 | 0.834 | 0.046 | 0.446
THO1 0.762 | 0.747 | 0.102 | 0.418 | 0.614 | 0.656 | 0.171 | 0.381 | 0.753 | 0.783 | 0.081 | 0.326 | 0.770 | 0.767 | 0.091 | 0.845
FGA 0.782 | 0.866 | 0.033 | 0.082 | 0.900 | 0.841 | 0.044 | 0.240 | 0.829 | 0.857 | 0.037 | 0.337 | 0.842 | 0.882 | 0.025 | 0.127
D22S104 | 0.842 | 0.822 | 0.055 | 0.062 | 0.743 | 0.742 | 0.112 | 0.966 | 0.705 | 0.714 | 0.131 | 0.026 | 0.698 | 0.672 | 0.162 | 0.064

5

D5S818 | 0.752 | 0.761 | 0.094 | 0.799 | 0.800 | 0.786 | 0.079 | 0.430 | 0.761 | 0.716 | 0.127 | 0.197 | 0.727 | 0.727 | 0.115 | 0.219
D13S317 | 0.762 | 0.695 | 0.138 | 0.217 | 0.786 | 0.799 | 0.069 | 0.327 | 0.769 | 0.777 | 0.081 | 0.718 | 0.799 | 0.815 | 0.059 | 0.855
D7S820 | 0.842 | 0.786 | 0.077 | 0.404 | 0.814 | 0.778 | 0.081 | 0.062 | 0.789 | 0.805 | 0.067 | 0.278 | 0.748 | 0.789 | 0.076 | 0.830
SE33 0.960 | 0.929 | 0.009 | 0.776 | 0.943 | 0.936 | 0.008 | 0.526 | 0.968 | 0.947 | 0.005 | 0.532 | 0.921 | 0.941 | 0.007 | 0.597
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Table 9 Allele frequencies, observed heterozygosity (Ho), expected heterozygosity (He), Match probability (MP), and p-value of STR

loci (continued)

African American Asian U.S. Caucasian U.S. Hispanic
Marker p- p- p- p-
Ho He MP Ho He MP Ho He MP Ho He MP
value value value value
D10S124 | 0.792 | 0.789 | 0.075 | 0.823 | 0.757 | 0.764 | 0.091 | 0.928 | 0.785 | 0.769 | 0.090 | 0.630 | 0.691 | 0.724 | 0.124 | 0.336
8
D1S1656 | 0.921 | 0.863 | 0.033 | 0.351 | 0.757 | 0.818 | 0.056 | 0.043 | 0.912 | 0.899 | 0.019 | 0.550 | 0.871 | 0.896 | 0.020 | 0.048
D12S391 | 0.861 | 0.864 | 0.032 | 0.190 | 0.771 | 0.808 | 0.063 | 0.650 | 0.904 | 0.896 | 0.020 | 0.450 | 0.842 | 0.874 | 0.028 | 0.071
D2S1338 | 0.911 | 0.894 | 0.020 | 0.763 | 0.871 | 0.872 | 0.030 | 0.356 | 0.880 | 0.878 | 0.027 | 0.230 | 0.906 | 0.877 | 0.027 | 0.929
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Chapter 5 Experiments and results

Population data

The following table shows the Probability of paternity exclusion (PE) values of the GlobalFiler" Express PCR
Amplification Kit STR loci individually and combined.

The PE value is the probability, averaged over all possible mother-child pairs, that a random alleged father will
be excluded from paternity after DNA typing using the GlobalFiler™ Express PCR Amplification Kit STR loci
(Chakraborty, Stivers, and Zhong, 1996).

Table 10 Probability of paternity exclusion values for the GlobalFiler” Express PCR Amplification Kit STR

loci
Locus Afric(z:ln=A£g)rican Asian (n = 153) Caucasian (n = 343) Hispanic (n = 368)
CSF1PO 0.5878 0.4904 0.4507 0.4644
D10S1248 0.6623 0.5353 0.5649 0.4644
D12S391 0.7401 0.6310 0.8032 0.6588
D13S317 0.4521 0.6063 0.5544 0.5770
D16S539 0.5548 0.6063 0.5915 0.5623
D18S51 0.7892 0.6560 0.7557 0.7121
D19S433 0.6332 0.5238 0.5135 0.6431
D1S1656 0.7462 0.5703 0.8032 0.7338
D21S11 0.7280 0.6063 0.7264 0.7013
D22S1045 0.7038 0.4795 0.4507 0.3970
D251338 0.8140 0.7463 0.7498 0.7392
D2S441 0.5228 0.5353 0.4986 0.5051
D3S1358 0.4918 0.3976 0.5338 0.4689
D5S818 0.4717 0.5942 0.4839 0.4959
D7S820 0.5767 0.5942 0.5808 0.5970
D8S1179 0.5990 0.6063 0.6187 0.5381
FGA 0.7280 0.8397 0.6632 0.7175
SE33 0.8639 0.8800 0.9231 0.8781
THO1 0.5124 0.3424 0.5036 0.5381
TPOX 0.4817 0.3602 0.3435 0.3620
VWA 0.6103 0.6186 0.6576 0.6276
PEi 2.0564 x 10710 2.7761 x 10799 4.1986 x 10710 2.1709 x 10799
Combined 0.9999999998 0.9999999972 0.9999999996 0.9999999978
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Troubleshooting

Observation

Possible cause

Recommended action

Faint or no signal from both the
DNA Control 007 and the DNA
test samples at all loci

The incorrect volume of Master
Mix or Primer Set was used.

Use the correct volume of Master Mix or Primer
Set.

The DNA Polymerase was not
activated.

Repeat the amplification with an initial hold at
95°C for 1 minute.

The Master Mix was not
vortexed thoroughly before
aliquoting.

Vortex the Master Mix thoroughly.

The Primer Set was exposed to
too much light.

Replace the Primer Set and store it protected
from light.

Evaporation.

Ensure that the plate is properly sealed with film
and that a compression pad was used with the
GeneAmp™ PCR System 9700. (A compression
pad should not be used with other validated
thermal cyclers.)

The thermal cycler
malfunctioned.

See the thermal cycler user manual and check
the instrument calibration.

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

A MicroAmp™ base was used
with a tray/retainer set and tubes
in GeneAmp™ PCR System
9700.

Remove the MicroAmp™ base.

The tubes or plate were not
seated tightly in the thermal
cycler during amplification.

Push the tubes or plate firmly into the block after
first cycle.

The wrong PCR reaction tubes
or plate were used.

Use MicroAmp™ Reaction Tubes with Caps or
the MicroAmp™ Optical 96-well Reaction Plate
for the GeneAmp "™ PCR System 9700 or Veriti"
Thermal Cycler.

Insufficient PCR product was
electrokinetically injected.

Use correct genetic analyzer settings.

Degraded formamide was used.

Check the storage of formamide. Do not
thaw and refreeze multiple times. Try Hi-Di™
Formamide.
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Appendix A Troubleshooting
Population data

Observation

Possible cause

Recommended action

Faint no signal Control and
samples all loci

The sample punch location was
not optimal.

For blood samples on treated paper, punch in
the center of the blood stain.

For buccal samples on treated paper, punch in
the center of the buccal transfer or punch in the
optimal location you have previously determined.

For buccal samples collected with the Bode
Buccal DNA Collector™ device, punch from near
the tip of the collector.

Insufficient volume of swab
lysate was added to the
reaction.

Ensure the swab heads are incubated for
20 minutes in 400 pL of Prep-n-Go™ Buffer.

Proper low-TE buffer not used
for treated paper substrates.

Prepare low-TE buffer. See “Prepare low-TE
buffer” on page 20.

Positive signal from DNA Control
007 but partial or no signal from
DNA test samples

The test sample was diluted in
the wrong buffer (for example, a
TE buffer with an incorrect EDTA
concentration).

Redilute DNA using low-TE buffer (with 0.1 mM
EDTA).

The sample punch location was
not optimal.

For blood samples on treated paper, punch in
the center of the blood stain.

For buccal samples on treated paper, punch in
the center of the buccal transfer or punch in the
optimal location you have previously determined.

For buccal samples collected with the Bode
Buccal DNA Collector™ device, punch from near
the tip of the collector.

Insufficient lysis of the swab
head occurred.

Ensure the swab heads are incubated for
20 minutes in 400 pL of Prep-n-Go™ Buffer.

Proper low-TE buffer not used
for treated paper substrates.

Prepare low-TE buffer.

More than two alleles present at
alocus

Exogenous DNA is present in
the sample.

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Stutter product (-1 repeat unit
position) was amplified.

See Chapter 5, “Experiments and results”

Triallelic patterns occur.

Confirm the triallelic pattern per the laboratory's
guidelines.

Incomplete 3" A base addition
(n—1 nt position) occured.

Include the final extension step of 60°C for
10 minutes in the PCR.

Include the final extension step of 60°C for
10 minutes in the PCR.

The signal exceeds the dynamic
range of the instrument and

is causing signal "pull-up" into
adjacent channels.

Ensure the cycle number is optimized. Use
fewer PCR cycles or interpret the off-scale data
according to your laboratory procedure.
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Appendix A Troubleshooting
Population data

Observation

Possible cause

Recommended action

More than two alleles present at
a locus
(continued)

Poor spectral separation
occurred.

Perform a spectral calibration.

Confirm that Filter Set J6 modules are installed
and used for analysis.

The double-stranded DNA was
not completely denatured.

Use the recommended amount of Hi-Di™
Formamide and heat the sample plate at 95°C
for 3 minutes.

Contamination was carried over
from the disc punching tool.

Clean the disc punching tool thoroughly. If
necessary, include a blank punch step in
between the sample punches.

Poor peak height balance

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

Some but not all loci visible on
electropherogram of DNA Test
Samples

The punched disc you used was
too large.

Use a 1.2 mm disc.

Insufficient lysis of the swab
head occurred.

Ensure the swab heads are incubated for
20 minutes in 400 pL of Prep-n-Go ™ Buffer.

The PCR reaction volume you
used is lower than the volume
required for the amplification.

Use the correct PCR reaction volume: 15 pL

STR profiles contain many off-
scale alleles

The PCR cycle number used
was too high.

Perform a sensitivity experiment to determine the
optimal PCR cycle number based on the sample

type.

Blood samples: Too much liquid
blood was spotted onto the
paper substrate.

Spot <100 pL of liquid blood per sample area.

Data collected on the
3730 instrument with POP-7™
polymer fails sizing

The 60-bp size-standard peak
is occasionally obscured by the
primer peak.

Reinject samples that fail to recognize the
60 base-pair peak.

Use the 80 to 460 bp size-standard definition
after performing appropriate validation studies
(as a general rule, the 60 base-pair peak is not
required for accurate fragment sizing using the
3rd Order Least Squares sizing method).

For more information, see the GeneMapper™
ID-X Software v1.4 New Features

and Installation Procedures User Bulletin

(Pub. No. 4477684), “Known issues: 3730 DNA
Analyzer sizing failures”.

Data collected on the

3730 instrument with POP-7"™
polymer: the D2S441 and
D1S1656 markers in some
allelic ladder samples fail base-
pair spacing quality assessment

Data was analyzed using the
Light setting for Smoothing.

Use the None setting for Smoothing after
performing appropriate validation studies.

For more information, see the GeneMapper™
ID-X Software v1.4 New Features

and Installation Procedures User Bulletin

(Pub. No. 4477684), “Known issues: 3730 DNA
Analyzer sizing failures”.
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Materials required but not supplied

STR kit required materials .. ... i e 138
Sample preparation required materials . .......... . 138
Thermal cycler required materials . ... ... . e 140
Genetic analyzer required materials . ... 141
Analysis software required materials . .. ... i e 143
Miscellaneous required materials ... ... i e 143

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

STR kit required materials

Item Source
GlobalFiler™ Express PCR Amplification Kit, 200-reaction kit 4476609
GlobalFiler™ Express PCR Amplification Kit, 1,000-reaction kit 4474665
GeneScan" 600 LIZ" Size Standard v2.0, 2 x 200 pL 4408399

IMPORTANT! Do not use GeneScan™ 350 ROX™, GeneScan™ 500 ROX™,
or GeneScan™ 500 LIZ" Size Standards with this kit.

Hi-Di"™" Formamide, 25-mL 4311320

Sample preparation required materials

Treated paper substrate

Item Source

Collection system: NUCLEIC-CARD" system or Whatman FTA™

NUCLEIC-CARD™ Sample Collection Device A32607
NUCLEIC-CARD" matrix, 1 spot 4474001
NUCLEIC-CARD™ COLOR matrix, 1 spot 4473974
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Appendix B Materials required but not supplied

Sample preparation required materials

(continued)
Iltem Source
Whatman™ FTA™ Classic Cards MLS
Whatman" EasiCollect™ system MLS
Sample preparation:
Prep-n-Go™ Buffer (for use with untreated paper substrates) 4467079
Low-TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) Teknova T0223
Punch tool:
Harris Micro-Punch™ tool, 1.2-mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a
1.2-mm punch head

BSD1000-GenePunch Automated Dried Sample Punch Instrument with a
1.2-mm punch head

Contact your local sales office.

Untreated paper substrate

Item

Source

Collection system: Bode or paper

Buccal DNA Collector™ Device

Contact Bode Cellmark Forensics

903 paper MLS
Punch tool:
Harris Micro-Punch™ tool, 1.2-mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a
1.2-mm punch head

BSD1000-GenePunch Automated Dried Sample Punch Instrument with a
1.2-mm punch head

Contact your local sales office.

Swab substrate

Item Source
Collection system
4ANB6FLOQSwabs™, regular tip 4473979
Sample preparation:
Prep-n-Go™ Buffer (for use with buccal swab substrates) 4471406
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Appendix B Materials required but not supplied
Thermal cycler required materials

(continued)
Item Source
Heated lysis protocol only: 1.5 mL tube format or 96-well deep-well plate format
1.5 mL tube format
1.5 mL tubes MLS
Oven VWR™ Scientific.: dry heat block or
equivalent
96-well deep-well plate format
PrepFiler™ 96-Well Processing Plates A47010
Robbins Scientific™ Model 400 Hybridization Incubator or equivalent MLS

Agilent™ Benchtop Rack for 200 pL Tubes/V Bottom Plates (metal) or
equivalent

IMPORTANT! Do not use a plastic plate adaptor.

Agilent Technologies 410094

Thermal cycler required materials

Veriti” Thermal Cycler

Item Source
Veriti" 96-Well Thermal Cycler 4479071
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS
GeneAmp" PCR System 9700

Item Source
GeneAmp™ PCR System 9700, 96-Well Silver N8050001
GeneAmp™ PCR System 9700, 96-Well Gold-Plated 4314878
Silver 96-Well Sample Block N8050251
Gold-Plated 96-Well Block 4314443
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Appendix B Materials required but not supplied

Genetic analyzer required materials

SeqStudio™ Genetic Analyzer

Genetic analyzer required materials

ltem Source

SeqStudio™ Data Collection Software v1.2 A46168
SeqStudio™ Genetic Analyzer Cartridge v2 A41331
SeqStudio™ Genetic Analyzer Cathode Buffer Container A33401
Reservoir Septa (for SeqStudio” Cathode Buffer Container) A35640
SeqStudio™ Integrated Capillary Protector A31923
MicroAmp™ Optical 96-Well Reaction Plate 4316813
MicroAmp"™ Optical 96-Well Reaction Plate with Barcode 4326659
MicroAmp™ Optical 8-Tube Strip, 0.2 mL 4316567
Septa for SeqStudio™ Genetic Analyzer, 96 well A36541
Septa for SeqStudio™ Genetic Analyzer, 8 strip A36543
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
3500 Series Genetic Analyzer

Iltem Source
3500 Series HID Data Collection Software v4.0.1 A46085

3500 Series Data Collection Software 3.1

440518701, A26287

3500 Series Data Collection Software 3 4405186l
3500 Series Data Collection Software 2 4475183l
HID Updater 3500 Data Collection Software v2 4480670
Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4" Polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4" Polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
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Appendix B Materials required but not supplied
Genetic analyzer required materials

(continued)
Item Source
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
' Contact your Thermo Fisher Scientific HID representative.
3130 Series Genetic Analyzer
Item Source
3130 Data Collection Software v4 4475105
3130x/ Data Collection Software-v4 4475126
3130/3730 Data Collection Software-v4 6-Dye Module v1 4480670
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130 x/ Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4" Polymer for 3130/3130 x/ Genetic Analyzers 4352755
Running Buffer, 10X 402824
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
MicroAmp™ Optical 96-Well Reaction Plate N8010560
3730 Series Genetic Analyzer
Iltem Source
3730xI Data Collection Software 5 4475133
3730/3730 x/ Data Collection Software-v4 4475154
3130/3730 Data Collection Software v4 6-Dye Module v1 4480670
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3730 DNA Analyzer 48-Capillary Array, 36-cm 4331247
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Analysis software required materials

(continued)
Item Source
POP-7" Polymer for 3730/3730x/ DNA Analyzers 4335611
Running Buffer, 10X 4335613
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
MicroAmp™ Optical 96-Well Reaction Plate N8010560
250-pL Glass Syringe (array-fill syringe) 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731
Analysis software required materials
GeneMapper™ ID-X Software
Item Source
GeneMapper" ID-X Software v1.6 Full Installation A39975
GeneMapper" ID-X Software v1.6 Client Installation A39976
GeneMapper" ID-X Software v1.5 Full Installation A27884
GeneMapper" ID-X Software v1.5 Client Installation A27886
GeneMapper" ID-X Software v1.4 Full Installation 4479707
GeneMapper" ID-X Software v1.4 Client Installation 4479711
Miscellaneous required materials
Plates and tubes
Item Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp"™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp™ Optical 8-Cap Strips 4323032
MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
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Appendix B Materials required but not supplied
Miscellaneous required materials

(continued)

Item Source
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Laboratory supplies

Item Source
Various procedures
Aerosol resistant pipette tips MLS!]
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

' Major laboratory supplier
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Example PCR plate layout

The following layout is recommended for use with the sensitivity experiment in the Perform PCR

Plate layouts

chapter. Create 3 identical plates for amplification at 3 different cycle numbers.
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Example electrophoresis plate layout

The following layout is recommended for use with the sensitivity experiment in the Perform PCR

chapter.
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Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are using this kit for:

* Forensic DNA testing, see "Forensic Laboratories: Handbook for Facility Planning, Design,
Construction, and Moving", National Institute of Justice, 1998

* Parentage DNA testing, see the "Guidance for Standards for Parentage Relationship Testing
Laboratories", American Association of Blood Banks, 7th edition, 2004

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute quantities of DNA,
necessitating precautions to avoid contamination of samples yet to be amplified (Kwok and Higuchi,
1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at all times and
change them frequently. Close sample tubes when not in use. Limit aerosol dispersal by handling
sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all precautions and care
necessary for using PCR technology.

PCR setup work area materials

146

IMPORTANT! Do not remove these items from the PCR Setup Work Area.

¢ Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate nuclease-free tube (for master mix
preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors
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Appendix D PCR work areas
Amplified DNA work area

* Tube decapper, autoclavable
* \ortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

Use only the validated thermal cyclers listed in “Instrument and software compatibility” on page 15.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, see the “Documentation and Support” section in this document.
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Appendix E Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the “Documentation and Support” section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer's

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if necessary) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise
attentivement et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au
stockage des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous.
Consulter également la FDS appropriée pour connaitre les précautions et instructions particulieres a
respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou
vétements de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Veérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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Appendix E Safety
Biological hazard safety

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient
les déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient
primaire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et
conformes aux exigences locales, nationales et communautaires en matiére de confinement des
récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en
respectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

Biological hazard safety

150

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC) 21-1112, Revised December 2009;
found at:
https://www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2009-
P.pdf

. World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document title Pub. No.
STR kits
GlobalFiler™ Express PCR Amplification Kit—PCR and CE Quick Reference 4480794
GlobalFiler™ Express PCR Amplification Kit—PCR Setup—Swab Substrate Quick Reference 4477601
GlobalFiler™ Express PCR Amplification Kit—PCR Setup — Treated Paper Substrate Quick 4480904
Reference
GlobalFiler™ Express PCR Amplification Kit—PCR Setup— Untreated Paper Substrate Quick 4480795
Reference
Thermal cyclers
Veriti" Thermal Cycler User Guide 4375799
GeneAmp" PCR System 9700 Base Module User Manual 4303481
SeqStudio™ Genetic Analyzer
SeqStudio™ Genetic Analyzer Instrument and Software User Guide MANO0018646
SeqStudio™ Genetic Analyzer for HID Instrument and Software v1.2.1 User Bulletin—New 100086084
Features and Developmental Validation
3500 Series Genetic Analyzer
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v1 User Guide 4401661
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v2 User Guide 4476988
HID Updater 3500 Data Collection Software v2.0 User Bulletin NA
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software 3 User Guide 100025036
3500 Series Data Collection Software v3 User Bulletin: New Features and HID Validation MANO0010812
Summary
3500 Series Data Collection Software v3.1 User Bulletin: New Features and HID Validation MANO0014110
Summary
3500 Series Data Collection Software 4 User Bulletin: New Features and Developmental 100075298
Validation
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Documentation and support

Related documentation
(continued)
Document title Pub. No.
3130 Series Genetic Analyzer
3130/3130xI Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
3130/3130xI Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
3130/3130xI Genetic Analyzers Getting Started Guide 4352715
3130/3130xI Genetic Analyzers Quick Reference Card 4362825
3130/3130xI Genetic Analyzers AB Navigator Software Administrator Guide 4359472
3730 Series Genetic Analyzer
3730/3730xI Genetic Analyzer Getting Started Guide 4359476
3730xI Data Collection Software 5 for HID User Bulletin: New Features and Developmental MANO0019461

Validation

GeneMapper " ID-X Software all versions

GeneMapper™ ID-X Software Bin Overlap User Bulletin 100029546

GeneMapper" ID-X Software v1.3

GeneMapper™ ID-X Software v1.3 Verification Experiments and Installation Procedures User 4470483
Bulletin

GeneMapper" ID-X Software v1.4

GeneMapper™ ID-X Software v1.4 New Features and Installation Procedures User Bulletin 4477684

GeneMapper" ID-X Software v1.5

GeneMapper™ ID-X Software v1.5 New Features and Verification User Bulletin 100031708
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Basic Features 100031701
GeneMapper" ID-X Software v1.5 Quick Reference— Basic Features 100031702
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Mixture Analysis Tool 100031704
GeneMapper™ ID-X Software v1.5 Quick Reference— Mixture Analysis Tool 100031705
GeneMapper™ ID-X Software v1.5 Installation Guide 100031706
GeneMapper™ ID-X Software v1.5 Administrator Guide 100031703
GeneMapper™ ID-X Software v1.5 Reference Guide 100031707

GeneMapper™ ID-X Software v1.6

GeneMapper™ ID-X Software v1.6 New Features and Software Verification User Bulletin 100073905
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Documentation and support
Customer and technical support

Customer and technical support

For support:

* In North America—Send an email to HIDTechSupport@thermofisher.com, or call
888-821-4443 option 1.

* Outside North America— Contact your local support office.

For the latest services and support information for all locations, go to thermofisher.com/support to
obtain the following information.

Worldwide contact telephone numbers

* Product support

* Order and web support

* Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of Analysis, are available by
contacting Customer Support.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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